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1 Introduction

Blue Sky Plan® is Windows computer software intended for 3D virtual surgical implant placement,
giving clinicians a more accurate way to treat patients. Blue Sky Plan® is precise and can help the
clinician determine the ideal position for implant placement for the best esthetic and functional results.
Blue Sky Plan® can be used for diagnostic purposes and can aid in the fabrication of surgical guides
for computer-guided surgery. Using Blue Sky Plan® is the way to give your patients the best care
available.

Blue Sky Plan converts a Computer Tomography (CT) or Cone Beam Computer Tomography scan into
a format that allows the dentist to assess the anatomic topography of the maxilla and mandible as well
as the location of important structures. The patient’s CT or CBCT images will be stored in DICOM
format from an Imaging Center. The software converts these images and makes it possible to view the
patient’s anatomic structures. These data can be used for accurate pre-surgical treatment planning.

The dentist can use the program to:

* carry out pre-surgical planning

* help fabricate an accurate surgical guide

* decrease the risks of surgical complications

» create realistic simulations of the treatment plan
» assist in selecting the type and size of implants
» assess results of prior bone grafting procedures
« store the patient data

« allow visual communication with patients and the
implant team

» demonstrate knowledge, credibility, and safety
* help provide advanced patient care

Blue Sky Plan® software can be downloaded from http://www.blueskybio.com. A user license must be
obtained for each installation. During the installation process the software will prompt the user to
request a license via the internet.

1.1 Indications For Use

Blue Sky Plan is intended to be used as conversion software for Computed Tomography (CT)
generated DICOM images into a format that allows a dentist to assess the anatomic topography of the
maxilla and mandible as well as location of important structures. It allows the information to be used
for pre-surgical treatment planning of dental implant procedures.

Blue Sky Bio Aligners are a series of clear, lightweight, plastic appliances indicated for the treatment of
tooth malocclusions in patients with permanent dentition (i.e., all second molars). Utilizing a series of
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force.

Blue Sky Bio Computerized Bracket System is a software system intended for use as an aid in
orthodontic treatment planning to correct Malocclusions in Orthodontic Patients. For use by dental
professionals trained in orthodontic treatment, including radiographic analyses and treatment planning.
Blue Sky Bio Computerized Orthodontic Bracket System is intended for use with commercially
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available brackets currently used in standard orthodontic treatment. The end product is an indirect
bonding tray for use by the Dental professional to place multiple brackets at the same time.

The denture module is intended to be used to design a denture and export the entire denture or
selected parts of the denture from the software for 3D printing

The crown and bridge functionality allows a dental professional to design one or more new teeth in the
Blue Sky Plan that will attach to either a damaged tooth or a titanium based abutment.

1.2 Warnings

The software does not contain any functionality verifying if real-life implementation of the virtual
treatment plan might result in damage to the patient. Any virtual treatment plan should be evaluated by
a trained licensed professional confirming that the virtual treatment can be implemented in real life and
will not cause harm to the patient.

If the segmentation function of the software is used, the segmentation has to be carefully evaluated to
ensure that it matches the patient's anatomy and corrected if necessary.

It is important to verify that the imported and exported data sets are of adequate quality and match the
patient's anatomical structures.

Appliances manufactured based on the virtual treatment plan should be made only from biocompatible
materials that have suitable mechanical properties and are in compliance with local regulatory bodies.
Appliances should be marked with patient information to avoid errors when delivering the appliance.
Poor quality radiographic or optical images, inadequate training of user or inadequate hardware can
affect the image results.

The DICOM data can be used to do the following:

1) make a scale 3D model of the jaw with the planned implant according to the illustrations below:

3) fabricate a surgical guide supported on the gingiva

BS-LS-IFU-06-en Ver 7 Blue Sky Plan®
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*The files with three-dimensional positioning of implants and the file of the three-dimensional guide
can only be generated in Blue Sky Plan®.
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2 Installing Blue Sky Plan

Blue Sky Plan® software supports Windows operating system. Installation packages are available for
the systems indicated.

2.1 Installation process

After downloading the Blue Sky Plan® software to your hard drive, simply execute the file and follow
the steps to proceed:

Vybér jazyka privodce instalaci

j Zvolte jazyk, ktery se mé pouiit béhem
instalace.

English w

Cestina
Deutsch r Choose the language and click “OK”.

Ezpariol
Francais
Ttaliano
Portugués (Paortugal)
Pycaai

H+:E

EHFF
EREPr

Setup = Blue Sky Plan 4.7.5

Lkcense Agreement
Please read the followang important nformation before contrumng. <

Please read the folowing License Agreement. You must accept the terms of this
agreament before continuing with the installation,

HCAUTION: READ THIS AGREEMENT CAREFULLY BEFORE [NSTALLING THE ~

SOFTVWARE-

LICENSE AGREEMENT FOR USE OF BLUE SKY PLAN™ SOFTWARE Carefully read the license agreement, select one
This License Agreement is provided for your reference. To complete of the Options, and click "Next".

the instalaton and to use the Blue Siy Plan ™ software package, you
will need to agree to the folovwang terms and condibons:

1. Contracting Parties. The parties in this License Agreement are
Blue Sky Bio, LLC (Licensor”) and the user of the software b

(7)1 accept the agresment
(W] do not accept the agresment

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 9
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Select Destinathon Location
Whera should Blua Sky Plan 4 be installed? F
Satup will install Blue Sky Fian 4 into the following folder.
To continue, click Next. If you would like 1o select & different folder, click Browss,
- — — -
H " "
Click "Next".
Al least 927,1 MB of free disk space is required.
e corn
Setup - Blue Sky Plan 4,
Select Additional Tasks )

Which additional tasks should be perfarmad? p

Select the additional tasks you would like Setup to perform while installing Blue Sky Plan

4, then dick Next.

Additional shortouts:
Create a desktop shortcut

File Extensions: Click "Next"
Make Blue Sky Plan the default program to open DICOM files
< Back Cancel
Setup - Blue Sky Plan 4.7.5
Ready to Install |

Setup is now ready to begin installing Blue Sky Plan 4 on your computer. p

Click Install to continue with the installation, or dick Back if you want to review or

change any settings.

Additional tasks:

Additional shortouts:
Create a desktop shortout
File Extensions: . " "
Make Blue Sky Plan the default program to open DICOM files CI|Ck |nSta|| .
< Back Cancel
BS-LS-IFU-06-en Ver 7 Blue Sky Plan®
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Setup - Blue Sky Plan 4.7.5

Completing the Blue Sky Plan 4
Setup Wizard

Setup has finished installing Blue Sky Plan 4 on your computer,
The application may be launched by selecting the installed
shortcuts,

Click Finish to exit Setup.

Launch Blue sky Plan 4 CI|Ck "FiniSh".

2.2 Hardware requirements

Minimum requirements:

* OS: Windows 10 Home/Professional 64 bit

* Processor: Quad Core Intel i7 or comparable

* RAM: At least 16 GB

* Video card: AMD Radeon RX 470, NVIDIA GeForce GTX 1050 Ti
* Monitor: resolution at least 1850p

» Hard Disk: 5 GB of free space

2.3 Operating system

Minimum requirements:
» Windows 10 Home/Professional 64 bit

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05
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3 Blue Sky Launcher

The Blue Sky Launcher is a multifunctional tool that provides access to all features of the Blue Sky
Plan® application. It allows users to launch the specific treatment planning modules, organized in
hexagonal tiles (1), and provides access to processes linked to the BlueSkyBio Digital account (2)(see
chapter 4). In addition, users can manage catalog packages (3)(e.g., implants, teeth) and open
existing projects (4). The Blue Sky Launcher serves as a "central hub", effectively integrating all key
functionalities into one intuitive interface.

The treatment planning options are organized into distinct modules (Orthodontics, Implant Planning
and Surgical Guide, etc.), which can be further divided into planning types (Aligners, Surgical Guide,
etc.). Each module and planning type has its own specific requirements regarding the data that needs
to be imported.

5 Ctrl+Shift+P
i} Manage Catalog Packages

EASY CT DICOM
VIEWER

ORTHODONTICS 5 SPLINT

IMPLANT " et
PLANNING AND DENTURE Suee CEPHALOMETRIC
SURGICAL GUIDES / ANALYSIS

i CROWN AND A ENDODONTICS

BRIDGE

ol

MODEL MASTER

Open Existing File

3.1 Modules and planning types

Planning a new treatment begins by creating a new project. To start, the user selects a specific module
(1) and, if available, a specific type of planning (2). Below is a list of all the modules and their planning
types:
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+ Easy CT DICOM Viewer - see 9
chapter 7
* Orthodontics - see chapter 25
= Aligners
* Indirect Bonding Tray o
(IBT) Align Brackets to traae®
Teeth ORTHODONTICS
* Indirect Bonding Tray
(IBT) Align Brackets to 9
Wire Indirect
+ Splint - see chapter 28 ‘ ' Bonding Tray
« Incisal Splint (AMPSA) Brag'lf;i‘:::%:e "
» Occlusal Bite Splint
Implant Planning and Surgical 9 -

GUI(.jeg Two Implant C Bonding Tray ' =
ne or Iwo implan ase (IBT) Align

- see chapter 24 Brackets to Wire
= Surgical Guide - see
chapter 17 P
* Denture - see chapter 26 N [
* Cephalometric analysis
= Cephalometric analysis
from an Image
= Cephalometric analysis
froma CT
» Crown and Bridge - see chapter 27
= Conventional Crown
= Crown on Ti-base
» Bridge
* Endodontics - see chapter 18
* Model Master - see chapter 13
» Model Master (CT)
= Model Master (STL Only)

Aligners

3.2 Project Setup

After selecting the module and planning type, the user enters the Project Setup flow, which consists of
two interconnected steps. In the Project Settings (1) the user has to create or select the patient,
treatment, and select the planned jaw. In Data Import (2) the user has to import the relevant data.
When all these required steps are done, it is possible to start the actual planning that has been
selected. Navigation between steps is provided by two blue arrows, Back (3) and Next (4). Returning
to the previous step (Back) is always allowed, while moving forward (Next) is only allowed if all the
requirements for the current step have been fulfilled.

© O0E= 03 &b

Project Settings Data Import
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3.3 Project Settings

The first step of the flow consists of: creating / selecting the patient (1), creating / selecting the
treatment (2), and, if available, choosing the type of jaw (3). Patient and treatment management
enables integration with online services, such as BioBigBox, LabPronto and iSmile.

3.3.1 Creating and editing patients

At the beginning, the new "generic patient" is automatically created. The user can also create the
patient manually by clicking the "Create New Patient" button - the "Add Patient" dialog will open.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 14
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D' Add Patient - Blue Sky Plan >

Last Mame
Email

Phone

Country United States of America (the)

Description

X Cancel

Creating a patient requires at least the "First Name" and "Last Name" fields to be filled. Other fields
are optional, though "Email" needs to be added in a standard email format. Click "Create" to add the
patient, or "Cancel" to close the dialog.

Patient
Select patient or create new one

Create New Patient Q

Last Name First Name

Any patient information can be edited later. To do so, click the "Edit patient information" icon on the left
side of the "Last Name" cell. Adjust any field as needed and click the "Update" button to save the
changes. The "Remove" button deletes the patient entirely, and the "Cancel" button closes the dialog.

3.3.2 Creating and editing treatments

After creating a patient, the new treatment is automatically created. The user can also create the
treatment manually by clicking the "Create New Treatment" button - the "Add Treatment" dialog will
open.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 15
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O Add Treatment - Blue Sky Plan X

Name Aligners

Description

Status new

Fields marked with * are required

Create X Cancel

The "Name" field is required for creating a treatment, other fields are optional. Click "Create" to add
the treatment, or "Cancel" to close the dialog.

+ Create New Treatment Q s

Name

As with patients, treatments can also be edited. Click the "Edit Treatment Information" icon on the left
side of the "Name" cell. The "Update" button saves the changes, the "Remove" button deletes the
treatment, and the "Cancel" button closes the dialog.

3.3.3 Sorting columns and search bar

To enhance the organization of patients and treatments, all columns in the tables can be sorted by
various criteria. Any patient and treatment can be easily found using the search bar.

3.3.4 Jaw selection

Some modules, like Orthodontics, require a planned jaw - maxilla, mandible or both jaws. Clicking the
planned jaw type enables the user to continue to the Data Import step.
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3.4 Data Import

The second step involves importing the data that is needed for the next step of planning. Depending
on the selected planning type, it will be necessary to import CT data or an STL model (or an image in
the case of Cephalometric Analysis from Image). When the user selects and confirms the desired data
in the window dialog that opens upon entering Data Import, the data is automatically categorized
based upon its titles. It is also possible to import data via the buttons "Import Model(s)" and "Import CT
Scan" (or "Import Image(s)" in the case of Cephalometric Analysis from Image)(1) or via the Import
Item ("+") button (2). Individual data are represented by a single item. The selected item is displayed in
the preview (3).

E a

o Project Settings Data Import

- -
I} mrort Modelis) Import CT Scan e

Project Data o Remove All

3.4.1 Data management

Project Data (4) contains mandatory and optional data. Mandatory data, outlined with a red border
until filled, are required for further planning (5). On the other hand, data that were automatically
classified as "Uncategorized" should be moved to the Project Data, if possible, because they might not
be included in further planning (depending on the planning type selected and the type of data).
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Project Data Remove All

1L

BSP_ 207 ...del upper
Mandible 3L Model Patient CT Scan

Buccal Bite

Data can be moved between categories via the drag-and-drop function (7), renamed by clicking on the
file name (8), shown or hidden in the preview (9), and removed either one by one using the cross (10)
or in bulk by clicking the button "Remove All" (11). Once all requirements are met, it is possible to start
planning by clicking the "Next" arrow (6).

3.5 Catalog management

Blue Sky Plan® allows the user to easily manage various catalog packages, including implants, teeth,
brackets, and buttons (1). The catalog overview provides information about the package name (2), its
size (3) and the package status (4)(installed or downloadable). Packages can be downloaded one by
one (5), or en masse (6). In either case, the user can easily track the download progress at all times
(7). Each package, except for those installed by default, can be uninstalled (8). If necessary, a
package can be imported manually (9) by selecting the appropriate file in the window dialog.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 18

BlueSkyBio



O Manage catalog packages - Blue Sky Plan X

Choose your favourite package, download and use it. You may import catalog. Import Catalog @

Implants Teeth Brackets Attachments o

Download all implants packages @
9 Package e Size e Status

BlueSkyBio 54.91 MB Installed

3P 5.26 MB Installed
AB Dental 13.95 MB New package
Adin 19.55 MB Installed
Advan 4.64 MB

All-Guide 1.95 MB

Status: READY
Downloaded files: 1

Files waiting: 0

Download speed: 0 kB/s

3.6 Project management

Blue Sky Launcher allows the user to access and manage existing projects saved in any module.
Each project provides key details, such as the patient's name, last update, project name and planning
type (1). The pin feature (2) makes projects easily accessible and displays them on the leftmost side.

Project Name bsb

-

Open Existing File

To open an existing project, the user can click the "Open Existing File" button (3) and search for it
through a pop-up file dialog. If the user wants to locate a project more specifically, they can use

the search bar function (4). Clicking the "Expand" button (5) will reveal additional projects with more
detailed information, and a preview (6). With the filter function (7), the user can narrow the list of
projects based on criteria such as the planning type, whether the project is pinned, or whether it is
saved on a cloud or locally. The "Clear filters" button resets all the applied filters (8). Finally, the project
section can be returned to its original size by clicking the "Collapse" button (9).
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Patient Name o
Today 10:09
Project Name bsh

g

Open Existing File

File Name Project Name
Medule Orthodontic
Project Type Aligners
Version

Created Today 12:09
Last Change Today 12:09
Path

File Size

To open a project, the user can either left-click on it and select the "Open Project" button in the pop-up
dialog or, if the project section is expanded, double-click the project or use the "Open Project" button
located on the right side below the project details.
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4 Licenses

The license system is based on the BlueSkyBio Digital account (hereafter the "BSB account")
environment, where one unique license is generated for each user. The whole process of license
creation is done automatically when the user launches the current version of theBlue Sky Plan®.

4.1 The main characteristics of licenses

» The credits from one user's account can be used on multiple machines. Exports on the given
license are shared between those multiple machines.

» The user can share their license with another user as soon as the owner of the license allows
sharing (through email approval).

4.2 License registration

The process of license registration is very simple and intuitive. On the first launch of Blue Sky Plan®,
the user is redirected to the BSB account login page in the browser.

’ . BlueSkyPlan LabPronto
Signin
O]

Enter email address or phone number
OR
€ Sign in with Google

T
Do not have an account? Sign Up

BioBigBox

G

Viewer Meonitoring

Sign in with Apple

Simulation University

\ «# BlueSkyBic

DIGITAL

If you don't yet have a BSB account, click the "Sign Up" button and fill in all the necessary fields. It's
also possible to create the BSB account and log in using a Google or Apple account.
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Create your Blue Sky Digital Account

o BlueSkyPlan LabPronto
OR
First Name * Last Name *
Email * BioBigBox
Password @ Confirm Password @
Password must be at least eight characters in length. It must contain at least cne
uppercase, lowercase, number and a special character. Viewer Monitoring
Select v Cell Phone
k | Simulation University
‘ ‘ | am human
— hCaptcha
Privacy - Terms
\ -
Sign In Instead Next B|IIES|(yBIO

DIGITAL

After creating the BSB account, a verification code is sent to the registered phone number.

2

BlueSkyPlan LabPronto

Sign in
Please type the verification code sent to +CED @ B¢

e : BioBigBox
\erification Code

(=
Remember me %

Viewer Monitoring

Resend in 40s. %

Simulation

- 3 RlueSiyBio

DidiTAL

Once the verification code is entered, the registration process is completed by confirming the email
sent to the user's email address.
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Welcome to Blue Sky Bio Digital Solutions!

Please confirm your account by pressing the button below.

Confirm

f 9 o in X

@ BlueSkyPlan.com Labrienio.com bio 9 BlueSkyMeet.com

Copyright 2024 Blue Sky Bio. All Rights Reserved.

Completing the registration process enables the user to access the Blue Sky Plan® application. The
current registered user is displayed in the top-right corner of the Blue Sky Launcher.
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VIEWER

ORTHODONTICS s SPLINT

®
IMPLANT .ﬂ* |
PLANNING AND DENTURE wsuny CEPHALOMETRIC
SURGICAL GUIDES ANALYSIS

i CROWN AND ENDODONTICS ’

BRIDGE
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MODEL MASTER
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If the user is logged out from Blue Sky Plan®, the application will automatically redirect them to the
BSB account login page, where they can log in with their email and password (or, alternatively, by the
verification code sent to their phone number). After logging in to the BSB account, the user is also
logged in to the BSB application.

4.3 BlueSkyBio Digital account options

In the top-right corner of the Blue Sky Launcher, the user may choose from different options linked to
their BSB account and online services in general.

Credits: 5.5

® =
9 o Profile... 9 9

@ switch User

To check and manage the BSB account profile in the browser, open the context menu by left-clicking
on the user's account and select "Profile..." (1). If necessary, the user can log out of the Blue Sky
Plan® and allow another user to log in by clicking the "Switch User" (2), which will automatically open
the BSB account login page in the browser.

In addition, the user can purchase credits (3), check if the application is updated (4), read notifications
(5) and join any online service offered by Blue Sky Bio (6).

4.4 Licenses in Preferences

The user can check their license in Tools > Preferences > BlueSkyBio Account.
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BlueSkyBio Account

General o User Info

Advanced First Name

Last Name

Launcher Email
Phone

BlueSkyBio Account

Country

Profile...

License

9 License key: -
Available license credit: 2.75 9

Machine count: 1

No subscriptions 9

=1 Order Export Credits

@ Apply Shared License

@ Pricing

STL export 1
Cephalometric export: 0.5
Orthodontic expor 0.5 per jaw up to 2
Custom abutments rt: 0.25 per abutment up to 32
Virtual teeth export: 0 per tooth up to 32
Denture export: 0.5 per jaw up to 2
Navigation export: 05

0.5 per jaw

Updated: 11-13708:03:40Z
Source: License Server

@ Restore Defaults Cancel

In "User Info" (1), the user can check the mandatory data, registered with their license. In this section,
the user can also view their own (private) license key (2), whereas in the "License" section the user
can view the license being used at the moment (3). This license can be their own (private) or a license
shared with another user. If it is shared license, both license keys (2)(3) will differ. "Available license
credit" (4) shows the remaining credit on the currently used license. The user also has an overview of
all the active subscriptions (5). Pricing (6) shows the cost of different types of exports. The user can
purchase credit or subscriptions by clicking the "Order Export Credits" button (7). The "Apply Shared
License" or "Disconnect Shared License" button (8) switches between a private license and a shared
license.

4.5 Shared Licenses

Users are able to use not only their own (private) licenses but also the licenses of other users. Such
licenses are called “shared licenses”.

In Tools > Preferences > BlueSkyBio Account, click on ,Apply Shared License®.
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BlueSkyBio Account

General User Info

P e First Mame
Last Name

Launcher

BlueSkyBio Account

Profile...

License

Licens

Availa

{& Order Export Credits

Apply Shared License

Enter the other user’s license key — you are now informed that the owner’s approval is needed. Note,
that both users must share the same country (Country Code), otherwise the sharing license won't be
possible.

2 Blue Sky Plan Suite - Blue Sky Plan X

Meanwhile, the owner of the license receives an email with the license request.
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‘-3 BlueSkyPlan.com

Powered by BlueSkyBio.com

License Request!

Dear Josef,

Approve

ma g

Approving this email will allow you to use the owner’s license on a computer with a unique machine
code.

B|UESkyP|an-C0m Purchase Exports Manage Credit Cards Login Signup ™ Czech Republic ~

Request for sharing your license on computer xxxx-Xxxxx-xxxx @il is approved.

When the owner of the license approves the request, the user who sent the request can click on
“Apply Shared License” again and confirm the shared license key. The shared key is successfully
applied and ready to use.
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-

O Blue Sky Plan Suite - Blue Sky... X

License successfully applied.

From now on, all credits will be deducted from the shared license. The user can switch back to their
private license at any time by clicking “Disconnect Shared License.”

BlueSkyBio Account
General User Info
Advanced Bestiame

Last Name

Launcher Email

Phone

BlueSkyBio Account

Profile...

able lic

hine count:

&) Order Export Credits

Disconnect Shared License

4.6 Purchasing export

If the user is logged into the Blue Sky Plan®, it allows them to purchase the credits or subscriptions
required for various types of exports.

The user can buy credits either by clicking "Credits" in the top-right corner of the Blue Sky Launcher,
or by navigating to Tools > Preferences > BlueSkyBio Account and click “Order Export Credits”.
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BlueSkyBio Account
General User Info

Advanced First Name
Last Name
Launcher £ il
Phone
BlueSkyBio Account ~
Country

License Key ~

Profile...

License

License key:

Available license credit: 19.75

(& Order Export Credits

Apply Shared License

The user is redirected to the "Purchase Exports" page, where they can select the desired package
type and proceed to the checkout.

Select Package Type
| padorepe | BgoriCrdis __FreeBonusCredis | Prie

® STLES 5 1 D

O STLE10 10 2 (]

O STLE50 50 3 D
O STLE100 100 5 G
O STLE200 200 10 G
O STLE300 300 15 G
O STLE500 500 25 L]
O STLE1000 950 50 L

Proceed to Checkout

The user can choose from various payment methods. After the ordering process is complete, the
export credits are added to the user’s license.
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Thank You

Your Orderid: 1148

@ Credits Have Been Added to License Number : xxxx-xxxx-xxxx -l
You now have_7 Credits Remaining.

Check the number of credits in the section “Active License Info” (Tools > Preferences > BlueSkyBio
Account).

License

License key:
Available license credit: 7.9

Machine count: 7
No subscriptions

1] Order Export Credits

Apply Shared License

The user also receives the order details at the registered email.
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5 Loading the patient’s CT or CBCT scan
into Blue Sky Plan

Blue Sky Plan ® can load uncompressed DICOM images (exported by all CT scanners) into the
software. Blue Sky Plan is “ self processing ” allowing the user to directly import the DICOM images in
a few easy steps. A complete scanning protocol is available via the Blue Sky Bio website and can be
sent to the scan site.

5.1 Selecting the DICOM images location

To import the patient’s CT or CBCT images, follow these steps:
1. Select planning type "Surgical guides" and then "Import Patient CT Scan".
2. A new window will appear.

Load DICOM Data

l Documents Jownloads 52 Metwork... .-_9 E=

l Patient CT for Model STL Wizard

010.dem

011.dem

013.dcm

014.dcm

016.dcm

017.dem 742 KB 24.04.2077 4:54

Cancel

Note that there are several shortcut buttons that appear on the top of the window. These buttons allow
quick navigation to the folder containing the DICOM images.

Select the directory that contains the DICOM images (you can also load a zipped file with DICOM
images) and click OK. Images must be stored in DICOM format from your Imaging Center in order to
load them into Blue Sky Plan®.
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5.2 Selecting the series

A list of available series that can be loaded will appear (1). Ideally each series should be saved in a
separate folder, and only one series will appear.

Please select one of the found DICOM series,

616 616 x 616 voxels

&l Bone
Expander - |
Kit = ===
An Alternative 1o ; é g E g A ? ”

Osteotomes s e s e i e

$549 A VD

' |
II'|IDUE||II‘I;' : — . = : @ BIIIESkyBiG.CO“‘I Order Now.

oK Canicel

[ Fix erroneous data

5.3 Enhancing performance

In the case that the computer does not have sufficient system or video memory, and possibly also if
the video card is not sufficiently powerful, the program makes it possible to reduce (downsample) the
input data; the user may set this manually for each axis or choose one of the available settings (2).

The software will automatically compensate for the “skipped” slices, and the quality of the treatment
plan and Surgical Template will not be compromised.

5.4 Scan alignment and defining the range of slices

In this step you align volumetric data and delimit the area of interest in the data. It is possible to crop
the data in all directions by dragging the yellow lines (1) or by directly setting the dimension of the slice
for the individual axes (2). The data display mode can be changed by selecting “Imaging Mode” (3).
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Please align dataset and select volume of interest...

BlueSkyPlan 4.7

FREE

Educational
Training Videos

|
'$ BlueSkyPlan.com WATCH NOW! &

Powered by BlueSkyBilo.com

The data can be aligned using the blue circles (4); it is also possible to enter values for rotation around
the individual coordinate axes manually (5). The transformation performed then applies correctlyfor
importing data.

Given the significant memory and performance requirements for visualizing 3D medical data, it is
advisable to crop the input data to the actual area of interest; this allows the program to run much
more smoothly.

5.5 Import additional surfaces

After loading CT data, the user can import additional surfaces. After choosing one, select the directory
that contains required model or scan.
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Impart Additional Surface?

E Impart STL Model

A\ Import CT Scan of Impression
L L )
ﬁ Impart CT Scan of Impression with Markers
. 8 8
MR Import CT Scan of Denture or Scan Appliance with Markers

- Impart CECT Model
—

5.6 Positioning the panoramic curve

The panoramic curve (the middle of the three, alternatively five, curves which appear in the axial
view)is generated automatically after importing CT data. It is possible to manually adjust it.
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This can be done by using the slider (1) to identify an axial slice which shows the complete arch/ridge of
the patient’s jaw. If necessary, it is possible to switch the display mode of the axial slice to an X-ray
display by clicking button (2).

The curve as a whole can be shifted by dragging red handle (3), and the width of the curve can be
adjusted by dragging any yellow handle (4). Dragging the yellow handle within the curve decreases/
increases the curve. By dragging any of the grey handles (5) along the curve user can align the curve

in position as desired.

Alternatively the entire curve can be redrawn by pressing the “Draw dental curve” button (6). The user
can left-click periodically as the mouse moves around the arch (from left to right), placing dots. The
software will connect the dots to draw the panoramic curve. When the curve is complete, simply
double click, orclick on the “Draw dental curve” button (3) again, or press “Esc”.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 35

BlueSkyBio



6 Software interface

Blue Sky Plan® allows seamless interaction among the various windows displaying the axial, sagittal,
coronal, cross-sectional, tangential, panoramic, and 3D images.

Depending on the intended use, it is possible to select the active windows for multi-planar functions
(axial, sagittal, coronal, and 3D) or implant functions (cross-sectional, tangential, axial, panoramic, and
3D).User can switch between different perspectives (in menu bar "View > Perspectives" (1),

alternatively by clicking on the button ﬂ in icon toolbar (2)). Within any perspective, it is possible to
add any view window (in menu bar "View > Views" (3)).

F Panels. Model Virtual Teeth  Module  Help

Views P e | L Py e m q"‘
gm seme | 4 J *"-E Eu

Panels k

wes 2 PONTO - F@ E
Perspectives | o 5

3D

2D

Objects
Curve

Reset Zoom

Load Default Layout

The following information and tools can be viewed in most of active windows:
« individual colors for each cross section of images,
* indicators showing the current position of the images,
* label of the image
* rulers

6.1 Screens and views

The implant screen allows visualization of the cross-sectional, tangential, axial, panoramic, and 3D
images. All implant planning tools can be accessed through the menu bar (1) below. The icon toolbar
and the panoramic image toolbar (2 and 3, respectively, in the following illustration) show the most-
used tools.
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6.1.1 Axial window

The axial images are horizontal slices of the volume and can be seen in the middle top (or in the
following illustration) view in the application (1). They are marked in blue. All the other images are
generated from the sequence of axial images.

By moving the axial slider (2), it is possible to view the whole sequence of axial images. The indicator
line of the axial slice appears in the cross sectional, panoramic, and 3D images (3).
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6.1.2 Cross-sectional window

The cross-sections view displays vertical slices going around the patient’s ridge. As the user moves
through the slices using the cross-sectional slider (1), the corresponding multi-color lines in the axial
and panoramic views (2 and 3) will move accordingly, identifying the location of the five (or

three) images being displayed in the cross-sectional views.

These images are used to evaluate the bone height and thickness in planning. When implants are
placed, they are often placed into one of the images in the cross-sectional view.

The distance separating the images can be modified by clicking on the . icon (4), and a new value
can be selected from the drop-down menu. By default the distance between images is set to 1mm.
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6.1.3 Panoramic window

The panoramic image is located in the bottom right-hand window of the application (1) and is marked
with light green.
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The indicator line of the panoramic slice appears in the cross-sectional (2) and axial (3) views. As the
user flips through the panoramic images, the panoramic curve will move along the horizontal axial
plane to indicate the location of the specific slice represented by the location of the panoramic curve.

The range of the field of view reachable by the panoramic curve can be adjusted by clicking on the

offset distance icon .(4) and by choosing an appropriate step. The change in the range of slices
reachable by the panoramic curvewill be represented by a change in the distance between the inner
and outer panoramic curves.

The view mode button E (5) will change the panoramic view into a composite image representing an
image similar to an X-ray. In such a situation the panoramic curve in the axial view will disappear, as
no individual slices are being represented, and instead a composite image of all the slices within the

relevant range is displayed. Selecting the view mode button E again will return the panoramic view to
the standard section view.

6.1.4 Tangential/implant window

The tangential view is located in the upper right-hand part (1) of the application and is marked
in green. It works in two modes. If no implant is active, it displays the view orthogonal to the cross-
section view (tangential to the curve).

The plane displayed can be rotated with the slider in the tangential view window (1) or by dragging the
line displaying the intersection of the plane with the axial slice in the axial view window (2). The
direction of view on the plane of the tangential slice is indicated in the axial view with a green triangle.

If an implant is active, the view orients itself in a tangential position to the curve when switching to the
implant. Nonetheless it does not display the perpendicular plane but rather the plane passing through
the implant. In this mode the orientation of the plane is indicated not only in the axial view but also on the
associated implant in the 3D window (3).

If the implant is rotated in a different view, the plane displayed in the window (1) automatically changes to
the rotated plane of the implant.
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Thanks to the option of rotating the plane passing through the implant, it is possible to easily check
and correct the tilt of the implant's position when viewing from any angle.

File Edit Tools View Panels Implants Virtual Teeth Module Help
TS TIPYEEY v
d)Start Wizard

Pronto -

-11.0 mm

6.1.5 3D View

The 3D image is located in the bottom left-hand view of the application (1). To rotate the 3D image,
click and hold the left mouse button in the model, to zoom, click and hold the right mouse button.
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6.1.6 3D Shortcut buttons

The 3D view has several valuable shortcut buttons on the right side of the view.
The first button (2) maximizes the window.

The second button (3) allows the user to change the positioning of the view. The user can click on the
button to open a fly out menu. The orientation of the patient’s anatomy will adjust according to the
option chosen.

The third button (4) allows the user to take advantage of different volume rendering options. It is
possible to set the rendering type and quality using the contextual menu options or the Volume
Rendering panel, which can be accessed from the menu under the "Panels" option.

The “Presets” option opens a selection of different 3D volume rendering presets with different coloring
schemes.

In “Surfaces” mode, differential surfaces (“CT surfaces”) are depicted (1) that are defined in the
“Surfaces” panel, which can be accessed from the main menu under the "Panels" option or by double-
clicking in the 3D window.

The user can assign a name to each density surface and set threshold values, the color, or the
transparency.

In the “STL Surfaces” table located on the same panel (2), users can find created or imported models
for which it is possible to set the color, visibility, and transparency.

The visibility of STL models, unlike that of CT surfaces, is not affected by the chosen volume rendering
mode.

The fourth button (5) turns on the visibility of the slices in the 3D window.
The fifth button (6) inserts a current snapshot of the 3D window into the "Screenshots" panel.
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6.1.7 Surface culling (3D cut)

A 3D visualization can be cropped with the Surface Culling function (3). In “Surfaces” mode, each CT
surface is cropped independently of the others. The first non- JEEr

deletable surface shares its cropping area with the other
visualization modes (Shaded Bones, MIP, X-Ray, etc.).

Visible Hint  Cole

inverted mesh

Cropping serves to:
* remove noise
* remove superfluous anatomy
* isolate anatomy

The cropping tools are in the lower part of the “Surfaces”
panel (3). It is possible to crop data with the "Cut" button, to
delete a previously performed crop with the "Clear" button, e —
and to isolate the selected anatomic portion. It is also
possible to invert the current cropping.

After the user clicks the “Cut” button, the application switches
to drawing mode. At this point, by clicking on the left mouse
button in the 3D window and dragging the cursor, it is
possible to draw an area which is cut out of the selected
surface after when the mouse button is released. Drawing
can also be invoked at any point by pressing the “Shift” key
and holding it down during the whole drawing period.

If we want to isolate a particular part of the anatomy, we must
first ensure that it is not connected to any other parts. We can
ensure this using the cropping function described above. We
can isolate anatomy in this way with the “Isolate” button and fimsl wdsh s
by clicking on it in the 3D window. All parts of the anatomy
are then removed except for the selected part.

As soon as we have a cropped part of the anatomy that we
want to display, it is possible to invert the cropping with the
Invert check box.

Name Visible Hint  Color

Original

Duplicate

¥ Surface Definition
Minimum e

Maximurn  E—— | |

Any cropping actions can be reversed using the “Undo” ¥ Material
function. Specular |

Shininess L )

Transpa

Cut Al

6.1.8 Indicators

The indicators are reference lines that indicate the positioning between the images shown on the
screen.

Usually the indicators are already enabled in the windows of 2D images. To disable them, click “View >
2D” in the menu and choose the indicator to be disabled.

It is also possible to enable the indicators on the 3D images. Click “View > 3D” in the menu and
choose the projection type to be enabled on the 3D image.
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To change the visibility of objects, such as implants or teeth, it is possible to use the associated
panels, the buttons in the icon bar (1), or the “View > Objects” option in the menu bar (2). After
switching the visibility of the dental curve and slice indicators in the 2D views, it is now possible to

use the “All projections” (alternatively the "Hide all projections") icon in the icon bar.
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6.2 Multi-planer screen

To access the multi-planar screen, click the “View > Perspectives > MPR” menu option. The multi-
planar screen makes it possible to view coronal, axial, sagittal, and 3D images. This screen is
generally used for applications such as oral and maxillofacial lesions and defects, removal of impacted
teeth, and treatment of temporomandibular joint pathology.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 44

2025-05

BlueSkyBio
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To locate the desired image, move the slide bar located next to the windows. Indicator lines show the
exact image position of one window in relation to the images in the other windows.

6.2.1 Sagittal window

The sagittal image is a vertical plane that divides the skull into a right and left side. It is located in the
bottom left window of the software (1) and is marked in yellow. When the user moves the scrollbar of
the sagittal window (2), the entire sequence of images in this group will be shown. The indicator line of
the sagittal slice appears in the coronal (3), axial (4), and 3D images.
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6.2.2 Coronal window

The coronal image is a vertical plane that divides the skull into a front and back part. This image is
located in the top right-hand window of the application and is marked in pink. When the user moves
the scrollbar in the coronal window, the entire sequence of images in this group will be shown. The
indicator line of the coronal slice appears in the axial, sagittal, and 3D images.

6.3 3D Mouse Controls

BSP allows the user to use a 3D mouse. In order to use it, please download the software from this
web page https://3dconnexion.com/drivers/.
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After installation, open the 3Dconnextion Settings and click on Buttons (2) to open the buttons menu.
Make sure you have set Blue Sky Plan (1) for 3D mouse settings.
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Blue Sky Plan @

SpaceMouse Compact

Speed

Advanced Settings Buttons

(7 30connexion Close

In the buttons menu for Blue Sky Plan, set the left and right mouse buttons (3) for the controls. Blue
Sky Plan allows the user to set the controls (4) for: File, Objects, Orthodontics, Panels and
Perspectives.

Blue Sky Plan

SpaceMouse Compact

LEFT Import STL <

RIGHT Open Export Dialog

: Blue Sky Plan @
File

Q7 30connexion Restore Def: Objects

Orthodontics

[71 Panels

| Perspectives

~1 3Dconnexion

1 Applications

The user is able to set basic functions such as undo/redo, copy/paste or camera controls. You can
also set BSP functions which control the program’s Ul.
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All options can be restored by clicking on the "Restore Defaults" button. For more advanced settings,
click on the "Advanced Settings" button.
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7 CT Dicom Viewer

CT DICOM Viewer simplifies working with CT Data, especially for reviewing CT scans. To start a new
project, click on the CT DICOM Viewer button (1) and choose a file containing DICOM data (2). The
next steps involve selecting one of the DICOM series (3) and defining the volume of interest and
imaging mode (4).

CT DICOM Viewer can be set as the “shell open module” in Preferences -> Advanced (i.e. the default
module in which data is opened “when double-clicking”).

The CT DICOM Viewer is based on the Model Editing module, the main differences between the two
are:

» Projects saved in the CT DICOM Viewer can be opened in the Model Editing module

Ul changes done in the CT DICOM Viewer are not saved (toolbars, panels...)

The “Import Additional Surface” dialog doesn’t appear in the CT DICOM Viewer

Only the Main Toolbar, Measurements Toolbar, and Messages Toolbar are activated by default
Brightness/Contrast, Ortho Slices, Volume Rendering, Surfaces, Notes List, Nerve List, and
Screenshots panels are available by default

To work with additional tools (chapter 7), select the Model Editing or Surgical Guides (chapter 15)
modules from the Blue Sky Launcher or switch to the Normal/Advanced module.

(1)

EASY CT DICOM
VIEWER

ORTHODONTIC! 2 SPLINT

IMPLANT ™

PLANNING AND DENTURE s CEPHALOMETRIC
SURGICAL GUIDES ANALYSIS

E“- CROWN AND ' mm" ENDODONTICS

BRIDGE

)

MODEL MASTER
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@ Load DICOM Data - Blue Sky Plan
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8 Placing implants and pins

Blue Sky Plan® allows virtual implant planning via the patient’'s CT or CBCT images. It is possible to
add, exchange, move, and rotate the implant and abutment or pin in the different views.

8.1 Adding an implant or pin

8.1.1 Implant from the catalogue

Before positioning the implant, it is recommended to first measure the dimensions of the bone. In this way

it is possible to estimate what dimensions the implant should have. Clicking on the icon in the toolbar
opens a dialog for adding an implant.

@o lew Implant

Implant = Abutment  Software Guide Tube  Pin Preview

Customization Implant Orientation e

(:) Select Implant

(O Custom Implant

Implant system: Blue Sky Bio e

Showing implants for kit: Blue Sky Bio Fully Guided Surgical Kit

Type Implant e

e
E__3
A
—

—

E
o Name Label Apical Diameter = Occlusal Diameter Ler S—
=
=

BIO | Conus 12 (Compatible with Astra Tech Dental ) IDH3010 2.16 mm 3.00 mm 10.00 m

IDH3011 2.16 mm 3.00 mm 11.00 m
30 2.16 mm 3.00 mm 13.00 m

BIO | Multi One
Platform

3.00

S Description o

4,00 - BIO | Conus 12 (Compatible with Astra Tech
Dental®)

Cancel

In this dialog it is possible to modify the implant parameters, abutment, and drill guide. The
corresponding parts can be selected in the individual tabs (1). “Select Implant” (2) is selected by
default, which makes it possible to select an implant from the catalog (3) on the basis of its type (4)
and platform (5) and then according to its parameters (6). It is also possible to specify the orientation
of the implant (7). The currently selected implant can be viewed in the preview (8). A short description
of the implant (9) is also located in the lower part of the dialog.
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8.1.2 Automatic implant from the catalog

The automatic implant is added via the “Add Tooth” function in the Normal or Advanced module. By
default, the “Automatically create Al Tooth” (1) tab is selected. Then choose the associated tooth from
the preview (2) - the text description of the crown appears in (3). Then use the "Implant" checkbox (4)
to enable the field with the implant parameters. By clicking the implant field (5), the “Add New Implant”
dialog appears.

@ Add tooth o

Automatically create Al tooth  Select tooth from catalog

Preview

T YEEERILERERRY Y

I EENRERRRERERA]
(2

Select the tooth.

Name e

Left Mandibular First Molar

Implant o

Blue Sky Bio IDH3010 with ABDH30 9

Cancel

In this dialog, select the “Automatic Implant” (6) option which automatically selects a suitable implant
from the selected manufacturer. It is possible to select an implant system from the catalog (7) by
clicking the dropdown menu (note: it is important to have the relevant implant catalog package
downloaded). The automatic implant option allows the “Implant Type” (8) to be chosen. The specific
platform and implant (10) will be chosen automatically. “Implant Orientation” (9) cannot be

changed because the implant is linked to the tooth that is selected in the "Add Tooth" dialog. To add an
abutment to the automatic implant, switch to the "Abutment" tab (11). Automatic implant is selected by
clicking the “OK” (12) button.
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© Add New|®

Implant | Abutment Software Guide Tube Preview

Customization Implant Orientation

O select Implant e
® Automatic Implant o
O Custom Implant

Implant system: Blue Sky Bio o

Showing implants for kit: Blue Sky Bio Fully Guided Surgical Kit

Type o Implant @

Name
BIO | Conus 12 (Compatible with Astra Tech Dental ®)
BIO | Forte (Compatible with NobelActive ®)
BIO | Internal Hex (Zimmer Tapered Screw Vent®)

BIO | Max (Compatible with NobelActive ®) Spec‘lﬁc Imp|ant W|l| be Choseﬂ

BIO | Max Mini (Compatible with NobelActive @) aUtO matica”y

Platform

Description

BIO | Conus 12 (Compatible with Astra Tech
Dental @)

Cancel

"Custom Abutment" allows the individual parameters of the abutment to be changed. The size of the
last implant used is display by default. By switching to the "Implant" tab for an automatic implant, the
custom length and diameter will be set to 3x20 mm.

@ Add New Implant
Implant = Abutment Software Guide Tube Preview
Customization

O No Abutment
® Select Abutment
O Custom Abutment

Abutment

Specific abutment will be chosen
automatically.

Description

BIO | Conus 12 (Compatible with Astra Tech
Dental®)

Cancel
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It is possible to see what kind of implant and abutment has been selected in the implant field (13). An
automatic implant with an Al tooth will be added by clicking the “OK” (14) button.

@ Add tooth

Automatically create Al tooth = Select tooth from catalog

Preview

T YEEERYIERERERY Y

Select the tooth.

Name

Left Mandibular First Molar

Implant

@ Automatic implant Blue Sky Bio - BIO | Conus 12 (Compatible with Astra Tech Dental ®) with automatic abutment

® 8] ¢ Cancel

For automatic implant placement, it is necessary to introduce two control values, both found in
Preferences > Surgical Guide. These values help set limitations and custom preferences for implant
placement. The first control value, "Subcrestal Depth," measures the distance from the edge of the
bone to the occlusal center of the implant's vertical axis. It is useful when the bone has an uneven
crest shape. This allows the implant to be placed deeper into the bone. If the implant is not deep
enough, it might end up too thin due to the bone crest shape restricting it. In such cases, the
"Subcrestal Depth" can be increased to allow the implant to be placed deeper, thereby
accommodating wider implants. The second control value, "Max Implant Width", is used to limit the
width of the implant, ensuring it does not become too thick.
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Surgical Guide

G I'a
General Guide Curve Suggestion

Customization G rgin on the e 1,00 mm

2,00 mm
Project

Shortcuts
Advanced
BlueSkyBio Account
e 12,00 mm
Surgical Guide s e 1,50 mm

5,00 mm

Default Ma: dercut 0,10 mm

Endo Mode

Note: Automatic implants are only available when adding an Al tooth and if CT data are imported.
8.1.3 Custom implant

If none of the implants fulfills the particular requirements, it is possible to create a simplified but fully
parameterized implant. This is achieved by clicking on the "Custom Implant" option (1). The individual
parameters (2) can be modified with the corresponding fields. These changes appear immediately in
the preview.
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@ Add New Implant

Implant = Abutment  Software Guide Tube Pin Preview
Customization Implant Orientation

O Select Implant

@ custom Implant o

Showing implants for kit: Blue Sky Bio Fully Guided Surgical Kit

Implant e

Length 10,00 mm
meter 2,16 mm

al Diameter 3,00 mm

Description

Fully customizable implant.

8.1.4 Abutment from the catalogue

By default, the implant is loaded without an abutment. If we want to add an abutment, it is necessary
to first switch to the "Abutment" tab (1) and then select the "Select Abutment" option (2). A list of
abutments that are compatible with the selected implant appears in the table (3). Once we have
chosen a parameterized implant, a table for selecting the type and platform will be displayed here
similarly as for the implant.
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Add New I*ﬁlant

Implant Abutment Guide Tube Pin

Abutment e

Label Diameter Length

ABDH30 4.50 mm 7.57 mm
ASDH3002 4,67 mm .00 714 mm
AUCLADH3D 3.61 mm .00 521 mm
BlueSkyBio Scanbody  5.99 mm .00 ° 15.01 mm

Dess Scanbody 5.99 mm .00 ° 15.01 mm

- R R iR

MORKDH3003 3.86 mm .00 = 9.50 mm

MORKDH3003-HGF5  3.86 mm .00 = 9.50 mm

MORKDH3005 3.86 mm .00 = 11.51 mm

MORKDH3005-HGF5  3.86 mm .00 = 11.51 mm

MPADH30 3.51 mm .00 = 14.94 mm

Cancel

8.1.5 Custom abutment

The abutment can also be fully parameterized in the same way as the implant. We first select “Custom
Abutment” (1); it is then possible to set the individual parameters (2).

Add New Implant

t Abutment Guide Tube Pin

ation

Description
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8.1.6 Software Guide Tube

The implant has an auxiliary drill guide added by default. If we want to modify it, it is necessary to
switch to the “Software Guide Tube” (1) tab. Its parameters can be changed in the corresponding fields
(2). If we want to display it or hide it in the preview, we can use the check box (3).

oftware Guide Tube  Pin

suide Tube In Preview

8.1.7 Pin from the catalogue

Instead of an implant, it is possible to add a pin (1). This is a special implant for positioning a template
more firmly. In contrast to an implant, it cannot have an abutment but only a drill guide.
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Implant ~Abutment

Handle Length

8.1.8 Your own pin

It is also possible to adjust your own pin similarly as for previous parts (1). Length 0 (2) sets the length
of the blue part of the pin; length 1 (3) then sets the length of the green part.

Implant  Abutment

Diameter

Length 0 @
Length 1 6
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8.2 Positioning and manipulating the implant

We confirm the choice of implant in the dialog by pressing “OK”. The mouse cursor then changes to

0@-,,, . We can then position the implant by clicking on the slice and, if necessary, on the 3D visualization
in any window. After being added, the implant is always positioned perpendicular to the selected
orientation. It is up to the user to fine-tune the position and rotation.

It is possible to move the implant in all of the windows. This is achieved by moving the cursor onto the
implant, clicking the left mouse button, and dragging. The implant always moves in the plane of the
view.

Besides moving it, it is also possible to rotate it using the so-called draggers. These are displayed
when you position the cursor on the implant, its abutment, or the drill guide. By moving the mouse
cursor onto the dragger and left-clicking the mouse, the dragger changes color, and by dragging the
mouse it is possible to modify the implant’s rotation.

8.3 Further operations on the implant

8.3.1 Toolbar

In the upper menu bar it is possible to display a toolbar of further operations on the implant by
selecting “View > Toolbars > Implants Toolbar”. Here are icons for removing the implant (1), replacing
the implant (2), displaying information about the implant (3) and Endo mode for placing implants by tip
((4) see chapter 17).

Operations 1 and 3 are used in the same way: click on the icon, move the cursor onto the implant, and
click on it. For the option of replacing the implant (2), the same dialog appears as when adding an
implant, in which we choose which implant we want to replace the selected implant with.
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8.3.2 Context menu

Show D

Lock Ir'nplant

Show Properties
Replace Abutment
Duplicate

Align

Replace

Software Guide Tube ¥
Rotate around »
Pivot ]
Deselect
Visibility

Validation Warnings
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It is also possible to perform several operations on the implant via
the context menu, which we can invoke by clicking the right
mouse button on the implant.

It is possible to display the implant ID (a short editable description
of the implant) or its properties. It is also possible to lock the
implant against edits. The locked implant has a padlock icon
displayed next to it. It is similarly possible to replace and, if
necessary, add an abutment. The entire implant can be duplicated
or aligned with another implant. That means that although the
implant remains in its position, it turns in the space in such a way
that its axis is parallel to the axis of another implant. A complex
implant replacement can also be performed from the context
menu. The implant can also be removed. Besides this it is
possible to change the point around which the implant rotates
during manipulation (the so-called Pivot). It is possible to cancel
the choice of the active implant via the context menu. Finally, the
visibility of individual parts of the implant can be changed
(“Visibility > Implant/Abutment/Software Guide Tube”).

Pivot set to Center. The implant rotates around its center.

Pivot set to Head. The implant now rotates around its head.

Pivot set to Tip. The implant now rotates around its tip.
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8.4 Side panel

To make it easier to find our way among implants, the side panel can be displayed via “Panels >
Implant List”.

Implant List

Drill Kit
Custom Kit
Implants
Label

<]

It contains a list of all the implants (1), the settings for the
transparency and visibility of the outlines in the 2D view (2),
the parameters of the active implant (3), its abutment (4), and
the drill guide (5). For a pin, the properties of the pin are
displayed instead of the properties of the implant and
abutment. For the implant and abutment sections, there are
also “Customize” and “Replace” buttons. The “Customize”
button replaces the implant with its fully parameterized
variant. “Replace” opens the same dialog as for adding an
implant and makes it possible to replace the implant with the
v nlent 2020 @) selected variant.

e Several properties of the implant can be changed quickly in
the list of implants. One is the ID (6), which is a short
description of the implant. It is possible to change the
visibility of the ID by double-clicking on it and to toggle its

¥ Abutment: - custom - visibility in the windows with the check box. The check box
Length under the implant (7) changes the visibility of the implant, the
check box under the abutment icon (8) toggles the visibility of
the abutment, and the check box under the drill guide (9)
changes the visibility of the drill guide. All the visibility
settings are independent of each other. Finally, every implant
v aiceTue @) has an icon for removing it (11) and locking it (10).

Guide Hole Diameter

&l &

Transparency

Implant outline [

Apical Diameter

Restore Defaults

8.5 Dialog with the parameters of the selected implant

The parameters of the implant can be displayed from the context menu. If the side panel is displayed,
then the associated implant is selected in this panel, and its parameters appear. If this panel is hidden,
a special dialog appears when the user attempts to display the parameters. It again displays the
implant ID (1), the parameters of the implant (2), the parameters of the abutment (3), and the
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parameters of the guide tube (4). For a pin, the parameters of the pin appear here instead of the
parameters of the implant and abutment, similarly as in the side panel.

General o

Implant ID

Implant 9 Abutment: - custom -9 Software Guide Tube 9

pter D e

] Implant visible ¥ Abutment Visible uide Tube Visible

14,00 mm

Customize

8.6 Validating implants

All implants are validated on the background. That means that their positions with respect to each

other and to the nerves are checked. If an implant is evaluated as invalid, the @ icon appears next to
it.

The first criterion considered is the distance between implants.
If two implants are too close to each other, both are evaluated
as invalid, which is represented by the appearance of icons
over both implants.

The second criterion is the angle between implants. If this angle
is too large, the implants are again evaluated as invalid, despite
the fact that they are relatively far apart. To fulfill the validation
criteria, we must reduce the angle between the implants and, if
necessary, to increase the distance between the implants again.

The third criterion is the distance from the nerve. The same considerations apply here as for the
distance between implants.

If you are not certain why the validation had failed, you may open a panel with the validation results via
“Panels > Implant Validation”. In this panel it is also possible to set the validation parameters (1).
There is a list here of all invalid implants (2) and the reasons the validation of the selected implant
failed (3).

Note: pins are not validated either against themselves (or implants) or against nerves.
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8.7 Ordering implants

Implants can be ordered directly from the application by selecting Order Parts in the toolbar.

%ﬂv%'»n'_%F_Esm(@\.-:"-.é-.-.;..- Fuaf-iS I Teniais xcat O e *

The Blue Sky Bio website will load automatically, and the implants which were used in the treatment
plan will be added automatically to the shopping cart. Additional implants and items can be added to
the shopping cart by continuing to shop via the website.

If custom implants were used (implants that were not selected from the Blue Sky Bio catalog) in the
treatment plan, those implants will not be added automatically to the shopping cart.
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9 Tools

This chapter explains the properties of each Blue Sky Plan® tool and the toolbar that contains the
most-used tools in the application.

9.1 Toolbar

1 — Menu bar (access to all the software tools)
2 — Icon bar (fast access to the main tools)
3 — 3D view icons (view rotation, volume rendering settings, and visibility of slices)

4 — Panoramic icons (offset step, X-ray mode, etc.)

e i TeoE  Vas  Peeh gl el el Mskis ey
EN-ThHam =sf 0w a0 s S a Vwvetdw Lo
) S Pronto- Exports e~aEacs oW |0 s

Further toolbars can be displayed by means of the context options in the main bar or via the option
“View > Toolbars”.
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9.2 Opening a project

B new project o
BB open Project... 9 Ctrl+0

Save Project Locked...

B Close Project @ After clicking the "File > New Project" (1) menu option the
% Import STL Model... application will return to the main menu. You can create

. BT T new project by selection of planning type. Already existing
project you can open by clicking the "File > Open
Project" (2) and the most recent used project you can
e open through the "File > Recent Projects” (3).
Export Data...

Create Analog Holes

B Purchase STL Exports...

. Print...
Save Image... o
. Drill Report
' Approve Plan...
L Anonymize...
- Show Data Properties...

W )

Exit Ctri+X

9.3 Saving a project

To save a modified project, click the “File > Save Project” (4) menu option. To save a project under a
new name, click the “File > Save Project As” (5) menu option.
9.4 Closing a project

To close a project file, click the “File > Close project” (6) menu option.

9.5 Saving images in JPG format

To save the currently visible screen images in .jpg format, click on the “File > Save Image” (7) menu
option, then choose the folder where you want to save the images or PDF file.
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9.6 Saving screenshots and generating a Drill Report

Screenshots can also be captured individually using the "Screenshot" button (1) located on the right
side of each view. Captured screenshots are inserted into the list in the “Screenshots” panel (2), which
can be accessed from the "Panels" menu.

For most slices this makes it possible to extract not only the current view, but also all further possible
slice positions with the current settings. Snapshots are captured in the size corresponding to the
current window size and the setting (3) in the "Screenshots" panel.

ile Edit Tools View Panels Implants Virtual Teeth Module Help
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Using the context menu options, by clicking the right mouse button (4) in the list of screenshots (2), it
is possible to copy the selected screenshot to the clipboard, save it to a disk, or remove it from the list.
The screenshot can be displayed in its original size by double-clicking on the preview.

Snapshots can be saved individually in the selected bitmap format (5), a PDF document of all the
windows can be created (6), and the document can be printed out directly (7).

9.6.1 Drill report

A set of screenshots can also be created with the "Drill Report” button (8) which creates a set of
snapshots containing the 3D view, the panoramic view, and a pair of the normal and tangential view for
each planned implant.

9.6.2 PDF export and print settings

When exporting to a PDF file and printing, the layout of the images on the page can be selected
in the "Page layout" section (1). In "Downsize only” mode (2) the program will not enlarge the
images and will attempt to maintain their actual size.
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The document created can be supplemented with a user header (3) and footer (4), basic information about
the patient and project (5), a table of implants (6), and a description of each image inserted in the
image (7). Once the settings are confirmed, the document created appears in the preview window.
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9.7 Modifying window and level

The display brightness and contrast of density data can be changed in the "Brightness/Contrast"
panel (2), which can be accessed from the "Panels" menu (1). The brightness and contrast can
also be changed with a special mouse mode (3) in which movement along the horizontal axis
while pressing the left mouse button changes the brightness, and movement along the vertical
axis changes the contrast.
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9.8 Zooming
To zoom in, press and hold down the right mouse button and drag the mouse up or down.

A second option is to select the zoom icon (as shown below) and hold down the left mouse button
while moving the mouse forward or backward.

S P

9.9 Moving the image

Click on the Move Image icon and drag the image as desired. An image can also be moved by
holding down the mouse wheel (pressing it, not scrolling it) and dragging the image.

S

9.10 Moving objects

In the default mouse mode (represented by Trackball Mode icon E in the icon bar), left-clicking
changes the position of the slice. If the mouse cursor is positioned over an object that can be
manipulated, the mouse cursor changes, and the object can be moved, and if necessary its angle of
rotation or size can be changed using the displayed dragger.
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9.11 Measurements and overlays
Users can perform any measurement of density (1), length (2), or angle (3) in 2D images. They can
also insert arrows (4), text descriptions (5), or rulers (6).
8 Add Nerve Ctrl+Shift+N
Add Marker

Add Text 6
Add Scale @

Draw curve

Density Value Measure [Hu] 0

Distance Measure [mm)] ( I9|’rt+['l
Angular Measure [*] e.rhn

Clear Notes

Clear Measurements
Manage catalogs

Preferences..,
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9.12 Linear measurement

Click the “Tools > Distance Measure” menu option (2) in order to perform any 2D measurements.

Click the left mouse button with the pointer on the image to mark the start point of the distance to be
measured and click again on the image to mark the end point of the measured distance. To correct the
measurement you can grab one of the end points and move them.

9.13 Angular measurement

Click the “Tools > Angular Measure” menu option (3). Click the left mouse button with the pointer on
the image and repeat the process twice to get an angle. To correct the measurement you can grab the
points specifying the angle.

9.14 Density measurement

Click the “Tools > Density Measure” menu option (1). The value of the density measurement is
obtained from the information contained in the patient's image and can vary for each CT or CBCT
scan. The measurements are given in Hounsfield units.
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9.15 Measurement correction and number position

The user can correct the measurement and all the overlays in the default mouse mode. It is possible to
correct a measurement by clicking at the edge of the measurement with the left mouse button and
dragging. It is also possible to position the numerical value of the measurement outside of the image.

9.16 Deleting a measurement
It is possible to erase a measurement in two ways:

a) Click the measurement edge or click on the number with the right mouse button. A menu will
appear with the deletion option.

b) Click the “Panels > Notes List” menu option. A panel will appear (7) with a list of all
measurements, their types, values, and colors. To erase a measurement, click the X beside the
measurement.

9.17 Overlays

To add text or other types of overlays, select the corresponding action from the “Tools” menu. Specify
the position of the item in the selected window by clicking on it. The inserted overlay is bound to a
specific position in the slice; it will not be visible for other positions. Orthogonal slices and the normal
slice can be positioned in the location of an overlay by double-clicking on the "Note Type" field (1) or
"View" field (2) of the associated item.

Marker

Angle

Distance

The text of an overlay can be changed by clicking on the “Note” field in the “Notes List” panel (7) or via
the context menu on the item in the associated slice. The color of several types of items can also be
changed in the "Notes List" panel by clicking on the “Color” field.

9.18 Panoramic

A panoramic image is a panoramic slice of the mouth and teeth. It is a perpendicular plane of the axial
image.
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9.18.1 Creating a panoramic line

Refer to Section 4.6.

9.18.2 Mandibular canal

The mandibular canal can be added in the panoramic image and viewed in all of the images.

9.18.3 Adding a mandibular canal

Adjust the panoramic curve to fit the patient’s arch as described in section 4.6. Click on the "Add
Nerve" button either located in the icon bar or under the "Tools" option in the menu bar (1). The Nerves
panel (2) will appear and show the default properties for the nerve (3). Click on portions of the nerve in
the panoramic window and follow the canal to the mental foramen.

When entering nerve points, the position of the slice can be changed with the scroll bar on the right
side of the window, and the last-added point can be removed with the "Edit > Undo" action. You can
fine tune the buccal/lingual aspect by adjusting the nerve point in the cross-sectional view later. Add
another nerve by clicking the “Add Nerve” button (4) on the Nerves panel, and repeat on the other
side. All images should show the nerve with a default diameter in yellow.
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It is also possible to add a nerve by clicking the "Detect Nerve" button, where a whole nerve canal is
added by clicking inside the mental foramen in the corresponding slice of the cross-sectional view. You
can also use the fully automatized nerve detection by clicking the button "Autodetect Nerves".

Merve List
Add Merve
Autodetect Merves
Detect Nerve

Click inside mental foramen.

Edit Merve

9.18.4 Changing mandibular canal parameters

Clicking on the color of the nerve in the list (2) opens the color selection window. After choosing,
confirm the selection by pressing “OK”. The width of the nerve is displayed in the adjacent column.
This can be changed either by clicking on the window and entering new values or by repeatedly
clicking on the arrows beside it to change the value in increments of 0.1 mm.
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9.18.5 Deleting the mandibular canal

Select the “Panels > Nerve List” menu option and click on the letter X beside the nerve to be deleted.

9.18.6 Canal display in different panoramic view modes

As described in Section 5.1.3, within panoramic view it is possible to switch between composite mode
and slice display mode. In composite mode, the entire mandibular canal is displayed in the form of an
outline, including all control points (see image). In slice mode, only the control points near the
panoramic plane are visible. The mandibular canal itself is only displayed in the form of slices of the
same plane

9.19 Show Dimensions

This measuring tool is available in the Model Master, Advanced and Surgical Guide (Endodontic)
modules. Right-click on an object in the 3D scene and select "Show Dimensions" from the context
menu. The dimensions are hidden by clicking "Hide Dimensions" in the same context menu. In Tools >
Show Dimensions (1), it is possible to activate multiselection without having to click on "Show
Dimensions". Multiselection is turned off by clicking outside the object. All dimensions can be hidden or
redisplayed in the Surfaces panel (2).
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10 Importing the Scan Appliance

The Blue Sky Plan® Scanning Protocol calls for two CT scans. The first scan should be of the patient
wearing a Scan Appliance, and the second scan should be of just the Scan Appliance. Since the Scan
Appliance is made of mostly radiolucent material, the Scan Appliance does not appear in the patient’s
scan.

It does however appear when scanned alone, since the relevant density of the Scan Appliance is
greater than the density of air, causing it to appear in the scan. The software allows the two scans to
be merged so the Scan Appliance can appear in the patient’s scan.Merging the Scan Appliance is an
aid for proper treatment planning as it shows the position of the future teeth and removes any artifacts
which may have previously appeared in the area of the teeth.

Follow the steps below to import the Scan Appliance:
1) Load the patient’'s DICOM set into the Blue Sky Plan application.

2) In the “Model Master” module, choose “File > Import DICOMS >Scan Appliance”. Follow the
prompts to identify the location of the Scan Appliance DICOMs and select the relevant region of
interest, selecting only the range containing the Scan Appliance.

anels  Model  Virtual aster

Tl e N S TR EER S S+ O -,
Ostart'r-.szald LabPrento u Continue to

D, | Surfaces

>
& sn suraces

-
A Name

Scan Appliance Model

Scan Appliance can also be imported via the "Model Master" module on the main screen. After
choosing "Model Master > Import Patient CT Scan", follow the prompts and select the regions of
interest (as described above). After that, the window with various types of additional surfaces appears.
Choose "Import CT Scan of Denture or Scan Appliance with Markers".

Import Additional Surface?

Import 5TL Model

Import CT Scan of Impression
L] L ] 2
a Import CT Scan of Impression with Markers
M Import CT Scan of Denture or Scan Appliance with Markers

. Import CBCT Model
—

Close
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Scan Appliance Align - O %

Patient Scan Markers

[ Mignpoints only  Update

3) In the process of alignment, you can use the buttons to toggle simultaneous display of the patient
data gutta markers (white) and Scan Appliance (red). You can display or hide the Scan Appliance
model with the button.

The top left-hand box contains the gutta markers from the patient’s scan. The top right-hand box
contains the gutta markers of the Scan Appliance. The bottom left-hand box contains an image of the
Scan Appliance. The bottom right-hand box displays both sets of gutta markers if they coincide.

10.1 Gutta percha markers coincide

If the two sets of markers do coincide, we continue as follows. If they do not coincide, proceed to
section 9.2.
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4) Confirm the data alignment by pressing “OK”.

5) The Scan Appliance will appear in the 3D image of the patient’s jaw. The properties of the Scan
Appliance can be changed in the “Surfaces” panel in the “Imported Surfaces” table.

10.2 Gutta percha markers do not coincide

42057 |5

SEHAW\ nce Model

—_—

[ Aignpaintserly  Update

4) In the top right-hand box use the zoom tool (right mouse button), the 3D density slider, and the
rotation tool (left mouse button) to clearly view at least four gutta markers. ldentify the gutta markers

by clicking the button or pressing the "Shift" key followed by left mouse clicks on the gutta markers.
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An erroneous identification of one marker can be reversed with button. If necessary, all identifications
can be canceled with a button.

5) Repeat the previous step for the top left box to identify the patient’s markers.

6) Perform the alignment on the basis of the gutta markers identified by pressing the "Update" button.
If the result does not roughly correspond to what is desired, identify more points for alignment or, for
data with gutta markers that are hard to discern, check “Align points only”. Under this setting, the
program aligns the points identified without reference to dimensional data. The alignment can also be
corrected manually using the dragger in the lower right-hand window.

7) The Scan Appliance will appear in the 3D image of the patient’s jaw. The properties of the Scan
Appliance can be changed in the “Surfaces” panel in the “Imported Surfaces” table.
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11 STL model import (planning with CT
scan)

Existing STL models are imported into Blue Sky Plan® by selecting “Import STL Model” option from
automatic pop-up menu after Patient CT Scan Importing. Another possibility is selecting “File > Import
STL Model”.

Import Additional Surface?

E Import STL Model

P ) :

E.{] Import CT Scan of Impression

L L

‘ Import CT Scan of Impression with Markers
" & ®

“ Impart CT Scan of Denture or Scan Appliance with Markers

- Import CBCT Model
"

P P
Llose

After the model has loaded, the Blue Sky Plan Automatic Alignment asks for model orientation and
attempts to align the model automatically. The “Model Manipulation” panel can also be used to position
the model to the desired location.

LTefiii ¢S4 O mep,”
Continue to Implant Planning >>

Model Manipulation

N
D

SP_2016_1008_model

S To Model 'i" Points

Center DICOM

v

To Teeth ‘3& Scaled

Stone Model

Model Reversal

[ Show Limiting Curve

Articulation pins

D] paa o
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¥ Alignment

o } Manual .. ToModel Points

Direct DICOM

, Automatic .:.:H To Teeth
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If the model is already aligned with respect to the data, the “Direct” should correspond to the correct
position of the model. For STL models created with different software than Blue Sky Plan®, use the
“DICOM” alignment. “Center” places the model into the middle of the scene without performing any
rotation.

Because automatic alignment is usually not precise enough, Blue Sky Plan® also makes it possible to
perform the alignment by entering a pair of points corresponding to each other. If you select “Points”, a
dialog appears for entering points manually. The surface model displayed in the left-hand window of
the dialogis created on the basis of the settings of the currently selected density surface. It is also
possible to significantly influence the time it takes to create the model and the visibility of the pertinent
reference points by duly setting the thresholds of the density surface.

2) Imported Model Align

Surface model - Imported model Points: 4

[ Refine using ICP [¥] Refine using Best-Fit Matching

Points can be added by clicking on the button with the eyedropper or by pressing the Shift + Left
click. If “Refine using ICP” is activated, the program attempts to perform an additional automatic
alignment after the alignment it made based on the points entered.

A similar point based manner of alignment is “Scaled” (works with extra scale) and “To Teeth” (works
with the panoramic image instead of the surface model).

It is also possible to align the model manually in the 3D window using the dragger that appears when
you press the “Manual” button. Clicking this same button closes the manual alignment mode, and the
dragger disappears.
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When aligning manually, it is possible to define a fixed point (a so-called pivot) around which the
model rotates. In 2D views, the pivot is represented by a cross. By dragging the cross, it is possible to
move the model in the plane of view. The model can be rotated using the blue circle. Hold Shift and
click the left mouse button to position the pivot at a different position in 2D views. In the 3D window,
the pivot can be repositioned using the small dragger arrows.
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12 Planning without CT scan

Blue Sky Plan® software also allows planning for cases without a CT scan — STL models only.

If a user plans a case without a CT scan, the imported models might not be oriented properly (the
orientation does not match the head in the bottom left of the 3D view). This makes planning very
difficult. For these cases, Blue Sky Plan has a model alignment dialog, which opens when selecting
the planning type of the “Import models”.

One or Two Implant
Case

IMPLANT Q
PLANNING AND

SURGICAL GUIDES

e

Import Models

cu

Import CT Scal

e

You can import one or several models. For alignment, it is necessary to select the primary model
(ideally Maxilla) through which the alignment is done. The user also needs to specify if the model is a
Dentated Arch, an Edentulous Arch or a Partial Arch.
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Select a model to align to the occlusal plane

Select The Relevant Jaw

éMa)«Ha |t Mandible

Select Model Type
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BSP_2017_1022_... BSP_2017_1022_...

BSP_2017_1022 ... BSP_2017_1022_...

Skip Alignment Continue to Alignment

In the next step, the user marks three points on the model (by holding Shift + Left clicking the
mouse) to help the software align the models properly (to match the orientation of the BSP coordinate
system). The rest of the models will be aligned relative to the alignment of the primary model.

Click 3 points to Align to Occlusal Plane

Hold down the Shift key, and left dick with your mouse button.

¢ "5
e @
' N

Mark three points an the occlusal plane as shown. Preferable to mark an incisal edge

as dose to the midiine s possible and mesial buccal cusps on each side of the arch
that will create a straight horizontal piane.

Faints: 2 / 3
£ Show Grid

-
el

In the last step, the user can manually fine-tune the primary model using the grid. If several models
were imported, they will move together as a group.
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Model Alignment

Manually Refine Alignment

Blue Sky Plan® software also allows the user to align models automatically. This option can be can be
modified in Preferences.
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The primary model can be manually adjusted using the grid. If several models were imported, they will
move together as a group. li is possible to reset the position of the fine-tuned model to it's
automatically aligned position. STL model alignment will be completed by clicking the “Finish” button.
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13 STL model adjustment

Blue Sky Plan software allows the user to select and remove part of the surface (model) and close any
holes which have been created during the process.

e S e AT T All the necessary tools are available in the Model
Edit panel. Using the “Selection Brush” the user
can select a part of the surface and remove it by
Selection Brush pressing the “Cut Selected Area” button. This way
the user can clean the surface from scuttered
parts or “extract” a tooth, for example. The

Cut Selected Arca selected area can be cleared by pressing the
“Clear Selection” button.

Diameter |
Clear Selection

Clean and smooth boundary

Hales Closing Tool Removing parts of the model, however, will create
a hole (or several). The “Holes Closing Tool” can
be used to close them. The user can select and
close one specific hole using, or select and close
Select All Holes all of them at once. All selected holes can also be
deselected.

Select Holes Manually

Deselect All Holes

Close Selected Holes Note: This tool is made for closing smaller and
simpler holes. More complicated cases may take a
long time. The model can be completely closed
and repaired using the “Close Model” tool, which
also creates a stone model with a base.

Close All Holes

Brush Tools

Smoothing Brush Surface irregularities can be fixed using “Move
Outlines”, which can only be used in the
orthogonal view (it doesn’t work in the 3D view).
Local Deform Brush “Add/Remove Material Brush” is used for the
addition/removal of surface material. “Local
Deform Brush” deforms the surface at a local
Diameter point. For final modifications and polishing the
Strength | % surface of the closed hole, “Smoothing Brush” can
be used.

Add/Remove Material Brush

Move Outlines

Plane Cut

“Plane Cut” is used to cut a model by a cutting

SHOWFians plane. The plane can be moved and rotated and
[] Keep both parts — E— the cutting direction can be inverted. The plane
can be reset to the default horizontal position. Both
Cut by Plane parts of the cut model can be retained (a new
Plane Cut remainder model will be created).
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14 Scan Body Registration

Blue Sky Plan® has a useful functionality that allows the user to register the STL files of the scan
bodies present in the BSP parts catalog into the scan bodies visible in a scanned model.

Blue Sky Plan® can convert the scan body (type of abutment that serves as a "post" at the time of the
scan) into an actual abutment with an implant attached.

Once the STL model with visible scan bodies is imported, clicking on the i icon in the toolbar (while
"Normal" or "Advanced" mode is active) opens a dialog for fitting the catalog scan body to the scanned
model.
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&4 Advanced
,l\ Model Master
Surgical Guide

2 Viewing

w# Normal

H Crown and Bridge

B® Denture

Scanbody Preview
Blue Sky Bio
Use Abutment as Scanbody...

Type: Scanbody

Label Diameter Length
Blue Sky Bio BlueSkyBio Scanbody 4.50 mm  15.00 mm
Dess MIJH 408 mm 1443 mm
BIO | Max NP CMUxx 571mm 480 mm
BIO | Conus 12 MMUT 5.69 mm
MMUTC A77 mm
Multi Unit OPTIMULTI 599mm  16.00 mm

Quattro

BIO | Max RP

Description

Cancel

After choosing a scan body from the catalog, it can be placed by clicking on the head of the scanned
abutment in the model — for the best fit position, it is good to click on the place illustrated by the red
marker as shown in the catalog scan body preview.

Once the scan body position is precisely defined, the window with implants pops up. After choosing
the desired implant, the scan body and implant are automatically aligned together. Tooth can be added
by clicking "Add Tooth" from the toolbar or by right clicking the scan body > Add Tooth. Another option
for aligning a tooth is by right clicking the implant > Align > Align New Tooth.

It is also possible to align either an existing or a new implant with the scan body by right clicking on the
scan body and choose the desired option from drop-down menu.
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a Lock Scanbody

, Align new implant
Align existing implant
Add Tooth

## Replace

Deselect

Later on, the scan body position can also be refined manually using the common manipulation widget
in the 3D view.

Anonymous patient
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15 Virtual teeth

Blue Sky Plan® makes it possible to insert "virtual" teeth into the project. Using automatically
generated crowns or pre-prepared crowns from catalogs, we can show the patient the possible result
after all the planned procedures have been performed. Virtual teeth also make it possible to align
either a new or an existing implant and thus easily visually inspect the respective position of the
resulting crown with respect to the position of the implant and to plan any abutment.

15.1 Inserting crowns

It is highly recommended to specify dental curve, since the inserted crown will be rotated automatically

with respect to it. The individual crowns are inserted either by clicking on the nicon in the main
toolbar or by using the button in the "Tooth List" side panel (indicated below), or, if necessary, by
choosing the “Virtual Teeth > Add Tooth” menu item.

A dialog for selecting crown will open. Firstly, the user can choose between two types of crowns:
automatically generated crowns and predefined crowns from catalogs. Note that automatically
generated crowns are available only in the Surgical Guide module.

For the automatic creation of a crown, select the "Automatically create Al tooth" tab (1). Then choose
the associated tooth from the preview (3) - the text description of the crown appears in (4). Implants
can also be placed together with the new teeth (5). For more information about placing implants, see
chapter 8. Confirm the selection by clicking the "OK" button (6) (the "Cancel" button closes the dialog
without making a selection (7)). Then user can place the crown on the associated spot and the crown
is automatically generated. The dimensions and location of the tooth can be subsequently modified
directly in the sequence.

For a predefined crown from the catalog, select the "Select tooth from catalog" tab (2). Compared to
automatic creation of the crown, there are a few differences in the dialog. From the dropdown menu, it
is possible to select the teeth from a specific teeth geometry set (8). In the preview, it's possible to
select additional teeth by pressing and holding the Shift or Ctrl key (9). The size of the teeth can be
adjusted as well (10). A tooth can be aligned to an already existing implant (11), or the teeth’s position
can be adjusted on the basis of the panoramic curve height (12).
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15.2 Positioning the crown and manipulating it

The mouse cursor changes to a cross when the dialog closes. The crown can then be positioned by
clicking on the slice, and, if necessary, on the 3D visualization in any window.

The crown is positioned in a vertical position according to the type of the simulated tooth and rotates
with respect to the dental curve. It is up to the user to fine-tune its position.

The tooth can be moved in all the windows. This is achieved by positioning the mouse on the tooth
geometry, clicking the left mouse button, and dragging. The tooth always moves in the plane of the
view. The tooth can also be rotated using the so-called draggers. These appear again when the mouse
cursor is positioned on the tooth. The dragger can then be grabbed by clicking the left mouse button;
the dragger changes color, and the tooth’s rotation is modified by dragging.

bashe 4| A

The rotation point (the so-called Pivot) can either be in the center of the tooth geometry or at the
beginning of the local coordinate system. This is located in the same place as the head of the aligned
implant.

In the 3D view, the tooth can be dragged not only in the plane of the view but also along the axis of the
tooth. As in the other views, it is necessary to move the cursor onto the tooth and display the draggers.
The blue arrows above and below the tooth serve to shift it along the axis. We change the position of
the tooth by moving the cursor to the arrow, clicking the left mouse button, and dragging. As for
implants, three differently colored circles appear in the 3D view for rotating the tooth around the
corresponding axes of the local coordinate system.

In addition to the position and rotation, the size of the crown can also be modified in the 3D view.
Spheres displayed along the axis of the tooth serve to change the size. The size of the tooth can be
changed by moving the cursor to it, clicking the left mouse button, and dragging.
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15.3 Adding the Al crown

To generate an Al tooth for a case where both jaw models are imported, first select a tooth from a
Tooth list, then pick an antagonist. This antagonist model must be aligned in occlusion with the model
with the missing tooth.

Antagonist selection can be done through a dropdown menu which will appear right after selecting an
Al tooth in the Tooth List and pressing the "OK" button. Clicking the "Cancel" button cancels jaw
selection, not tooth generation. It is necessary to click on the Cancel button again.

Regardless of whether the opposite jaw is available, it is possible to regenerate an Al tooth. Right-click on
the Al tooth and select "Regenerate Al Tooth" from the context menu. The mouse cursor changes to a
tooth. Left-click on the model in the desired tooth position.

™ Align b

Align with dental curve rt"

]
J. Regenerate Al Tooth
/  Show properties
_I_. Show dimensions

¥ m Replace
H Remove

/ Pivot 4
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15.4 Aligning an implant and further operations

The side panel, which can be opened with the “Panels > Tooth List” menu option, provides further
operations on the tooth. A list containing a description of the tooth (1), a check box (2) for turning the
visibility of the individual tooth on and off, and a button to remove the given tooth (3) appear in this
panel. The selected tooth is displayed in red in the sequence, and the associated row is highlighted in
the list.

As for implants, it is also possible to set the transparency (4) or outline the display (5) for teeth.

There is also an "Add Tooth" button here for adding a tooth (6), which functions the same way as the
toolbar button described above, optionally via a menu item.

Tooth List

Tooth

Teeth

Tooth label

Left Maxillary Central Incisor o

Left Maxillary Lateral Incisor

The result of clicking the “Remove Tooth” button
(7) depends on whether a tooth has been
selected. If so (if one of the teeth is selected), the
action is performed directly on the chosen tooth. If
not, the selected tooth is removed from the
sequence by clicking the mouse. The button for
changing the geometry of the tooth is “Replace
Tooth” (8). The dialog for selecting the new
geometry works analogously: if one of the teeth is
selected, the new geometry is set to it; if none is
selected, the mouse cursor changes to a selection
cross, and the geometry changes to that of the
MEihility Sethings o tooth selected by clicking on it.

Transparency

Tooth Qutline [] e

e Add Tooth o Remove Tooth
e Replace Tooth o Align New Implant
@ Align Existing Implant

Tooth Extraction

B BSP 2017 1030 m odel_upper

When active, you can use CTRL + left click on the jaw's tooth to
extract it.

@ Extract Tooth @ Clear Segmentation

Pontic ovation | 00mm

[] Radial deformation @ @
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The "Align New Implant” button (9) first opens a dialog for selecting the implant (see chapter 7), and
after the selection is confirmed with the “OK” button, the new implant is added to the project with a
position setting corresponding to that of the selected tooth.

The button for aligning an existing implant (10) works analogously. When it is pressed, the mouse
cursor changes to a selection cross, and when one of the existing implants is clicked on, its position
with respect to the tooth is modified.

The tooth can be extracted in the "Tooth Extraction" section. By clicking the "Extract Tooth" button (11),
segmentation starts on the selected scan and a segmented model is created. When segmentation is
active, it is possible to use CTRL + left click on the jaw’s tooth to extract it. Segmentation is deleted by
clicking the "Clear Segmentation" button (12).

Radial deformation (14) affects the shape of the resulting ovate pontic. When turned on, the amount of
surface deformation depends solely on the distance of the surface point from the theoretical center of
the tooth, resulting in a symmetric, radius-dependent shape.

The slider (13) then affects the resulting depth of pontic ovation upon the extraction of the tooth.

Model prepared for tooth extraction

15.5 Context menu

Some operations can also be performed via the context menu. We invoke this by clicking the right
mouse button on the tooth geometry. Besides the operations described above, such as aligning the
implant, removing the tooth, or replacing it with another type, it is also possible to group a tooth with an
implant and move them together across the scene, and also to choose the point of rotation of the
draggers (the Pivot) as described in chapter 14.2.
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Lock Tooth
Align
Move with...

Align with dental curve

Show properties

Show dimensions
Replace
Remove

Pivot
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16 Tooth and jaw segmentation

Blue Sky Plan® makes it possible to segment and remove individual teeth and jaws from the data. The
following segmentation methods are supported. Segmentation is available in the Model Master module
> Panels > Segmentation. Automatic segmentation for both tooth and jaw is accessible via Model
Master > Tools > Automatic Teeth Segmentation or Automatic Jaw Segmentation.

Surgical Guide

General R
Default Height 10,00 mm

—~ . . efault Dept 500 m
Customization SHEER B

. Guide Curve Suggestion
Project

1,00 mm

Shortcuts

2,00 mm

2

Advanced

BlueSkyBio Account Default Articulation Pin Arm Width

Default Articulation Pin Arm Height

Surgical Guide

Implant to Tooth (occlusal side) Distance
Default Insertion Path Direction

Default Maximum Allowed Undercut 0,170 mm

Endo Mode

cted implant's position

Automatic functionality

o & Run bor

e Defaults

Segmentation settings can be adjusted in Preferences > Surgical Guide > Automatic Functionality.
"Run Bone Segmentation without manual adjustments" (1) won't show the user manual editing tools
during the jaw segmentation process. The other three checkboxes will start specific segmentation
process after the CT data are imported. "Run CT Teeth Segmentation automatically when importing
CT scan" (2) will only start teeth segmentation. "Run Bone Segmentation automatically when importing
CT scan" (3) will start teeth and jaw segmentation (note: this will overwrite the "Run CT Teeth
Segmentation automatically when importing CT scan" checkbox). "Run Airways Segmentation
automatically when importing CT scan" (4) will start Airways segmentation.

16.1 Automatic Tooth Segmentation

Using the Segmentation functionality, you can also use ,,Automatic Tooth Segmentation®. Two options
are available — Select Tooth and Create STL Surfaces for All Teeth.
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Segmentation

Segmentation Method

® " Automatic Tooth Segmentation

(®] ' Virtual Tooth Segmentation

O " Manual Tooth Segmentation

(8] &2 Manual Jaw Segmentation
¥ Automatic Tooth Segmentation

Select Tooth
Create STL Surfaces for all Teeth
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data
¥ Refinement Tools

4} Lasso o Int. Lasso
o Brush * Int. Brush
Smaoth
Inflate
Deflate

¥ Model Creation

Create Surface

Cut from CT Surface

To work with one tooth segmentation at a time, click on Select Tooth button (1) and choose a tooth
from one of the orthogonal slices (2) you need to select. The result of the selection will be colored in all
the slices. A preview of the selected tooth can be shown in 3D by clicking on Show Segmentation 3D
Preview (3). Tooth selection can be removed from the orthogonal slices by clicking on Clear
Segmentation Data.
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Segmentation

Segmentation Method

® ” Automatic T+ mentation

(3] ” Virtual Tooth Segmentation

" Manual Tooth Segmentation

Manua ¢ Segmentation
Automatic Tooth Segmentation

Select Tooth

Create STL Surfaces for all Teeth
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data

Refinement Tools

4 Lasso "' Int. Lasso
IE!(ush *I Int. Brush
Smooth
Inflate

Deflate
Model Creation

Create Surface

Cut from CT Surface

Tooth selection can be corrected with the "Refinement Tools" (4). It is also possible to apply a
“Smooth” filter on the segmentation data. “Inflate” inflates data by one voxel while “Deflate” shrinks
data by one voxel.

Refinement Tools o

4 Lasso & Int. Lasso
f Brush " 1nt. Brush
Smooth

Inflate

Deflate

To create a 3D model from the segmentation data, click on “Create Surface” (5). To create a new CT
surface with the current segment cut out, click on “Cut from CT Surface”.
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Segmentation

Segmentation Method

@ " Automatic Tooth Segmentation
O ' Virtual Tooth Segmentation
) " Manual Tooth Segmentation

O g Manual Jaw Segmentation

¥ Automatic Tooth Segmentation

Select Tooth
Create STL Surfaces for all Teeth

Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data

Refinement Tools

¥ Lasso a Int. Lasso

d' Brush ',Int. Brush

¥ Model Creation 9

Create Surface

Cut from CT Surface

If you want to run fully automated segmentation, click on “Create STL Surfaces for All Teeth” (

Segmentation
Segmentation Method
@ ” Automatic Tooth Segmentation
(8] ” Virtual Tooth Segmentation

O " Manual Tooth Segmentation

O u Manual Jaw Segmentation
¥ Automatic Tooth Segmentation

Select Tooth

Create STL Surfaces for all Teeth
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data

¥ Refinement Tools

4 Lasso & Int. Lassa
( Brush *d Tt. Brush
Smaooth
Inflate

Deflate

Model Creation

Create Surface

Cut from CT Surface
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You can check fully segmented teeth in the Surfaces panel.

STL Surfaces

Name Visible Hint Color
Tooth UR1 o
Tooth UR2 v

Tooth UR3 v

16.1.1 Implant Segmentation

To perform implant segmentation, select "Segment CT implants when automatically segmenting CT
teeth" in Preferences > General > Automatic Functionality. Segmentation will occur when segmenting
the jaw or a tooth. It is necessary to have CT data with implants already added in the laboratory, it is
not possible to do segmentation on data where only a virtual implant has been added.

Merged teeth and implants (left) and segmented implants and teeth (right)

16.2 Virtual Tooth Segmentation

If automatic delimitation of the tooth fails, it can be selected in the data using the virtual tooth manually
positioned in the data via the “Virtual Teeth > Add Tooth® option from the main menu. After positioning
the model, perform the “Use Active Tooth Model” action for the designated data on the basis of the
tooth model entered. Using the "Model Neighborhood Parameter" it is possible to slightly correct the
area around the positioned model that has been selected.
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Segmentation

Segmentation Method

O ” Automatic Tooth Segmentation

¥ Model Based Tooth Segmentation

Use Active Tooth Model

Model Neighbourhood
|

Manual Segmentation
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data
Model Creation

Create Surface

Cut from CT Surface

It is possible to transfer the area of the tooth marked in the data into the model by clicking “Create
Surface”. A model created in this way appears in the “Surfaces” panel in the “Imported Surfaces” table.

The tooth can be removed from the data by clicking “Remove Tooth”. If you are not satisfied with the
result, the action you carried out can be reversed with the "Undo" button, and the tooth selection
parameters can be modified.

16.3 Automatic Jaw Segmentation

Automatic Jaw Segmentation is available for the user in the Segmentation method section. Simply
click on the option (1) and choose between the mandible or maxilla or both jaws (2). Teeth and jaw will
be separated into individual models if selected (3). Start the segmentation by clicking the "Start
Automatic Segmentation". It might take a few minutes. If "Airways" is selected, Airways segmentation
will also occur (see chapter 16.4).

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 106

BlueSkyBio



Segmentation
Segmentation Method
O E Automatic Tooth Segmentation
O] k&{ Automatic Jaw Segmentation
(@) $~; Virtual Tooth Segmentation
=) " Manual Tooth Segmentation

&) % Manual Jaw Segmentation

l.;| Automatic Jaw Segmentation

o]
9 v #Maxil\a ¥\ Mandible | ﬁ Airways

e Start Automatic Segmentation

e L4 HP Don't merge teeth and jaw models

¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data
¥ Model Creation

Create Surface

Cut from CT Surface

The results of the jaw segmentation can be corrected with the segmentation tools (5). The tools can
only be used on a jaw preview. Segmentation will be completed by clicking the "Next" button (6).

ARl Segmentation
@ \ed Automatic Jaw Segmentation
O  virtual Tooth Segmentation
O P, Manual Tooth Segmentation

O \ug Manual Jaw Segmentation

* Manual correction of segmentation output

Use manual segmentation tools to change results of automatic
segmentation if needed. You can use tools only on jaw preview. The teeth
are shown just for reference,

o Lasso & It Lasso
A Brush %4 e Brush

o Eraser €} Fill Holes

Previous Cancel
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data
T Model Creation

5 8 7 6 5 4 3 2 1 1 2 it 5 6 7 8 9 10 1 12
ulanelunsbsssalanssleoselsasalssealssahsmalsasalianalasaivudiasalmnaglaeslaneiaaalinglaasl gl Create Surface

Podial / XY . Coronal / X2 ' sogitel / vz ] Crosssections W panoramic | #¥ implant/Tangential cut from CT Surface

Click on the "Create surface and continue" button (7) for surface creation. It is possible to go back and
use the segmentation tools again. In this case, click on the "Previous" button (8). "Start New
Segmentation" (9) starts new segmentation for the jaw.
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Segmentation
@ ‘hé\ Automatic Jaw Segmentation
) ?‘;" Virtual Tooth Segmentation
O '“ Manual Tooth Segmentation

&) u Manual Jaw Segmentation
¥ Manual correction of segmentation output
Segmentation completed

Please see options below to perform segmentation data
postprocessing and create a surface.

Smooth

uoe[ndiLels [Bpojy n s808LNS 0 Lopejuswbas

Inflate

Deflate

e Start New Segmentation
Previous Create surface and continue
¥ Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data
¥ Model Creation

Create Surface

cut from CT Surface

Teeth and jaw models are not merged Merged teeth and jaw models
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The user is able to show or hide CT teeth from the 3D scene in the STL Surfaces table (10). The same
option applies to segmented implants (11). If a new jaw bone segmentation starts, previous models
from STL Surfaces will be hidden. Models have to be removed manually from the STL table.

Surfaces

STL Surfaces

Tooth UR1
Tooth UR2

Tooth UR3
Duplicate

@ Hide Maxilla CT Teeth Hide Mandible CT Teeth

Show All Dimensions Hide All Dimensions

@ Hide CT Implants

16.4 Airways

Airways segmentation is available in the "Jaw Bone Segmentation" method (1). To run this
functionality, select "Airways" (2) and click on "Start Automatic Segmentation" (3).

Segmentation
Segmentation Method
oth Segmentation
gmentation
mentation

mentation

Automatic Jaw Segmentation
O & Mavilla [ \o/ Mandible e v g Airways
19 Start Automatic Segmentation

v -"P Don't merge teeth and jaw models

" Segmentation View

Show Segmentation 3D Preview

Clear Segmentation Data

" Model Creation

Create Surface

Cut from CT Surface
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The Airways model is visible in the "Surfaces" panel and can be exported via the Export panel for a
fee.
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17 Surgical guides

It is possible to fabricate surgical guides in the program on the basis of imported STL models or a so-
called scan appliance. It is also possible to edit the surgical guide fabricated. Surgical guides are
fabricated using the functions located on the “Guide” panel (1), which can be opened by clicking on the
" File (or Panels) > Guide Fabrication" (2) menu item (while "Normal" or "Advanced" mode is active

(3)). The tools are divided into groups according to their purpose.

The first group (4) combines elements used jointly for both model types. The second (5) contains a
button for fabricating surgical guides on the basis of a scan appliance model. The third (6) contains a
function that creates the undercut model. The fourth (7) contains all elements for fabricating an offset
surgical guide from a surface model. The fifth (8) contains tools for creating label text. These are
followed by panels for creating labels.

The method of fabrication differs according to the type of model being processed.

17.1 Guide fabrication based on scan appliance

Open the “Guide Fabrication” panel. The first section (“Fabrication”) contains all common settings for
fabricating a surgical guide. The combo box (1) is used to select the input model.
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Some input models may be damaged —
they are composed of several parts, and
their internal structure may not be correct.
Fabrication of the surgical guide may fail

s 4

Fabrication

[ Scan Appliance Guide

X Lock implants and virtual teeth 9 in these cases. If the input model is
damaged, it is possible to try to correct

® Use automatic brush 9 the input geometry using the correction

B Built-in Drill Stops @ tool (2) and_ run model fabricatic_)n_ again.
When manipulating the model, it is a good

Brush diameter ™l idea for the option of working with

implants to be turned off so that they are

_ _ not moved unintentionally, for example.
Normal g Very high a The "Lock Implants" checkbox (3) locks
them. Implants are also locked
automatically when using certain tools for fabricating surgical guides.

Guide quality

In order to be able to work conveniently with the resulting surgical guide and so that protruding parts
do not prevent you from working with the tools, it is possible to select automatic alignment of the areas
above and around the guide tubes. Select "Use automatic brush" (4) for this purpose and then use
setting (5) to set the diameter of the free area. If these selections are not checked, only an area of the
same diameter as the given guide tube is enabled above the guide tubes.

Automatic brush settings for modifying the software guide tubes can be set in the Guide settings by
clicking the E=1 putton in the Fabrication section.

Metal Cylinder Lip Height
Guide Thickness 3,00 mm
Endo Guide Thickness

« Remove Undercuts
» Brush Tool Should Mot Maodify Software Guide Tubes

Software Guide Tubes are not modified
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Software Guide Tubes are modified

By using "Built-in Drill Stops" checkbox, it is possible to generate in-built drill stop, which enables the
handpiece head to bottom out to create the proper depth into the jaw (6).

The detail of the resulting model is adjustable (7). The general rule is that the more detailed the model
is, the longer it will take to generate it, and the slower manual edits with tools such as the Brush Tool
will take. A model with the “Normal” setting should be sufficiently detailed for most input data.

Finally, the additional properties of the surgical guide can always be adjusted (8).

¥ Scan appliance

Create Scan Appliance Guide

After entering and checking all settings in the “Fabrication” panel, it is possible to proceed to automatic
fabrication of the surgical guide. Clicking the "Create Scan Appliance Guide" button in the “Scan
Appliance” section runs this. A progress bar is then displayed, and once this runs out, the resulting
surgical guide is displayed automatically.

17.2 Guide fabrication based on scanned surface models

It is also necessary to have an input STL model open in this case.

First check whether all the settings in the “Fabrication” panel are correct, i.e. whether the correct input
model is selected, whether or not automatic model alignment is used above the guide tubes, and what
level of detail is selected for the resulting surgical guide. Further settings specific to fabricating a
surgical guide from a surface model are found in the “Guide settings” section (8).

When opening a project, the program tries to guess whether it contains maxillary or mandibular data
and automatically makes the selection. The same test is then also conducted when initiating the
generation of a surgical guide.
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= Mandible Maxilla

If the program’s estimate does not agree with the actual situation, it is possible to change
selection manually.

Guide panel

¥ Guide Orientation

(O Mandible @ Maxilla

SR Cde Before actually fabricating the surgical guide, it is

Automatic Curve necessary to specify the area that should be
Draw curve covered. This is done automatically by clicking the
Clear curve "Automatic Curve" button. If the automatic curve
drawing fails, it is possible to draw the curve
Crasts: Sorgicnl Guide manually by clicking "Draw Curve". This activates
Save Surgical Guide the drawing mode. The state of the button is
# Create undercut model as byproduct indicated by a Change in color.

If we are in curve drawing mode, it is possible to manipulate the model without pressing any keys.
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The shape of the curve can be edited using individual control points on it. Before actually generating a
surgical guide, it is a good idea to check its shape in this mode. If needed, the curve can be deleted by
clicking the "Clear curve" button and the curve can be automatically drawn again.

As a consequence of fragmentation, errors in some input models, and, in some cases, local
unevenness in the surface, it may happen that the curve does not correspond exactly to the intended
shape. In this case, it is necessary to move the nearest points of the erroneous section so that the
resulting outline aligns; see the following images.

Parameters for the automatic curve can be set in Preferences > Surgical Guide > Guide Curve
Suggestion. The suggested curve will be shown based on the settings.

Selecting "External Surgical Guide to contralateral canine and exceed to the most distal tooth" will
extend the surgical guide curve from the most distal tooth on the side of the arch, where an implant is
located, to the contralateral canine.
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General

Surgical Guide

Custom Metal Cylinder Lip Height 1,00 mm
m Metal Cylinder Lip Width
Software Guide Tube Distance
BSB Direct Cut Drills Surgical Guide Offset
GRS Guide Holes Diameter
Software Guide Tube Wall Thickness 2,70 mm
Generated Models Base Height 3,00 mm

Guide Windows

Default Width 10,00 mm)|

Default Height 10,00 mm

1,00 mm

Number of Teet
[] Bxtend surgical guide to contralateral canine and extend to the most distal tooth
Default Articulation Pin Arm Width 5,00
Default Articulation Pin Arm Height 2,50
Implant to Tooth (occlusal side) Distance 12,00 mm
Default Insertion Path Direction 0,000

Default Maximum Allowed Undercut 0,10 mm

After you finish editing, you can run generation of the surgical guide by clicking the button "Create
Surgical Guide". The now unnecessary cropped curve is hidden automatically at this point. This is
indicated by the "Show curve" checkbox, which can be used to redisplay the curve. If the curve
entered and thus the resulting surgical guide do not contain all the planned implants, the user is
notified and has the option of halting generation.

Once it is completed, the fabricated surgical guide model is displayed in the "Surfaces" panel, where
its parameters can be changed as standard.

The surgical guide can be regenerated with edited parameters and the same curve; the curve is
merely hidden and can be displayed with selection, edited again, and used to create a modified model.

17.3 Removing undercuts

The “Surgical Guide Insertion Path” function is used to define the direction from which the surgical
guide will be inserted. Using this function, you can visualise the areas that run “under” the surgical
guide (undercuts) and may cause problems when inserting the surgical guide on teeth, especially in
the case of using stiff materials for fabrication. These areas can be removed by clicking on the “Create
undercut model as byproduct” (generates model with undercuts removed) checkbox. The surgical
guide created on this model will be easy to mount.
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The differences between individual outputs can be compared in the following pair of images. On the
left is a guide on the model with undercuts removed; on the right, all details are preserved.

The default Insertion Path Direction angle and default Maximum Allowed Undercut are defined in
Preferences, Surgical Guide tab. In addition, the Define Insertion Direction From View functionality is
available from the Guide Panel. Creating an Undercut Model generates a new model that can be
worked with independently.

-

Surgical Guide Insertion Path
Define Insertion Direction
Define Insertion Direction From View

Reset Insertion Direction

Maximum Allowed Undercut 1l

17.4 Brush tools

Except for the automatic brush tool, the application provides basic tools for manually adjusting the
resulting surgical guide: “Brush Tools”. These tools can smooth the surface (i.e. they lower bulging
parts and even out depressions), add or remove surface material, locally deform the surface material
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and edit outlines in the model (only works in 2D). The tool is found under "Model master" module, in
the "Model Edit" panel. For more information about model adjustments see section 12.

2% Model Master

Continue to Implant Planning })

Model Edit

«  Model

W STiModellower

tion Brush Tool

17.5 Text tool

The surgical guides fabricated can be supplemented with one or more labels with a 3D profile. This is
done with the “Text tool”.

¥ TextTool It is first necessary to check whether the correct
model is selected. If the model is set as invisible at
this point in time, the user is notified of this when
he or she tries to insert a label on it. The text is
inserted into the editing field. At this point, an

(1 Show label auxiliary display of the text entered is also shown in
the 3D display window. The text will be located on
the model at the location at which it is displayed in
Apply Text this window. Therefore, it is necessary to position
the model in the 3D window in such a way that the
text will be at the right position on its surface. It is also necessary to choose one of two methods for
creating text-depth: emboss or engrave.

Engrave

Then press the “Apply Text” button. The auxiliary display of the text in the 3D window is hidden, and
the text is pressed into the surface of the surgical guide. The auxiliary display in the 3D window can be
reactivated with the “Show label” checkbox.
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18 Endodontic Mode

Endodontic treatment (also known as root canal treatment) is a treatment sequence for the infected
pulp of a tooth which is intended to result in the elimination of infection and the protection of the
decontaminated tooth from future microbial invasion. It is usually done on one tooth and may include
all 4 roots.

The planning begins with an intro screen titled “Endodontics”, where the user selects the type of
planning. For more information, see chapter 3 "Blue Sky Launcher".

EASY CT DICOM
VIEWER

ORTHODONTICS - SPLINT

IMPLANT ™
PLANNING AND DENTURE AT CEPHALOMETRIC

SURGICAL GUIDES ANALYSIS

i CROWN AND ENDODONTICS

BRIDGE

)

MODEL MASTEF

To continue to Endo Mode, click on the "Continue to Endodontic Planning" button in the upper right
screen.

Before actually creating the endodontic guide, it is necessary to specify the area that should be
covered. This is done automatically by clicking the "Automatic Curve" button (1). Clicking the "Draw
curve" (2) button activates the drawing mode. The state of the button is indicated by a change in color.
The curve border can be edited by using the individual control points. Before actually generating the
endodontic guide, it is a good idea to check its shape in this mode. If needed, the curve can be deleted
by clicking the "Clear curve" (3) button and the curve can be drawn again.

Once editing is over, the endodontic guide can be generated by clicking the "Create Endo Guide"
button (4). If the curve entered, and thus the resulting endodontic guide, do not contain all the planned
implants, the user is notified and has the option of halting generation.
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Once it is completed, the Endodontic guide model that has been created is displayed in the "Surfaces"
panel and can be exported and saved by clicking the "Save Endo Guide" button (5).

Endo Guide Thickness can be set in the Advanced Module in the Guide panel. Open the Guide
settings by clicking on the icon E(6).

File Edit Tools View Panels Implants | Teeth Module Help ?‘jAdvan[ed

WEEE -~ ERBEQA WS N 35

- Guide panel
Surgical Guide: Anonymous patient

Fabrication

B sTLModelLower

15,00mm =
O Very high
Scan appliance
Create Scan Appliance Guide
Surgical Guide Insertion Path

Define Insertion Direction

* Endo Guide

Automatic Curve:
Draw Curve

Clear Curve

Create Endo Guide

[ Create undercut model as byproduct
Valume Rendering

Metal Cylinder Lip Height

Guide Thickness
Endo Guide Thickness 0,50 mm

¥ Remove Undercuts
+ Brush Tool Should Not Modify Software Guide Tubes

The user is able to place an implant tip exactly where clicked. The implant pivot is “Tip” by default
(“Head” with Endo mode turned off).

The user can turn on “Always show selected implant/tooth” for 2D visibility (even when the
transparency is set to 1.00) and “Move slices to selected implant’s position” to move slices to the
added implant. Those options are available in Preferences -> Surgical Guide and Endo mode has to
be active in order to work with it.
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Surgical Guide

0,00 mm
Advanced 10,00 mm

BBB/LP Login Default Height 10,00 mm
Li

Surgical Guide

3SB Direct Cut Drills

Default Depth 5,00 mm

Guide Curve Suggestion

Gingival Margin on the Buccal Side 1,00 mm
Gingival Margin on the Lingual Side
Number of Teeth Extention on tl | Side 2
Number of Teeth Extention on the Distal Side 2
[] Extend surgical guide to con ral canine anc to the t distal tooth
Default Articulation Pin Arm Width
Default Articulation Pin Arm Height
Implant to Tooth (occlus:
Default Insertion Path Direction
Defaul mum Allowed Undercut
Endo Mode

cted implal
cted implan

Automatic functionality

Restore Defaults

Note: Once the user is in the endodontic module, it is not possible to switch to the surgical guide
module. It is necessary to start a new project in the Surgical Guide module!
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19 Data export

Most of the project data can be exported from the application in the form of an STL model. The menu
selection “File > Export Data” is used to export data.

The quality of the export can be set in the dialog, which influences the quality of the resulting model
but also the time necessary to generate the export. The check boxes can be used to select what
should be exported from the project. Selection is limited to data that are currently visible in the 3D view
of the application. Nerves, imported models, implants, density surfaces, virtual teeth and scanbodies
can be selected. It is possible to export either to a file or directly to the installed VRMesh application
for a license with a limited number of exports. The number of remaining exports is indicated on the
“Export” button and in the window’s title. The number of exports is only reduced once in a project that
is currently open. By selecting the "Open in Alpha Al" or "Open in RayWare" or "Open in Uniz Dental",
models can be exported to the respective external 3D printing software.

Export Quality

(@ standard O very High

Export File Format

STL Surfaces CT Surfaces

Selected Name Color  Selected Name Selected

- BSP_2021_1164_Lower_Model

- BSP_2021 1164 Upper_Model - v

v Original v

Implants Virtual Teeth Scanbodies

o Selected L Selected A. Selected G. T. Tooth Name Selected Selected S.
v 1
v O

[] Show only teeth with CAM file support [_| Swap face orientation '« Export separated files to a folder [] Open in Rayware [_| Open in Alpha Al [_] Open in Uniz Dental Cost: 0

Create Surface Export (43 remaining) Cancel
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20 External Softwares

20.1 Medit import

The goal of the connection between Blue Sky Bio and Medit is to enable scans from the clinician’s
intraoral scanner to be used directly in Blue Sky Plan.

To import intraoral scans into Blue Sky Plan, choose the case from your scan box that has the status
“Scan Completed”. Then click on the Export Blue Sky Plan button to export the scan data to the Blue
Sky Plan application.

AL
alnd Case Box

Scan Completed

Patient Name

Medit

Medit

Medit

Sample

Sample

Medit

Sample

Dashboard
- 2 (v al) ( Formony Need Processing
Case Box
Total Count: 15
PES
Order Box Status Case Name
-‘g Ordered Samplecase - Veneer - Clone
Case Talk
Ordered Samplecase - Crown - Clone
>
CAD ) Samplecase - Crown
App Box
r-i | Scan Completed ) Implant Scanbody Complex
Trash B
( Formonly ) Sample's Case
Scan Completed | Samplecase - Fullarch - Clone - Clone
Scan Completed ) Model Builder
>
i < Implant Scanbody Complex (Sample) ~
Dashboard
. Scan File Viewer
Case Box
v Maxilla @
= Pre-Op @
Ordier Box
Base @
p->
% >  Abutment ®
Case Talk
= > Margin Line ®
> > Scan Body Base @
Appisr > scan Body Library @
o
~ f v Attachment i
Trash B > 3DData ¢ ® =
> Images °
> Video
X
=
[~
i

CAD Ordered Case Completed

Birth Date Form Information

B

- o

@ None v = Last Modified Date v
2018-01-01 ~ 2022-06-08 All v Search/Contains Q
Last Modified Date \ Scanning Date Order Date Lab Name
17.02.2022 9:56 05.06.2021 1026 12072021 7:33
17.02.2022 931 12.07.2021 7:34

12.01.2022 820
15.12.2021 8:51 27.10.2020 425
30.11.2021 1.05
0211.2021 243 29.04.202110:12

0211.2021 239 24.06.2021 254

&%)
B © 0O

(__scan completed ) M u]

D

oreer m g

¢ B < M

€ 2 2 G +

To import a scan from Medit, it is necessary to have a project opened in the Blue Sky Plan. The scan

will be loaded automatically.
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21 Articulation pins

For cases when the user needs to 3D print models of the upper and lower jaw in an exact position, the
Articulation pins function should be used. Articulation pins can be attached to two arbitrary STL models
(two opposing jaws), and the models with the pins can be exported.

Once the upper and lower jaws are printed (models, denture bases, etc.), the user can insert the male
and female pins into each other to recreate the exact articulation. Articulation pins can be placed in the
Model Manipulation Panel in the Surgical Guide Module.

¥ Articulation pins The user needs to select the upper and lower jaw models and
Add = articulation |:|iF|S for models: CIICk the “Add” bUtton The number Of plns Can aISO be
changed.

. STLModelLower

and

Both of the models do not need to be closed before adding
the articulation pins. Open models are closed during this
process automatically. Both of the models should be aligned
before adding pins.

- STLupper

Pins and manipulation widgets will show up. The dimensions of the connecting arms as well as of the
pins can be changed by dragging the manipulation widgets which appear when the user hovers over
that object. The arrows allow the pins to be moved to the sides and the scale widgets change the
thickness of the pins.

It is not possible to drag the pin arms outside of the pins. The default dimensions can be set in
Preferences, in the Surgical Guide tab, as Default Articulation Pin Arm Width and Default Articulation
Pin Arm Height.
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Surgical Guide

Custom Metal Cyfinder Lip Height

-
8
E

Cisiloim Metal Cvfindsr Lip Width

Software Guide Tube Distance

[
3

ok LMrecT LUt Limilis
Surgical Guide Offss)

GRS Gude Holes Dy

= W §r
= =N RS
S ERE

Diefmlt Height

Cefault Depth

']

Default Articulation Fin Arm Width
Default Ariicubation Pn Am Height
Implant to Tooth u=al side) Dstance

Default Ingerlion Path Direclion

=
o B
|

Dsnfaclt Maogmum Allewed Undercut

Rastore Defaults

Once the position and size of all pins and arms are tuned, by clicking on the "Create Articulation Pins"
the final jaw models with the articulation pins are created. The upper and lower jaw models are
separated for export and prepared with male and female articulation pins so they can be connected in
the original position.
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22 Coordinates export

For the purpose of producing a surgical guide, the program has a function for exporting the
coordinates of implants on the basis of markers that are part of the scan appliance. It is necessary to
first designate markers which are visible in the data. Open the panel with the coordinates of the export
functions that is in the menu option “File > Export To > GPI Coordinates...”

Blue Sky Plan - Anonymous - C:;/Users/Adi ‘Desktop/TESCAN/BSP models/GPI Coordinates/BSP_2020_1073/BSP_2020_1073_dicom.zip

Exports

Export to

rt Dati

In the coordinates export settings panel, select the corresponding type of scan appliance (1) and
corresponding type of jaw (2). A schematic preview of the template currently selected can be displayed
by clicking on the help button (3).

GPI Guide

In the 3D window, view the model from above and adjust the display with the slider so the markers are
clearly visible. Click button to activate marker display mode (4), and designate markers by clicking on
them. The order in which the markers are designated must correspond to the order marked on the
schematic template. If no order is prescribed then markers can be selected in any order. The markers
can be designated in all available views and their position is automatically adjusted for the best fit.
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Coordinates

Coordinates Export

Guide type 0
GPI Guide

Project type 9

Mandible

o B 7 B cCreate Report
If you make a mistake when entering a marker, the most recently entered point (5) or all points (6) can
be removed by clicking the corresponding buttons or with a right click on a marker when the marker
selection mode is active. The coordinates are actually exported when you click the “Create Report”

button (7). For a license with a limited number of exports, the number of remaining exports is indicated
on the button; the number of exports is only reduced by one each time the project is opened.

ympatible with Astra Tech Dental®)

Implant
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23 Boolean Operations

Boolean operations allow the user to join and subtract 3D models. This function can be activated in the
Model Master or Normal/Advanced Module in the Panels section.

File Edit To A

dule Help

NEEBE ~~ =REAAL wie N 15 DTN

Boolean Operations

D 0) + ABDH30

To start a boolean operation, select two models in the models section (1) with the preferred offset (2)
and then click on the operations option (4). The resultant mesh of the operation will be available in the
Surfaces panel.

If multiple models are available, the checkbox "Show selected parts only" will display only those
models among which the boolean operation will take place.

Note: Boolean operations are applied to any STL model or implant.

23.1 Union

Objects will be joined to become a single object.
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Union with zero offset Union with 2 mm offset

23.2 Difference

The difference operation is used to remove a selected part of an object.

Difference with zero offset Difference with 2 mm offset

23.3 Intersection

The Intersection operator retains the parts that are common in all the objects involved.
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Intersection with zero offset Intersection with 2 mm offset
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24 Blue Sky Plan Wizard

For easier cases of implant planning in the Normal Mode there is the Blue Sky Plan Wizard tool. The
tool allows case processing in the form of partly automated sequential steps with help. To start the
Wizard, first select "Implant Planning and Surgical Guides" in the main screen, then choose "One or
Two Implant Case". For more information, see chapter 3 "Blue Sky Launcher".

One or Two Implant
Case

IMPLANT (;
PLANNING ANI

SURGICAL GUID! 5

i

Import Models

o

Import CT Scan

‘!a

If you have already opened some project, you can also press “Start Wizard” button in the top left
corner.

Fite- Edit Tools Wiew Panels Implants  Virtual Teeth Modole Help

BEER ~~=klia s

(') Start Wizard Dr ntn -

The notification pops up, if you wish to start the new case, or open the Wizard with existing case.

A case is already open. What do you want to d

Startanew case  Open wizard with existing case
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You can move between individual Wizard steps using the “Next” (1) and “Previous” (2) buttons. Every
step clearly shows the Wizard stage you are in (3). There are thematic learning videos available for
some of the activities (4). Whilst running the Wizard you can use the “Save Screenshot” (5) button and
continue working with the screenshots via the “Screenshot Panel”. The button in the top bar is used for
reactivating or restarting the currently used tool (6).

If you find that the case requires more complex processing you can switch the Wizard off at any time
and continue work in the Normal Mode (7). Any nerves that have been detected, implants inserted or
guides created will be saved.

as

o Surgical Guide Wizard (Model STL) Draw Guide Curve Next >>
e Wizard Panel

CT, Surgical Guide: Anonymous o

o
Shift + left click to indicate curve. Grab and drag curve nodes to fine

tune positioning. Right dlick on the model and choose Add Windows
to position future windows.

¥ T

Select DICOM Folder
Autodetect Mandibular Nerves
Import STL Model

Automatic Model Aignment
Align Model

Confirm Mode! Aignment
Position Crowns

Adjust lant Positions

Draw Guide Curve

Create and Verify Surgical Guide

The Wizard allows various types of input data to be used in planing (Import Type):

* DICOM + STL Model (Model STL)
* DICOM + Model Scan (Model CT)
* DICOM + Impression Scan (Impression CT)

* DICOM + Impression Scan with Markers (Impression CT With Markers)

24.1 Load DICOM data

After starting the Wizard a dialog will open where you can select the import type, kit type and, after
selecting some kind of kit types, the handpiece you want to use (1).
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Welcome to the Blue Sky Plan Wizard

Select Import Type:

Model STL

Select Kit Type:

Blue Sky Bio Direct Cut Drills
Select Handpiece Type:

Custom

The following windows serve for DICOM data upload, potential dataset selection and to select volume of
interest (2). If you have already uploaded some DICOM data when you started the Wizard, you will work
with these data. The window “Load DICOM Data” will not open and the Wizard will move directly to the
next step.
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XZ View

24.2 Adding a mandibular canal

In this step, automatic nerve detection is carried out for both foramens. It is possible to cancel nerve
detection if the user wants to work with the maxilla; in this case, click on “Cancel, it's maxilla”.

Automatic nerve detection for both foramens can be disabled in Preferences, Automatic functionality
section.
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General

Language English

Interface Dark

Background Color 2D

Appearance

tart model alignment d

If this option is chosen, the user sets the foramens manually. Select “Set Right Foramen Manually”
and in the 3D view click the cross-shaped cursor first on the right and then on the left mental foramen
by selecting “Set Left Foramen Manually” (1). The mandibular canal is automatically detected (2) and
its shape may be edited manually in any view except for 3D (3). If you do not need to detect the
mandibular nerve, you can skip this step using the “Next” button. If you are working with the maxilla,
click directly on the “Maxilla” button in the top bar.
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Jane Doe

0 Surgical Guide Wizard (Model STL) x S~ = << Previous IB’Autodeter:t Mandibular Nerves || Set Right Foramen Manually ‘ Set Left Foramen Manually lw Maxilla ‘ Next >>
| N Wizard Panel x
T -40mr T 00mm [ § SP_2016_10 ‘

v e

ly.
atic
ion wil then

Select DICOM Folder
Autodetect Mandibular Nerves
Import STL Mode!

24.3 Model upload and preparation

In the next step the model will be uploaded and prepared. Depending on the surface scan import type,
several preparatory steps can be run before a model is prepared for aligning with the DICOM data.

* Model STL - simply upload.
* Model CT - it is necessary to set the surface threshold and create a surface model.

* Impression CT - it is necessary to first set the surface threshold and create an impression model. It is
then necessary to plot and edit a curve in the impression model to delimit the appropriate model
part and create an inverted model.

* Impression CT with Markers — you need to align the scan appliance with the gutta percha markers
(refer to section 7) and then, as in the case of the Impression CT, create an inverted model.

24.4 Model aligning

Except for the impression CT with Markers process, it is necessary to align STL model to CT dataset.
After importing the model, select if the model is mandible or maxilla. The process of alignment will
perform automatically after that. The same function of automatic alignment has the button "Automatic
Model Alignment".
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* Mandible Maxilla

It is also possible to align the model manually by clicking the button "Manual Alignment". At least five
identical teeth must be marked in the model and in the panoramic image. Points should be placed in
exactly the same position in both scans. In the next step you must confirm the alignment or return to the
previous step to improve the point setting.

as | mm
rgical Guide Wizard (Model STL) |E a3 1< Previous

st five points (Shift+left cick) in each scan.
uid be placed in exactly the same positions in

Select DICOM Folder
Autodetect Mandibular Nerves
Import Model

Automatic Model Aignment
Align Model

Confirm Model Algnment

Volume Rendering. = i em—

For reversing the alignment, click on the button "Undo Alignment".
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Wizard (Model STL) 0 revious Automatic Model Alignment || Manual Alignment || Undo Alignment

Tio

Automaticaly align a model

Select DICOM Foider

Autodetect dibular Nerves
Import STL Mode!

Automatic Model Aignment
Align Model

¥ Steps

“

R S S
e '

e

f
ALl

24.5 Crowns and implants

Now you can add crowns and implants. Crowns can be generated either automatically, or can be
selected from predefined catalog. For more information about virtual teeth, see chapter 15.
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@ Add tooth
Automatically create Al tooth | Select tooth from catalog

Teeth geometry set
Teeth Caps

Preview

T YRR Y REEXRRY Y
VWOIPITIIPpYOIW®

Select the tooth. Press and hold the Shift or Ctrl key to select additional one.

Size

O Small

® Medium Implant

O Large Blue Sky Bio IDH3010 with ABDH30

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 141

BlueSkyBio



@ Add New Implant

Implant | Abutment Software Guide Tube Preview

Customization Implant Orientation

© select Implant
O Custom Implant

Implant system: Blue Sky Bio

Showing implants for kit: Blue Sky Bio Fully Guided Surgical Kit

Type Implant

Name Label Apical Diameter  Occlusal Diameter Length -

l
3

BIO | Conus 12 (Compatible with Astra Tech Dental ®) IDH3D10 2.16 mm 3.00 mm 10.00 mm
ible with NobelActi IDH3011 2 n 0 11.00 mm
mmer Tapered Scri ) IDH3! n Y 13.00 mm

ax (Compatible with No

ompatible with NobelActive ®)

Platform

Description

BIO us 12 (Compatible with Astra Tech
De

You can choose from several teeth geometry sets and implants compatible with the kit type selected at
the start of the Wizard. The crowns are added together with the selected implants and, in this step,
you can only move them jointly.

Blue Sky Plan® examines the available space for placing the tooth and implant. This only works for
one tooth option. If the system evaluates a bigger gap for the implant in question, an info message
appears and the user chooses between automatic or manual implant placement. The user manually
places and positions the implant by clicking the "Place Manually" button. If the user selects "Add
Automatically, the program will try to place the implant, but, most likely, it may be defective. Please
note that this is only applicable to the implants associated with teeth from the catalog.

N Gap seems bigger than fit for one implant.

Add Automatically Flace Manually

Blue Sky Plan Wizard offers the possibility to add fully automatic implants. An automatic implant is
added via the “Add Tooth” dialog. Choose the associated Al tooth from the preview in

the “Automatically create Al Tooth” tab (this is selected by default). By clicking the implant field, “Add
New Implant” a dialog appears. Select “Automatic Implant” and implant type. The specific implant and
platform will be chosen automatically. Click on “OK” to confirm implant selection and then once again
on “OK” for automatic implant and adding a tooth. For more information about automatic implants, see
chapter 8.1.2.
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After the Al tooth with an automatic implant is added, segmentation takes place and the local bone and
two surrounding teeth are segmented. Segmentation cannot be hidden in the Wizard, it can only be
done outside the Wizard in the Surfaces panel.

In the next step you can adjust the implant and the crown positions separately. Both steps also display
validation information about the status of the individual implants.

. o
Surgical Guide Wizard (Model STL) "2 o = | << Previous Adjust Implant Positions

), IDH3010, 0'
v

Drag or rotate implants to adjust positioning.

Select DICOM Folder
Autodetect Mandibuiar Nerves
Import STL Model

Automatic Model Aignment
Algn Model

Confirm Model Algnment
Position Crowns

Adjust Impant Positions

Draw Guide Curve

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 143

BlueSkyBio



The® icon appears if an implant is evaluated as invalid. After double clicking on this icon the Implant
Validation Panel will open with further information.

Implant Validation
Validation Settings
[¥ Implants - drill depth
[® Implants - drill kit warning
[® Implant e Tube violation

[ Implants - minimum distance

[® Merve - minimum distance

[® Implants - maximum angle

Implants - angle che: tance

SW Guide Tube Collision Alowance

Reset To Defaults
Invalid Implants

D

Validation Results

r from being
on the implant an oftware Guide Tube" and then
r'M re Guide Tube. The drilling
will be u

If you continue while the collision between Software Guide Tube and the model is detected, you can
choose in this step if you resolve collisions immediately or leave it as it is.

A collision has been detected between Software Guide Tube and the Model.

[] Do not show this message again

Resolve collisions Do nothing, I got this covered

24.6 Surgical Guide

Prior to fabrication of the surgical guide it is necessary to specify the part of the model to be covered.
In the “Draw Guide Curve” step, a curve around the area of interest is drawn automatically on the base
model. By generating a surgical guide, the undercuts are removed and the newly-generated model
does not have them. To edit the curve, move its individual points and when moving on to the next step,
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the surgical guide will be created. In both the “Draw Guide Curve” step and the “Create and Verify
Surgical Guide” step, windows can be added by right clicking on the base model and they can be
adjusted by manipulating the widget. By clicking the buttons "Next" (in the "Draw Guide Curve" step) or
"Recreate Guide with Windows" (in the "Create and Verify Surgical Guide" step), a surgical guide will
be recreated with windows.

D Wizard Panel

¥ " uf
Q) Surgical Guide Wizard (Model STL) . | = | << Previous Create and Verify Surgical Guide ‘ ‘ Recreate Guide with Windows Next >>
4
Surg Suide Yoe

i)

¢ Create surgical guide. Optionally, add windows and recreate surgical
guide.

The automatic surgical guide suggestion can be enabled in the Preferences > Surgical Guide > Run
SG curve suggestion automatically.
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Surgical Guide

Default Height 10,00 mm

Default Depth 5,00 mm

Guide Curve Suggestion

Direct Cut Drills
Gingival Margin on the Buccal Side 1,00 mm

Gingival Margin on the Lingual Side 2,00 mm
Number of Teeth Extention on the Buccal Side 2

Number of Teeth Extention on the Lingual Side 2

Default Articulation Pin Arm Width 5,00
Default Articulation Pin Arm Height 2,50
Implant to Tooth (occlusal side) Distance 12,00 mm
Default Insertion Path Direction 0,00°
Default Maximum Allowed Undercut

Endo Mode

show selected implant/toot

Move slices tc

Automatic functionality

Run bone segmentation without manual adjustments
[! Run CT teeth segmentation automatically
Run bone segmentation automatical

Run air

Restore Defaults

24.7 Saving and ordering

In the remaining Wizard steps, you first save the prepared project. The template created is exported
and can be submitted via BioBigBox.com. Then the PDF report with basic information and screenshots
is saved. The necessary parts can be ordered directly at http://www.blueskybio.com. Then you can
continue with a new case or close the Wizard.
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http://www.blueskybio.com/

25 Orthodontics Module

Blue Sky Plan makes it possible to plan orthodontic treatments based on imported STL models of the
jaw with teeth. All of the controls are available in the “Orthodontics” panel.

Planning begins with an intro screen entitled “Orthodontics”, where the user selects the type of
planning — “Aligners”, “Indirect Bonding Tray - Align Brackets to Teeth”, or “Indirect Bonding Tray -
Align Brackets to Wire”. For more information, see chapter 3 "Blue Sky Launcher".

Aligners

WRast®

ORTHODONTICS

; Indirect
M B Bonding Tray
(IBT) Align
Brackets to Teeth

Indirect
Bonding Tray ' E<
(IBT) Align
Brackets to Wire

"N o

The specific type of planning can’t be changed in an upcoming process. You can view the selected
type of planning for your project in the top left corner of the 3D window where the patient data is
shown.

The functions for model preparation are identical in all types of planning. Specifically, this includes the
steps for Loading the Input Model, Jaw Alignment, Teeth Segmentation and Model Trimming.

The individual types of planning include:

Aligners: Teeth Moving — Edit Steps — Add Attachments (optional) — Design Aligners or Aligner Trim
Curve (optional) — Export

IBT (Align Brackets to Teeth): Add Brackets — Prepare IBT — Export

IBT (Align Brackets to Wire): Teeth Moving — Edit Steps — Add Brackets — Prepare IBT — Export
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25.1 Loading the Input STL Model

The planning starts by loading the STL jaw model using the
menu selection “Import Models” and choosing the correct
orientation. It is also possible to use the option “Import
Patient CT Scan”, with the stepwise uploading of CT data
and jaw models. The alignment of the STL model and the
CT scan is done via “Matching Teeth”, and the STL model
can then be further worked with.

If the other jaw (the opposing arch) is available, it can be
imported in this step. After it has uploaded, the user is able
to show/hide this other model together with the

“Collisions” and “Closeness” functions, switching on the
colour visualization of collisions as the teeth approach each
other or collide.

Both jaws should be automatically aligned, or it is possible

to activate the model alignment widget ‘ to allow the user
to move the jaw manually in the 3D view. Another function
for this purpose is “buccal bite registration” (see chapter
25.2).

Orthodontics Panel

¥ Load Jaw
Import opposing arch and buccal bite if available.
¥ Visibility

Occlussal Positioning

[[] collisions

[[] Closeness

Opposing Arch

Import Opposing Arch

Buccal Bite Registration

Load Model

Patient Info
Patient Name Patient]
Add Tooth

Add Tooth

Continue to Annotation >>

Blue Sky Plan also permits the processing and planning of both jaws in a single case. This requires
uploading and aligning both models in the import stage. This step further includes entering the

patient’s name.

If there is a missing tooth in the STL model, the user is able to add a tooth via the “Add Tooth” button.

By clicking the option, the Add Tooth dialog appears and it is possible to choose a tooth from

several teeth geometry sets.

After the tooth selection, simply click on the OK button and left click on the model with missing tooth. It

is possible to adjust the tooth position or remove the tooth by right clicking the mouse > Remove.

Note: Teeth can be added/removed only in the import step. The selected tooth must match the correct

Jaw!
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Add teeth Merged teeth in the segmentation step

It is possible to automatically run the steps "Annotation”, "Segmentation”, "Trimming", and, if CT data
are available, also to align STL models to CT data. If enabled in Preferences, all the selected steps will
be skipped and the user will get to the "Teeth Moving" or "Continue to Add Brackets" steps faster.

"All skipped steps can be returned to using the "Back" button"

@ Preferences

Orthodontics

General Dental Notation Y]
. Generated Models Quality Very high
Customization
CT Teeth Segmentation Disabled
Proje(t Jaw Bone Segmentation Disabled
Airways Segmentation Disabled
Shorteuts Automatic Annotation Enabled
Closed Model Height 20,00 mm

Advanced
Gingiva Augmentation Amount 0.00 mm

BlueSkyBio Account Automatic Approval of Model to CT Alignment Enabled

Automatic Annotation Step Enabled

Surgical Guide

Automatic Segmentation Step Enabled

= - " Automatic Model Trim Step Enabled
BSB Direct Cut Drills
Model Trimming

Orthodontics

Gingiva Trim Margin 2,00 mm

o ] ight Below M ible Teeth After Trimmil 24
Tooth Movement Limits Model Height Below Mandible Teeth After Trimming 00 mm
Medel Height Above Maxillary Teeth After Timming = 2,00 mm

Crown and Bridge
Pivot Offsets

If the automatic function for the steps is disabled, proceed to the next step by clicking the “Continue to
Jaw Alignment” button.

25.2 Buccal Bite Registration

Blue Sky Plan allows for upper-lower jaw alignment using a “buccal bite” surface scan. This process
requires both jaw models to be imported. Then, the “Buccal Bite Registration” button can be used for
transferring to the special “Buccal Bite Registration” panel. The maxilla and the mandible are already
automatically uploaded to the panel and it is only required to add one or more buccal bite scans. The
software then automatically aligns the maxilla and the mandible. Additional buccal bite alignments can
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be created (according to the number of the buccal bite scans) and visualization is possible for the
mandible moving from the normal to each of the additional buccal bite alignments.

Buccal Bite Registration

Buccal Bite Registration

Add Buccal Bite

Positions

* Animations

* Mandible articulation

25.3 Mandible articulation

The lower jaw articulation can be visualised by adding jaw articulator. This functionality is not
dependent on import of the buccal bite and is available in all types of planning and all their steps on
Buccal Bite Registration panel. Collisions between the upper and the lower jaw can be shown in all
positions.
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Buccal Bite Registration

25.4 Annotating Teeth and Jaw Alignment

25.4.1 Manual Teeth Annotation

Once the jaw model is imported, it is necessary to mark all teeth, including those teeth that will not be
moved or teeth that are missing. Teeth annotation is only possible when the “Mark All Teeth Manually”
button is active.
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Orthodontics Panel

£ Maxilla o/ Mandible

A Opposing Arch

—~ Jaw Mavement
o)
- Occlusion Positioning
[] show Opposing Arch [ collisions

Annotate Teeth

Teeth Annotation

Correct Single Tooth
i Automatic Annotation b4 Clear Tooth
Mark All Teeth Manually

L ad One Tooth Back Clear All Teeth

Continue with Mandible ‘)}

The tooth from which the teeth marking starts is highlighted in red in the schematic jaw figure in the
panel. First, the teeth on the patient’s right-hand side are annotated starting from the incisor and
finishing with the molars. To mark a present tooth that will be moved, hold the “Shift” key and left click
on the tooth. Orange and yellow dots illustrate the annotated teeth on the 3D model. A tooth that will
not be moved, or is missing, should be marked by right clicking on the mouse (blue dots appears on
the model).

Once all the teeth on the first side are annotated, you can proceed with the other side by clicking “Go
to Left Side” starting from the incisor highlighted in red again.

It is not necessary to annotate all the teeth on each side. If the last molar, or so, is not present, you
can skip marking the remaining teeth on the side by clicking either “Go to Left Side” or “Finish Teeth
Marking” .

While marking the teeth, it is possible to return one step back (the “One Tooth Back” button) and
repeat the marking of the previous tooth, or to start from the beginning again by pressing “Clear All
Teeth” . The colored (blue and yellow) labels indicate the teeth names.
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Orthodontics Panel

& Maxilla

X

.A‘ Opposing Arch

-
Occlusion Positioning

[] Show Opposing Arch

Annotate Teeth

Teeth Annotation

Correct Single Tooth
B Automatic Annotation Clear Tooth
Mark All Teeth Manually

| o One Tooth Back Clear All Teeth

Continue with Mandible )>

A single tooth correction is possible by clicking on the “Correct Single Tooth” button (1). Click on the
scheme to select the tooth (2) and correct the annotation on the jaw model (3). To remove the
annotation from the selected tooth, click on “Clear Tooth” button. Is it possible to mark the tooth again
by holding the “Shift” key and left clicking on the tooth.

To complete the step, click the “Continue with Mandible” button.

Note: The proper marking of the teeth is crucial for the subsequent automatic teeth segmentation step.
It heavily impacts the precision of the segmentation. Incisors and canines should be marked by
clicking/placing two dots on the occlusal edge of each tooth. Molars and premolars should be marked
by placing the dots on the buccal side of the tooth surface as indicated in the image above.

25.4.2 Automatic Teeth Annotation

Blue Sky Plan allows the user to automatically annotate the teeth. To disable or enable this function go
to Tools -> Preferences -> Orthodontics -> Automatic Annotation.
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Orthodontics Panel

& Mailla o/ Mandible
Opposing Arch

Jaw Movement

Occlusion Positioning

[ show Oppasing Arch [ collisions

Annotate Teeth

Teeth Annotation

Correct Single Tooth
"= Automatic Annatation X Clear Tooth
Mark All Teeth Manually

[ a3 One Tooth Back Clear All Teeth

Continue with Mandible

This functionality works exactly the same way as manual annotation. The user is able to switch
between manual and automatic annotation for manual modifications of the dots.

The thickness of the final stone model, i.e. the minimal allowed height in millimetres, is at least 20 mm
and can be increased in Preferences.

25.5 Two Jaw Functionality

Once the teeth of the first jaw (maxilla) are annotated and the model is closed, the transfer to the
mode of planning both jaws is activated. By default, the workflow is set so that after clicking “Continue
with Mandible” a direct transfer is performed to the second jaw annotation. To plan both jaws, both
models must be annotated and aligned. In the following steps there is the option to actively work with
one or the other jaw. If the dentist uses the other model (the opposing arch) for visual control in the
course of the planning step and for the depiction of possible inter-mandibular collisions only, the “Skip
this Jaw” button can be used for direct transfer to a single jaw segmentation.

25.6 Teeth Segmentation

The transfer to the step of the automatic segmentation of individual teeth may take a while as the
program tries to identify the gingival margin automatically.
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Orthodontics Panel

Orthodontic Aligners: Anonymous patient

After the automatic segmentation, you can adjust the
detected gingival margin of the active/selected tooth by
dragging the control points of the curve, or by manually
drawing a part of the curve on the model while holding down
the “Shift” key and left mouse button simultaneously.

The gingival margin can be edited for the active tooth only. The active tooth can be changed
throughout the schematic jaw image in the panel, or by clicking the segmented tooth directly in the 3D
view.

Select the tooth you want to remove and click the Extract Tooth button. The last tooth can't be
extracted.

Radial deformation affects the shape of the resulting ovate pontic. When turned on, the amount of
surface deformation depends solely on the distance of the surface point from a theoretical center of
the tooth, resulting in a symmetric, radius-dependent shape. When toggled off, the amount of
deformation applied to the gingiva at the pontic site is calculated adaptively to the shape of the tooth's
boundary, resulting in an ovate pontic that copies the boundary shape.
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Ovate Pontic Depth: -5 mm Ovate Pontic Depth: 0 mm Ovate Pontic Depth: 10 mm

Tooth extraction without using "Radial Tooth extraction using "Radial Deformation"
Deformation”

Once the boundaries need no further refinement, you can finish the segmentation by clicking the
“Continue to Model Trimming” button. This applies the changes made and separates the teeth from the
3D scan being able to move them.

25.7 Model Trimming

The STL model imported to BSP may contain excess material and printing it would mean an
unnecessary waste of printing material. For these situations, BSP offers the trimming function by
means of a curve. The trimming curve is created automatically at a distance from the teeth based on
the “ Gingiva Trim Margin ” parameter (which can be modified in Preferences). The curve is further
manually adjustable by dragging the control points.

Part of this step is also the closure and trimming of the model at a specific height based on the

distance of the segmented teeth. The parameters “Model Height Below Mandible Teeth After

Trimming” for the lower jaw and “Model Height Above Maxillary Teeth After Trimming ” for the upper
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jaw can be modified in Preferences. The Model Trimming step can be skipped by using the options
“‘Don’t Trim Maxilla” or “Don’t Trim Mandible”.

©Orthodontics Panel

Continue with Mandible 3>

In this step, Model Trimming is only defined. It will only start after clicking on Continue to Teeth Moving,
so this operation may take a while.

After the separation of the teeth, the gingiva may be
augmented (i.e. inflated) to prevent interference with the
aligner and to help prevent tissue impingement. Note: Due
to the optimisation in the processes, the .0mm value is
recommended for versions 4.7.50 and higher. The .2mm is
recommended for versions 4.7.20 and older. This is the
“Gingiva Augmentation Amount” parameter in Preferences.

Also, the colours of the 3D model and the teeth change to a more natural pink and white, respectively.
Now the software allows you to reposition the teeth and plan their final positions.

25.8 Teeth Moving

In this step, the target positions of individual teeth can be planned. You should start by selecting the

active tooth — either by left clicking on a tooth in the schematic jaw image in the panel, or by clicking
the tooth in the 3D view.
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The active tooth has a visible tooth midline and a 3D
manipulation widget shown around it. Using the widget, you
can move and rotate the tooth in the following types of
movements:

» Mesial / Distal tipping

* Buccal / Lingual tipping

* Rotation along longitudinal tooth axis
* Intrusion / Extrusion

* Left / Right

e Forward / Backward

¥ Visibility

CT Positioning Occlussal Positioning
|:[ Closeness D Collisions
I:[ IPR I:[ Diastemata
[] Teeth Midlines [] Teeth Widths
[] cT Teeth
|:[ Initial Teeth Positions

A couple of interesting functions can be activated in the
orthodontic panel after this step. The “IPR” option will show
a 3D view of the sizes of the over-limit Interproximal
reductions, and the limits of the maximum allowed IPR can
be set in Preferences. The red areas informatively visualise
inter-teeth collisions. “Diastemata” shows the measurement
of the space between the teeth. “Initial Teeth Positions”
shows the original model before positioning the teeth. “Final
Teeth Positions” shows the last model after positioning the
teeth. “Teeth Midlines” allows the user to see the estimated
tooth axis with its midline. Teeth widths and their sum is also
displayed by checking “Teeth Widths”.

The "Automatic" section (1) allows the final positions to be 7 Teeth Setup

computed for the aligning treatment. This requires the user o e S ToE
to upload and annotate both jaws. "Align Both Jaws S e s e T
Automatically" (2) runs the alignment algorithm repeatedly, Aign Both Jaws Automatically e
trying to improve the final positions with every step. v Advanced

Collisions between jaws are not resolved. IPR is Alignment Repetitions
automatically applied afterwards. "Align without IPR
resolving" (6) only runs the algorithm once and doesn't
resolve IPRs. Each run only tries to improve the positions of

Maximum Allowed IPR =l o
Canines Distance To Opposi th 0,10 mm e
ine 0,50 mm

the teeth. "Resolve IPR" (7) tries to resolve IPRs by arch e Algn vithout PR resohing
expansion and teeth shifting. The "Alignment Resoive IPR o
Repetitions" (3) slider shows the number of algorithm runs,
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10 by default. The "Maximum Allowed IPR" (4) slider allows
IPR up to a certain value, as the default is no

IPR. Additional parameters can be edited in the leveling
section for every jaw (5).

The "Snap to Curve" section (1) allows the user to adjust a
curve representing an ideal teeth arch and snap one or all
teeth to this curve.

In order to straighten the teeth to the curve while keeping
the IPR data in an acceptable range, select "Level to
Curve" (2) and click on the "Snap All Teeth" button. When
the user works with the mandible jaw and an opposing arch
is available, the software allows the user to level the teeth to
the opposing ones (3). Click on "Snap All Teeth" for
snapping. Additional parameters can be edited in the
leveling section for every jaw. (4). The "No

Levelling" (5) option snaps the teeth without extrusion or
intrusion. By clicking on "Edit Curve" (7) the user edits the
curve points symmetrically or asymmetrically. This button
also enables "Move with Curve", where it is possible to
move both the curve and the teeth at the same time. When
"Edit Curve" is active, the measurements of the dental curve
are visible. The "Reset Curve" (8) button resets the curve to
its original position. If the user clicks on the "Edit Curve"
button again, the curve can no longer be edited.

Clicking the "Adjust Curve Plane" (6) button activates the
occlusal plane for adjusting the curve. It is possible to move
the plane in the 3D scene based on the angle and distance
of the plane. Edit

Additional parameters are available in the Preferences for
Orthodontics, Tooth Movement section.

¥ Teeth Setup

o

Snap To Curve

9 Level To Curve e Level To Opposing Teeth e No Leveling

Snap All Teeth

Automatic

pper Centrals Distance To Upper Curve = 0,50 mm

1,00 mm o

Upper Laterals Distance To Upper Curve

(6]

Adjust Curve Plane

o Edit Curve

Move Points Symmetrically Move With Curve Show Curve @

Reset Curve (Symmetric)

Curve Plane Adjusting
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Panoramic Curve: Mandible
.

“ ‘m'u ¥
(AW \ LR f“)

B, H

"Auto Position CT Slices With Selected Tooth"
enabled

"Always visible" widget enabled

Every tooth can be locked in position by right clicking on the
tooth and selecting “Lock Tooth” from the content menu.
Unlocking proceeds in a similar manner, or the user can

unlock all teeth at once by clicking on the “Unlock All Teeth”
button. Trans - Buccal/Lingual ~ -0,02 mm

¥ Tooth Deviations (LR1)

Trans - Mesial/Distal

The user can also adjust the midline when the “Adjust PGS

Midlines” button is active. : =
Tip - Mesial/Distal

The “Reset All Teeth” button returns all the teeth to their Rotation

original positions. As the active tooth is being moved, the = il
“Orthodontics” panel shows information about the total Limits | Manthly
movements in the form of distances [mm] and angles [°]
from the initial position. Movement limits can be set as
monthly, bi-weekly or weekly.

Tip - Buccal/Lingual

Multiselection allows multiple teeth to be manipulated at
once - hold Shift key and by left clicking select multiple
teeth. With multiselection, it is possible to utilize all the
manipulation methods (via the manipulation widget,
deviations table and arrow keys). Checking the "Transfer
movement locally" checkbox, the tooth’s local deviation is
applied to other selected teeth.

Context menu options (locking, snapping, changing teeth
movement speed, etc.) can also be used with multiselection.

Milestone is a mandatory step across all teeth (i.e. "sync
point"). Final and initial positions are implicit milestones, but
it's possible to create additional milestones if necessary. e ——

Milestones can be created in two possible ways: o
« By clicking the button "Insert Milestone" (2) (2
* By duplicating the “Teeth movement” step

The slider (1) shows the sequence of individual milestones.
Each milestone (excluding initial position) can be deleted
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(3). It's also possible to clear the custom milestones and
return to default ones (4).

¥ Teeth Manipulation

Unlock All Teeth

Adjust Virtual Teeth

When positioning a tooth, it is sometimes useful to see the
movement of the whole tooth, including its roots. Therefore,
Blue Sky Plan allows you to add a virtual tooth with roots
simply via the context menu > Show Virtual Tooth or by
enabling the "Virtual Teeth" checkbox (note: This option
won’t be available if you import CT Data). To refine the
shape and position of the newly added virtual tooth so that it
closely matches the underlying teeth separated from the 3D
scan, click on the “Adjust Virtual Tooth” button. Now, you
may adjust the position and size of the virtual tooth using
the in-scene widget. To hide the virtual teeth, click on the
"Virtual Teeth" checkbox again.

To work with a selected tooth, right click on the tooth and
choose the functionality. To hide the tooth, select "Hide
virtual tooth". To reset the tooth to its original position, select
"Reset virtual tooth position". It is possible to change the
point of rotation of 3D manipulation widget, i.e. to switch
between the tipping and torque. The tipping and torque
angles are tracked and reported separately. Pivot offsets
can be set in Preferences.

Blue Sky Plan software allows the user to work with
segmented CT data.

Go to Preferences > Orthodontics > CT Teeth Segmentation
to enable segmentation of CT teeth.

To hide all the visible CT teeth simply click on the "CT
Teeth" checkbox. To hide one (or more) CT tooth, right click
the selected tooth and choose "Hide CT tooth". For better
clarity of the roots, the transparency of the jaw can be
increased by moving the slider in the panel (1).

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05

BlueSkyBio

Reset All Testh

Adjust Midlines

Hide virtual tooth

Reset virtual tooth position
Lock tooth
|
s 0sitic

Snap tooth to curve

Ay o

A\k )

Hide CT tooth

Lock tooth \

Snap tooth to curve
Switch to torque

Reset tooth position

161



The user can enable automatic jaw bone segmentation.
This option is available in the Preferences > Orthodontics >
Jaw Bone Segmentation.

When entering the Teeth Moving step, the segmented jaw
bone with CT teeth will automatically become visible. To
hide the data simply use the "Jaw Bone" checkbox. For
better clarity of the CT data you can increase the

transparency by moving the slider in the panel (2). * Transparency

Airways segmentation can be enabled in Preferences > ERETIEEEET

Segmented

Orthodontics > Airways Segmentation. To hide the data use
the "Airways" checkbox. For better clarity of the CT data you
can increase the transparency by moving the slider in the
panel (3).

Segmented Airways

Note: The options "CT Teeth Segmentation", "Jaw Bone
Segmentation" and "Airways Segmentation" must be
enabled during the import step of the CT Data in order to
produce segmented data!

A
=4

1 W

|

\ WL
Iy

e

CT Teeth Jaw Bone

(1]

BSP allows the user to correct ongoing treatment with original final positions. The user loads the new
scans and proceeds to the "Tooth Alignment" step, and selects the original project via File > Import

Final Tooth Setup from Existing Case (1). When the project is loaded, the final position planning from
the new project is updated and a color map showing per tooth alignment accuracy is displayed. After
loading the original project, the "Confirm Import" button (2) will appear, after clicking it the color map

will disappear, but the final positions will remain.
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'Flle Edit Tools View Panels Virtual Teeth Help

| g New Project
B Open Project..

Recent Projects

% Import Final Tooth Setup From Existing Case...
¢ Import Face Scan...
Export Data...
Save DICOM Data...
B Purchase STL Exports...
i Print...
Save Image...
.. Approve Plan..,
- Show Data Properties...

Exit

oe @ LabPronto ~PurchaseExports [N

3D
Ctrl+S
Ctrl+Shift+S

Ctrl+W

(1)

Ctrl+Shift+E

Ctrl+P

Ctrl+Q

© Confirm Import

25.9 Generating Intermediate Positions

Once you are satisfied with the target positions of the teeth, use the “Continue to Edit Steps” button to
generate intermediate positions and move to the next planning step.

The table in the “Orthodontics” panel lists the number of necessary intermediate steps to reach the
planned target position of the active tooth. The number of steps is always the same for all the teeth,
but it is possible to start the movement of teeth in later steps. The first and last row in the table
represent the initial and target position of the active tooth, so these positions are locked and cannot be
changed at this planning stage. The number of steps is estimated automatically based on the pre-
defined settings of maximum movement limitations. The default movement limitations are stored in the
application Preferences and can be adjusted manually.
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The slider at the top of the “Orthodontics” panel (2) allows you to
move teeth over time and in intermediate steps. If the slider is
moved to the left, the teeth are visualised at the initial positions.
The very right position of the slider represents the planned target
positions. By dragging the slider, you can animate the movement
of the teeth through intermediate steps over time. Further, you
can move the slider to one of the interim steps and, if needed,
adjust the position of the active tooth in this concrete step to
prevent collisions with its neighbouring teeth.

The movement of an active tooth is illustrated by a green color in
the table. Milestones are depicted in red. Orange rows are
milestones with changes with respect to the previous step. The
row selected by the user is marked blue.

In the table, there are two columns of checkboxes. It may be
important to start the movement of the active tooth later in a step.
The starting step can be changed by checking the checkbox in
the left column ("Start Step")(3). After any change, it is necessary
to regenerate the entire table by clicking the “Refresh Steps”
button (7). The checkboxes in the right column ("Mandatory")(4)
can be used to lock the intermediate positions of the tooth — the
tooth always moves through the locked intermediate positions.

Three optional plans for organizing teeth movement are available
— “Least movement move last”, “Least movement move first” and
"Uniform movement". "Inter Tooth Sequencing" (5) moves all
teeth with respect to each other, while "Intra Tooth

Sequencing" (6) is related to the rotation and translation

movement for individual teeth. It is also possible to set Intra Tooth

Sequencing by right clicking on the tooth.

The movement of all teeth can be postponed in one step by
clicking the "Duplicate steps" button (8). The details about each
tooth movement within the specific step can be found in "Step
Details" (9). For an illustration of teeth movement in each
individual step use "Open Movement Chart". If necessary, each
adjusted plan can be reset to the default one (10).

The movement speed of each tooth can be changed by right
clicking on the tooth. Decreasing speed will slow down tooth
movement by 65%, while increasing speed will accelerate tooth
movement by 65%. Resetting the speed will return the tooth

Steps (6/15)

9 0 ¥ Export Video

I« < »> »

9 Start Step

Tooth (UR2)
e Mandatory

Initial Position

Step 1

al Positic
I
encing (All Teeth Sequencing): 6 @

e last ~ =

ool encing (Individual Tooth Movement): @
m

ent move last

0 Refresh Steps

Show virtual tooth

Movement speed

Intra tooth sequencing

movement speed to the original values. Note, that any change of
tooth movement speed will also affect the number of intermediary
steps in the table.

In the Aligners planning type, it is necessary, at the end of this step, to select which method of creating
aligners will be used further on. For the generation and export of model intermediate positions only,
the default selection “ Export Models Only ” is sufficient.

By selecting the “ Design Printable Aligners ” option, the aligners will be drawn and generated directly
as models in BSP, which can later be exported. Selecting “ Design Aligner Trim Curve ” means that the
trimline, applicable to the mining machine, will be drawn on the models and exported. It's very helpful
for automatic aligner trimming.

If attachments are meant to be added on model intermediate positions, it is necessary to check the
“Add Attachments” as well. Doing that will add this step to the rest of the process.
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The “Export Video” button (1) allows the user to export video content of teeth movement. A couple of
interesting functions can be set in this option. Note that by default, the size of the video is given by the
size of the 3D scene window. In some cases, this can produce large videos (e.g. on 4k monitors),
which some video players may have issues with. To prevent these issues, you can limit the size of the
video by choosing the "HD" or "Full HD" limit in the "Video size" option. Alternatively, you can install a
different video player (e.g. the VLC media player) which can handle large videos.

Video content:

sl Ay =E

Both jaws separately Both jaws in a bite

What you see on screen

v
+ Show IPR/Diastemata labels

Video si

Custom t

Font size 75 -

[] t#alic [] Bold [] Underline

Cancel

25.10 Orthodontic Aligners

The method of creating aligners can be selected at the end of the step “Generating the intermediate
positions” (described in the previous chapter). The upcoming steps will be based on this selection.

25.10.1 Add Attachments

Attachments are added automatically through the predefined “Automatic Attachment Placement” in
Preferences. The attachment are placed according to the clinician’s instructions.

To change the placement of the attachments, click on one of the three options: "Gingival Placement",
"Mid Placement", or "Incisal Placement". This will only affect attachments that are positioned vertically.

Attachments

Automatic Placement

O Gingival Placement (@ Mid Placement O Incisal Placement

Remove All

Replace All
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Attachments can be added manually after right clicking on the tooth in the 3D view and selecting
among several sets, shapes, and sizes. The attachment position can be fine-tuned manually.

If the user decides to go to the previous step to change teeth movement, the attachments for the
current placement can be kept. This also works for the brackets.

N Do you want to keep current attachments?

25.10.2 Design Printable Aligners

This step is intended to be used for drawing and editing the curve for the aligner fabrication. The
aligner curve will be generated automatically based on the settings of the “Curve Shape” and “Trim
Margin” parameters in Preferences. Both parameters can be adjusted as well and regenerate directly
on the Orthodontics panel. These changes are saved in the project. If the parameters are changed in
this process, it is necessary to regenerate the curve by clicking the “Reset Curve” button. The
generation of aligners is a part of the transition to the STL model export step.
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The production of aligners may be ordered at Blue Sky Bio. You must send the STL files containing the
models with the 3D profile on them to identify the patient and stage number to Blue Sky Bio. Blue Sky
Bio will make the aligners and ship them to you. If at any stage the patient no longer matches your
model for that stage (making the aligner not fit) then edit the models and re-order the aligners. More
detailed instructions for use are available in Footnotes 31.1.

25.10.3 Design Aligners Trim Curve

The Aligner Trim Curve will be (just like the Aligner Curve) generated automatically based on the
settings of the parameters “Curve Shape” and “Trim Margin” in Preferences. Both parameters can be
adjusted as well and regenerate directly on the Orthodontics panel. These changes are saved in the
project. If the parameters are changed in this process, it is necessary to regenerate the curve by
clicking the “Reset Aligner Trim Curve” button. To use the trimline information to automatically trim the
aligners in the milling machines’ information in the future, it is possible to turn on “Show locator” and
modify the trim curve accordingly. It will be possible to export the curve in the last step.

Orthodontics Panel
Orthodontic Aligners: Anonymous patient

The type of the aligner locator model can be set in the Preferences -> Orthodontics -> Aligners
section. The locator type can be changed in the Export step as well.
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Aligner Trim Curve

Edit Curve

Clear Curve

Curve Shape [ ) Continuous

Trim Margin 1,00 mm
Reset Curve

T SHAPE

25.10.4 Send for Aligner Manufacturing

By selecting "Send for Aligner Manufacturing” (1) and clicking on "Send for Aligner Manufacturing” (2),
you are able to order aligners for a case via LabPronto.

Attachments and Export Options

On the LabPronto page, select order information and attach files. Click "Order Now" to order your
aligners.
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Predictable TAD Placement
with TAD Surgical Guides!
Now Available!

@ BlueSkyBio.com  Your Partner In Implan

Aligrers USRS ($ 0.00)

Clear Aligner Fabrication ($30 + 520/ Aligner ) Total Order:
$50.00

ORDER INFORMATION

Select Option
12

Select Option

Additional information for Lab:

Continue to Attach Data Files
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Predictable TAD Placement
with TAD Surgical Guides!
Now Available!

'3 BlueSkyBio.com  Your Partner In Implant & Digital Dentistry
y B

Attach File(s) _, A

USPS ($ 0.00)
Total Order:
$50.00
Previous
Coupon Code Apply
IMPORTANT:
ORDER NOW

O

Note that this service is currently available only in the United States of America and you need to have
filled the shipping address.

25.11 Indirect Bonding Tray - Align Brackets to Teeth

Blue Sky Plan also allows for controlled virtual bracket placement in the software and the fabrication of
an indirect bonding tray to allow the physical brackets to be placed.

This planning type is used to add brackets to the initial position of the teeth. That is the reason why it
doesn’t include the Teeth Moving step and after Model Trimming goes straight to Add Brackets.

25.11.1 Add Brackets

Brackets are added directly on the teeth based on the predefined “Brackets Placement Offsets” in
Preferences. The position of already added brackets can be modified by the 3D manipulation widget
and the function “Snap to Tooth” by right clicking with the mouse.
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25.11.2 Prepare IBT

Once the brackets are placed, the next step will include drawing and editing the curve for indirect
bonding tray fabrication. Its use allows the physical brackets to be placed accurately in real life.
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25.12 Indirect Bonding Tray - Align Brackets to Wire

25.12.1 Add Brackets

The “Align Brackets to Wire” planning type is used to add brackets to the final position of the teeth.
Blue Sky Plan automatically places the brackets along the wire. The brackets fully respect the
rectangular wire and do not adjust their position according to the teeth surface. Just as in the previous
method, it is possible to choose from several bracket systems and the added bracket can be modified
using the 3D manipulation widget and function Snap to Wire by right clicking with the mouse.

25.12.2 Prepare IBT

This steps includes drawing and editing the curve for indirect bonding tray fabrication similarly to the
previous type of planning. The curve is drawn on the final position of teeth. The indirect bonding tray is
generated for the first position model only. The default setting for IBT fabrication can be changed in
Preferences.
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25.13 Generating and Exporting STL Models

The final step, Export, is again common for all types of planning. The only difference is in what can be
exported in this final step (OBJ or STL models or the parameters of the curve).

[Orthodontic Aligners

\j
»‘4\-
t

Volume Rendering

Orthodontics Panel
Export and Report Generation
Export models and data. Right dlick on model to add printing platform.

Active Jaw
& Maxilla
Visibility

[ coliisions
[ Final Teeth Positions

[ show Opposing Arch
[] mitial Teeth Positions

¥ Platform for Printing

Apply On
O Model @ Aligner
Reset

TitX: -10,00 2z Tity: 0,07 T Ttz 037

Separation: Il
Label Tool

Label Text Anonymous Patient

[ Show Label

O Emboss ® Engrave
Apply On
© Model O Aligner

Apply
Models (Step 14/14)

(4 Export (6 remaining)

Before the export itself, it is necessary to check all of the intermediate positions of the generated
models. After the check, it is possible to export models in different coordinates; regular and separated
models can be sent separately. A model’s export coordinates can be selected in the Orthodontics

Panel.

General
Customization
Project
Shortcuts
Advanced
BlueSkyBio Account
Orthodontics

Tooth Movement Limits
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Curve File Delimiter SPACE
Curve File Extension XyzZ

Exported Curve Point Spacing = 0,50 mm

Printing Platforms

Add Model Platform Automatically

Add Aligner/Indirect Bonding Tray Platform Automatically
Platform Rotation

Model Platform Height

Model Platform Thickness

Aligner/Indirect Bonding Tray Platform Height

Aligner/Indirect Bonding Tray Platform Thickness

Models Export

Label Text and Numbering

Generate Steps As Hollow Models
|:| Generate Cross Pattern

Hollow Models Thickness 3,00 mm

@ original (O Aligned
O original O Aligned
O No Separated Models

Exported Models Coordinates

Separated Models Coordinates

Export Separated Teeth / Gingiva

Blue Sky Plan®

10,00 °
15,00 mm
3,00 mm
7,00 mm

4 00 mm

@ Separately ) One line

O Forward () Base Down
O Forward O Base Down

O Separated Models Only O Separated Models Extra
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coordinates: aligned coordinates: base down

Platforms are automatically added to the generated models, allowing for the horizontal 3D printing of a
larger number of models. They are added separately for models and for aligners, and for additional
work with them, it is necessary to have the correct option checked on the Orthodontics Panel. The
default settings for platforms (size and rotation) are found in Preferences, Orthodontics tab. These
parameters can be further manually adjusted for a specific case. Using the “Separate” slider, it is
possible to create two smaller parts at the end of the jaw, which are sufficient for printing. You can add
the platform to a model just in one step — it will be generated in the remaining steps.
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The Orthodontics panel also allows you to supplement the generated intermediate models and
aligners or IBTs with text with a 3D profile emboss or engrave (typically the patient’'s name and the
step number). This is done with the “Label Tool” which works like the one used to emboss text on
surgical guides. The text needs to be attached to the first model only and it is automatically
propagated onto the other intermediate models. It is necessary to choose either the emboss or
engrave method in the “Label tool” and if it will be applied on the generated models or aligners (IBT). It
is also possible to choose if the label text and number of the model will be generated on the same row.

= Labed Tool

If the generated STL model needs to be optimised for print, hollow with (or without) a cross
pattern, the user must check the "Generate Steps as Hollow Models" and check the “Generate
Cross Pattern” in Preferences, in the Orthodontics tab, before exporting.

Besides the models, the parameters of the Aligner Trim Curve can be exported as well for the Aligners
planning type. The generated curves for intermediate models can be modified individually with the
visualised locator to be optimally prepared for use on the milling machines. The parameters “Curve
File Delimiter” and “Curve File Extension” can be modified in Preferences.
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In this step, once again, it is possible to export a video. If you added attachments in the previous
steps, it is now possible to export video with the available attachments.

Export Options

+ Export Models
¥ With Buttons

+ Export Printable Aligners

+ Open in RayWare

# Open in Alpha AI

v Open in Uniz Dental

¥ Activate Remote Monitoring For This Patient
# Order Aligners Now

+ Export Both Jaws

» Create Report

<( Export (78 remaining)

The generated models can be exported from the software in the form of STL models by pressing the
“Export” button. By selecting the "Open in Alpha Al" or "Open in RayWare" or "Open in Uniz Dental",
models can be exported to the respective external 3D printing software.

Note: To export the STL files, you must have a valid STL export license! To see the option "Open in
Alpha Al" or "Open in RayWare" or "Open in Uniz Dental" you must have those software programs
installed on your computer.

There is an option in the export step to export files to BioBigBox, where it is assigned as a new Patient
and Treatment. This information will be sent to the BlueSkyMonitoring service when the "Activate
Remote Monitoring For This Patient" is checked.

LabPronto (represented by the "Order Aligners Now" button) is a solution for sending the user's order
directly to the most capable provider to get the user's job done properly and quickly. LabPronto
analyzes the user's order, lab availability and the price the user will pay. Lab Pronto will then prioritize
the user's order to the specific lab that will create the order. Lab Pronto offers various ordering options,
allowing the user to order exactly and only what he needs. He can outsources the entire case,
manufacturing or planning.

"Export Both Jaws" exports both the maxilla and mandible into the selected folder.

For immediate and automatic STL license activation, purchase exports directly in the Blue Sky Plan
Software (File > Purchase STL Exports). You may also purchase STL case exports from https://
blueskybio.com/store/stl-case-export.

Finally, it is also possible to generate the so-called Tooth Movement Report with the angles and
displacements of the teeth moved from the original position to the final position. In addition, the report
shows the movements from each intermediate position to the next stage.
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https://blueskybio.com/store/stl-case-export
https://blueskybio.com/store/stl-case-export

Export Options

Export Models
</ Back to Design Aligners

</ Back to Add Buttons

<’ Back to Edit Steps

<’ Back to Moving Teeth
</ Back to Model Trimming
</ Back to Segmentation or This Patient
</ Back to Annotation

<-/ Back to Load Jaw

<< v Export (1046.74 remaining)

By clicking on the dropdown menu next to the "Back" button, it is possible to "fast jump" several steps
back.

25.14 Show Dimensions

"Show Dimensions" in the orthodontics module is a measuring tool. It shows bounding boxes that can be
used to analyze objects. This tool can be used in all steps during orthodontics.

To use this function, right-click on an object in the 3D scene and select "Show Dimensions" from the
context menu. The dimensions are hidden by clicking "Hide Dimensions" in the same context menu. In
Tools > Show Dimensions, it is possible to activate multiselection without having to click on "Show
Dimensions". Multiselection is turned off by clicking outside the object.

32490.42 mm?

Dimensions shown in the "Segmentation” step
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Dimensions shown on the tooth CT in the "Tooth Alignment" step

1720.74 mm?

L

Dimensions shown on the aligner in the "Export" step

25.15 Quick Instructions for Using the Computerised
Orthodontic Bracket System

More detailed instructions for use are available in Footnotes 31.2

The user during the export step should select the check boxes for “Export models” and “With Brackets”
and generate a model, including the bracket location indicators, in the form of an STL model.
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25.15.1 Printing the Model

The user should use a relevant 3D printer that prints at a resolution of at least 150 microns on the x/y
axis and 100microns on the z axis, to print the exported model in grey or tan model material. The
printer control software, printer and model material should be labelled for use together.

Select the exported STL model file in the printer control software for printing.

25.15.2 Adding Brackets

Use cement to firmly secure the desired brackets to the bracket location markers on the 3D printed
model.

25.15.3 Creating the Indirect Bonding Tray by Pressure Forming

The user creates the Indirect Bonding Tray by pressure thermoforming over the 3D printed model with
brackets attached to an outer carrying shell from a legally marketed orthodontic resin such as Essix
Ace. The user should then trim the shell to the middle of the brackets for easy release.

The brackets should then be placed into wells created in the shell. Skip to section 1.9 using the
indirect bonding tray to place the brackets.

25.15.4 Creating the Indirect Bonding Tray by Printing (this method should
only utilised in an FDA registered establishment)

The user should click “Create the indirect bonding tray”.

The user should check the print screen image of the tray for accuracy, and when it is correct export/
print the indirect bonding tray by choosing File>Export Data and selecting the indirect bonding tray to
be exported as an STL.

The user should use a relevant 3D printer that prints at a resolution of at least 150 microns on the x/y
axis and 100microns on the z axis, to print the exported model in grey or tan model material. The
printer control software, printer and model material should be labelled for use together. The material
should be a light cured resin which is not recycled or recyclable.

Select the indirect bonding tray STL file in the printer control software to be printed in the legally
marketed impression tray resin material called NextDent Ortho IBT.

Brackets should then be placed into wells created in the shell of the printed indirect bonding tray.

25.15.5 Using the Indirect Bonding Tray to Place the Brackets

The user should place the brackets onto the teeth by placing conventional cement onto the bracket
pads following the manufacturer’s instructions and seat the tray with the brackets into the patient’s
mouth. Excess cement should be removed, and a light cure should be used via the Indirect Bonding
Tray.

The outer carrying tray should be removed and the inner liner tray should be peeled off. Excess cured
cement should be removed.

25.15.6 Use of the Blue Sky Plan Calibration Verification STL file

The calibration of the printer should be done according to the printer manufacturer’s instructions and in
accordance with the quality system of the FDA registered establishment printing the trays. The
frequency of calibration should be determined by the printer manufacturer’s printer instructions and the
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establishment’s quality system. Blue Sky Bio provides a calibration verification file to confirm adequate
calibration. Calibration verification should be done whenever the printer is calibrated and any time the
printing material is changed.

Download the STL calibration verification file from the Blue Sky Bio website

* Import the STL calibration verification file into the printer control software

* Print the STL file

* Measure each cube in all 3 dimensions and the distances between adjacent cubes with a
calliper.

The size of each cube is printed on the cube.

The distance between cubes is 3mm.

The measurements of the cubes and open spaces should be within the certified accuracy of the
printer.

If the measurements fall outside that range, recalibrate the printer according to the printer
manufacturer’s instructions.

Precautions: Do not touch the bonding surfaces with your bare fingers as skin oils may diminish the
adhesion. Do not allow adhesive to get under the bracket in the guide slot. The position of each
bracket should be verified by the clinician and if necessary malpositioned brackets should be removed
and repositioned. Ceramic brackets may abrade the opposing arch. Wait to apply the ceramic brackets
until the bite has opened. If necessary, use metal brackets before the placement of ceramic brackets.
Provide the patient with instructions on how to conduct thorough oral hygiene, as tartar or food debris
may impair the function of the bracket. Do not apply excessive force when opening the bracket as the
bracket may bend or detach from the tooth. To prevent splintering when removing the brackets, use
the appropriate instrument. If patient experiences an allergic reaction, immediately remove the bracket
and advise patient to seek medical care.
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26 Denture module

Blue Sky Plan permits the user to model and export dentures. The functions are available in the
“‘Denture” panel once the user switches to the “Denture” module.

26.1 Loading the patient’s STL model

New planning starts by loading the STL jaw impression model using the main module selection
“‘Dentures > Import Models”. To start planning the denture, the user needs to switch to the “Denture”
module from “Model Master”. For more information, see chapter 3 "Blue Sky Launcher".

26.2 Adding virtual teeth

Virtual teeth can be added by clicking on the ﬂ icon in the toolbar. A dialog for selecting crown(s)
then opens. Clicking on a tooth selects it, and a text description of the crown appears below the
preview. Multiple teeth can be selected by holding down the Shift or Ctrl key. Another possibility is
clicking on Select All Maxillary Teeth/Select All Mandibular Teeth or Select All Teeth. It is also possible
to select from three sizes. Teeth are added as teeth chain. We confirm the selection by clicking the
“OK” button; the "Cancel" button closes the dialog without making a selection.

Teeth geometry set

Teeth Caps

Preview

anssdibbi
A EEEEREEN

Select the tooth. Press and hold the Shift or Ctrl key to select additional one.

Utilities Name

Select All Maxillary Teeth Left Maxillary Second Malar
Select All Mandibular Teeth

Select All Teeth

Virtual teeth are regular teeth sets, available in the Surgical Guide, Denture, and Crown and Bridge,
they are modifiable and exportable.
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The Denture Panel is used for denture modelling. After clicking on the “Denture Panel” tab, the below
menu will appear with buttons for working with the teeth chain.

Denture Panel
Mark Visible Teeth For Teeth Chain
Clear Teeth Chain
Show [ Hide Teeth Chain
Move Entire Teeth Chain

Manipulate Model

Denture

Ml esr 2020 1087 Upper_Model

Mandible 2 Maxilla

Create Denture

26.3 Mark visible teeth for teeth chain

L
]

Clicking on “Mark Visible Teeth for Teeth Chain”
and using the control allows for the manipulation of
the teeth chain. The teeth can also be moved
individually with the arrows to different sides.
Rotation is done by using the circles surrounding
the teeth chain. Each axis is represented by one
colour.

-2

¥
S

26.4 Clear Teeth Chain

Clears selected teeth chain.

26.5 Show / Hide teeth chain
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The button “Show / Hide Teeth Chain” is used for showing and hiding the green dot indicators in the
teeth chain. There is one indicator per tooth.

26.6 Move Entire Teeth Chain

“Move Entire Teeth Chain” permits the user to hide [HEEEEIE LY

teeth chains in the maxilla or the mandible by [ Hide maxilla teeth chain
selecting the appropriate option. ol — r

The scale is used to enlarge or diminish the teeth.

26.7 Manipulate model

The model can be unlocked by clicking the checkbox and the centre of rotation can be changed.
Tranzform
¥ Lodk model

Reset center of rotation

26.8 Create denture

A denture can be created in the menu in the right panel. This requires selecting a file, the correct jaw
orientation, and confirming by clicking “Create Denture”.

Denture

B EsP 2020 1087 Upper Model

Mandible = Maxilla

Create Denture
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26.9 Step 1 — Undercuts and insert direction

Step 1 is used to define the initial parameters for the denture.

The sliders can be used for setting the values for offset and undercut removal.

The insert direction should be adjusted using the rotation ring so that the undercuts
are minimised.

“Set insert direction from view” is used to set the insert direction according to the
current viewing angle setting.

“‘Reset insert direction” will restore the original status of the arrow and the model.

“Define posterior palatal seal” permits the
modelling of this structure. The Palatal Seal is
created by left clicking with the mouse on the two
required points with Shift key pressed.
Adjustments can be done by drawing with the
mouse.

The “Back” and “Next” buttons are used for moving one step back or forwards.
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26.10 Step 2 — Select denture base

Step 2 defines a contour around the teeth chain to define the borders of the denture. If a contour is not
defined, user is not able to get to another step.

The offset from the gingiva and thickness of the denture can be set by the sliders.

Gingiva extension allows the user to extend the gingiva with the slider. The thickness and smoothness
from the gingiva can be set with the sliders.

Pressing the Shift key and double clicking on the model around the teeth will add new points and
create a blue contour around the area representing the denture base:

The contour can be deleted by selecting “Clear
contour”.

26.11 Step 3 — Shape gingiva
Step 3 is used for adjusting the created gingiva.

Denture Panel

ﬂ Denture

(O Mandible
Shape gingiva (3/4)

Add/Remove
Smooth

Local deform

Show Teeth Chain

Move Entire Teeth Chain

Set To Default
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The following adjustments can be made within this step
Add/remove — addition/removal of gingiva material

Smooth — gingiva surface smoothing

Local deform — creation of ups and downs

Show Teeth Chain — display of the green dot indicators
Move Entire Teeth Chain — manipulation with the teeth chain

The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool.
The original values can be restored by selecting the “Set to Default” button.

26.12 Step 4 — Denture

Step 4 is used for finalizing the denture creation. During this step, virtual teeth penetrating through the
denture base are reduced while maintaining the minimum denture thickness.

Denture
Denture Panel

Denture

() mandible @ Madlla

Denture (4/4)

duction coping

teeth and create single STL file

<<

Sliders are used for selecting Teeth offset and Min denture thickness.

Tooth reduction coping generates a denture coping. Connect Teeth as single STL file makes the work
easier for the export.

The model design is completed by selecting the “Next” button.
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26.13 Export

The user can export the denture created in this step. Quality of the export can be set as well as swap
face orientation. Export separated files exports the selected objects to a separated file or one single
file created by the user. The “Create Surface” button allows the user to unite the selected models in
order to create one model. The user won’t be charged again when additional surfaces are exported
from the case.

Export Quality

O High

Export File Format

STL -

STL Surfaces

Color Selected
ywer_Model
BSP_2020_1087_Upper_Model

Maxillary_Undercut

Virtual Teeth

Tooth Name Selected
Right Maxillary Central Incisor No O
Left Maxillary Second Molar MNo O

Left Maxillary First Molar No O

[] Show only teeth with CAM file support [] Swap face orientation '+ Export separated files to a folder

Create Surface Export (119 remaining) Cancel

26.14 Teeth Surfaces panel

Teeth Surfaces lists the imported patient’s STL models, placed virtual teeth and their reduced versions,
and the newly generated denture base:

STL Surfaces

Lock Closeness Visible Color
[] BSP_2020_1087_Lower Model L] L] ~
] BSP_2020_1087_Upper_Model [] ~
] Right Maxillary Central Incisor ] ] b4
(] Left Maxillary Second Molar 1] L] 4
The table includes the following attributes:
“Lock” — surface locking controlled by a checkbox
“Name” — surface name
“Closeness” — surface closeness controlled by a checkbox
“Visible” — surface visibility or hiding by a checkbox
BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 187

BlueSkyBio



“Colour” — surface colour

R surface removal

Filters can be used to display either the maxilla or
the mandible only or selected object types:

26.15 Opening saved project

A saved case is opened with “File > Open Project...

[ Mandibular

[ Teeth and crowns M Models ¥ Dentures

[ Reduced teeth

” in the top left corner.

\) Blue Sky Plan - ONLY for testing!
& Edit Tools View Panels Module Help
B hew Project = | >=”=‘ (
B Open Project...
Recent Pro 4 -
& vrockrre '
! Save Project Ctrl+5 pentre
oject As...
tj Close Proje
cport Data...
&4 Purchase STL Exports...
* Print...
- Show Data Properties...

Ctri+X

== Denture

L
Order Parts ¥

Teeth Surfaces

STL Surfaces

Name

|BUEd BUnjuag

|

BSP_2020_1087_L...

K

BSP_2020_1087_....
Right Maxillary C...

Left Maxillary 5e...

5B0EJING L2 ] ‘

Left Maxillary Fir...

e |

[® Mandibular

[ Dentures

& Teeth and crowns B Models
[ Reduced teeth

[ Show implants

After clicking, the file to open is selected and the selection is confirmed with “OK”.
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Denture - Fin

Filters
[ Maxillary [ Mandibular

[ Teeth and crowns [# Models [ Dentures
[ Reduced teeth

[®] Show implants
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26.16 Screenshots

The Screenshot panel can be used for taking a screenshot with the ®¥ putton located in the top right
corner of the workspace.

After clicking the button, the “Save screenshot” message appears, and the screenshot is included in
the column in the right panel.

Screenshots

Screenshot size 125%

x Video

The arrows on the right are used for changing the screenshot size.

Screenshot size

Video allows the exporting of the screenshots as AVI video or animated gif with custom text and
selected font size and type.

L) Video - *

Custom text in video

Font size -

[® 1talic [] Bold (¥ Underline

Cancel
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27 Crown and Bridge module

Blue Sky Plan® allows the user to create a bridge and crowns and change the geometry of the virtual
teeth. These functions are available in the "Crown and Bridge" panel once the user switches to the
Crown and Bridge module.

27.1 Loading the patient’s STL model

The new planning starts by loading the STL jaw impression model using the main module selection
“Crown and Bridge > Conventional Crown | Crown for Titanium Base | Bridge”. To start planning the
crown and bridge, the user needs to switch to the “Crown and Bridge” module from “Model Master”.
For more information, see chapter 3 "Blue Sky Launcher".

27.2 Adding virtual teeth

Virtual teeth can be added by clicking on the n icon in the panel list “Virtual Teeth > Add Tooth”. A
dialog for selecting the crown(s) then opens. Clicking on a tooth selects it, and a text description of the
crown appears below the preview. Multiple teeth can be selected by holding down the Shift or Ctrl key.
Another possibility is clicking on Select All Maxillary Teeth/Select All Mandibular Teeth or Select All
Teeth. It is also possible to select from three sizes. Teeth are added as a teeth chain.

By clicking the “OK” button, the selection is confirmed; the “Cancel’ button closes the dialog without
making a selection.

\2) Add Mew Tooth m} bt

aBssdabAadsras
CwergiITITHYOODRE

Select the tooth. Press and hold the Shift or Ctrl key to select additional one.,

Utilities

£ Medium

Large Select all Teeth

Cancel
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Virtual teeth are regular teeth sets, available in the Surgical Guide, Crown and Bridge and Denture
module, are modifiable and exportable.

27.3 Restoration Design panel

The Restoration Design panel allows the user to choose the restoration type — crown on a tibase and
conventional crown. It is also possible to select the jaw type and antagonist model as well as to create
a bridge.

The antagonist model resolves and detects a teeth collision. If there is only one jaw available, the “no
antagonist” selection resolves this situation.

Select models:

I AECH30 - Left Maxillary First Molar

Antagonist: (optional)

The tibase can be chosen by clicking on the tooth or by clicking on the tibase dropdown. If a tibase is
not selected, the user cannot go further.

27.4 Restoration type selection — Crown on a Tibase

The Crown on a Tibase selection can be chosen in the menu in the right panel. This requires the
selection of a restoration type, jaw, model, crown, tibase, and antagonist model (optional) (if a user
uses maxilla and mandible) and confirming by clicking “Start”.

Note that it is mandatory to have a scanbody scan for "Crown on Tibase" restoration.

¥ T

Select model, crown and tibase and dick "Start”,
ation type and jaw
Restoration type: Crown on a Tibase
Mandible = Maxila

Select models:

Model: EsP_2020_10659_Lower_Model

Crown: Il L=ft Maxillary Firs
Tibase: I AE0H30 - Left Maxillary First Molar

Antagonist: (optional)

Step 1 — Undercuts
Step 1 is used to define the initial parameters for the crown.
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“Reset insert direction” restores the original setting of the insert direction.

The “Back” and “Next” buttons are used for moving one step back or forwards in the
design flow.

The slider can be used for setting the values for the undercut.
“Set insert direction from view” is used to set the insert direction according to the
current viewing angle in the 3D view.

Step 2 — Identify Interproximal Areas

Step 2 is used to select/colour the existing adjacent teeth so the crown can be resized by the software
to fit.

The interproximal area can be deleted by selecting “Clear Area”. Pressing the Shift key and holding
the left mouse button will define the interproximal area and create a brown contour around the
selection representing the crown and bridge base.

By pressing the Ctrl key and left clicking with the mouse, you can remove the selection. The “Tool size
slider is used for brush size selection.

Step 3 — Margin detection
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Step 3 detects the tooth margins used for crown creation. Pressing the Shift key and holding the left
mouse button allows the margin to be edited.

Crown and Bridge

Restoration Design Panel

¥ Tip:

tion type: Crown on a Tibase

nolar

y First Premolar

elow to create custom crown.

Custom crown (3/5)

Clear Margin

Praject Margin

Step 4 - Tibase editing

Step 4 is used for crown upgrading and the creation of a crown screw channel.
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“Crown margin” can be used for setting the crown margin.
“Titanium base margin” can be used for setting the base margin.
“Crown cement spacer” is an extra space for the glue between the crown and abutment.

The create crown screw button creates a hole going through the crown so that the user can access the
abutment screw and screw the abutment into the implant.

Step 5 — Crown editing
Step 5 is used for adjusting the created crown.

Crown and Bridge Restoration Design Panel

Follow steps below to create custom crown.

Adapt Occlusal Contacts (5/5)

-
—
5
=
=
=
%

Add/Remove

Smooth

Local Reshape

“Add/Remove” is used for the addition/removal of the crown material.
“Smooth” smooth the crown surface.
“Local reshape” Tool that deforms the tooth at a local point.

BS-LS-IFU-06-en Ver 7 Blue Sky Plan® 2025-05 195

BlueSkyBio



The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool.
The original values can be restored by clicking on the “Set to Default” button.

The relevant checkbox can be used for hiding "Adapt Interproximal Contacts" and "Cut Occlusal
Intersection™.

27.5 Restoration type selection — Conventional crown

Conventional crown selection can be chosen in the menu in the right panel. This requires selecting a
restoration type, jaw, model and confirming by clicking “Start”. The crown and antagonist models are
optional. If a user selects the (no crown) option, the crown is added in the third step.
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Select crown and model and click "Start".

Select restoration type and jaw

Restoration type: Conventional crown

Select jaw: = Mandible Maxilla
Select models:

Model: BSP_2019_1055_Lower_Model

Crown: (optional)

Antagonist: (optional)

Step 1 — Margin line definition

Step 1 is used to define a closed margin line along the remaining tooth structure. The user is able to
select between semi-automatic margin line detection and manual mode. To work with semi-automatic
detection, click on the “Two Point Margin Line Detection” radio button. Click 2 points (Shift + left click) ,
as shown in the picture below, to detect a curve. The curve should be detected automatically. It is
possible to move with points or add more points to more precise detection.

To work with the manual margin line, click on the “Manual Mode” radio button. Click the points (Shift +
left click) along the remaining tooth structure. Closed curve can be modified by holding Shift and left
mouse button.
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The margin can be deleted by selecting “Clear Area”. Undo and redo can be used as well for
modifications

Warning: A closed margin line has to be defined first to continue to next step!

Step 2 — Undercuts Step
Step 2 is used to define the initial parameters for the crown.

The slider can be used for setting the values for the undercut.

“Set insert direction from view” is used to set the insert direction according to the
current viewing angle in the 3D view.

“Reset insert direction” restores the original insert direction.

Step 3 — Identify Interproximal Areas

Step 3 is used to select/colour the existing adjacent teeth so the crown can be resized by the software
to fit.
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The approximal area can be deleted by selecting “Clear Area”. Pressing the Shift key and holding the
left mouse button will define the interproximal area and create a brown contour around the selection
representing the crown and bridge base. By pressing the Ctrl key and left clicking with the mouse, you
can remove the selection.

The “Tool size” slider is used for brush size selection.

Step 4 — Crown bottom editing
Step 4 is used for editing the crown bottom.

“Crown cement spacer” is an extra space for the glue between the crown and abutment.
“No cement gap” allows the user to edit the crown margin.

“Horizontal” defines the horizontal crown border width.

“Angled” defines the length of the angled part of the border.

“Angle” defines the angle of the angled part.

“Vertical” defines an additional vertical border.

“‘Minimal Thickness” is used to edit the minimal thickness.

The relevant checkbox can be used to hide the minimal thickness. If the user selected the (no crown)
option in the restoration panel, the “Add New Tooth” dialog is available to select the tooth by clicking
on the “Next” button. Only one tooth can be selected. The tooth is added by clicking on the “OK”
button. Cancel closes the “Add New Tooth” dialog.

Step 5 — Tooth placement and editing
Step 5 is used for tooth placement and tooth editing.
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Crown and Bridge

Restoration Design Panel

Tooth placement (5/6)

Transform
Add/Remove
Smooth

Local deform

Add/Remove

Tool size
Tool strength

Set To Default

“Transform” activates the widget for tooth placement.

“Add/Remove” is used for the addition/removal of the crown material.
“Smooth” smooths the crown surface.
“Local deform” allows the creation of ups and downs.

The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool.
The original values can be restored by clicking on the “Set to Default” button.

Step 6 — Crown editing
Step 6 is used for additional crown editing.
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Crown and Bridge

Restoration Design Panel

Adapt Occlusal Contacts (6/6)

¥ Cut Occlusal Inter
W Adapt Interproxin
Add/Remove

Smooth

Local Reshape

“Add/Remove” is used for the addition/removal of the crown material.
“Smooth” smooths the crown surface.
“Local Reshape” Tool that deforms the tooth at a local point.

The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool.
The original values can be restored by clicking on the “Set to Default” button.

The relevant checkbox can be used for hiding "Adapt Interproximal Contacts" and "Cut Occlusal
Intersection".

27.6 Create Bridge

The create bridge function is available in the Restoration Design Panel but only if you select Bridge
process flow in the Main screen. It allows the user to design a bridge for missing teeth. By clicking on
“Create Bridge”, the user starts a new process flow.

Step 1 — Unit Bridge

Step 1 is used for setting the points between the teeth to unit them. If the teeth are intersecting, the
blue points are not created.

Restoration Design Panel

toration type and jaw type.
Select restoration type and jaw

R : Crown on a Tibase

Unit bridge (1/4)

The blue points can be dragged along the teeth to set the bridge according to the user’s preferences.

Step 2 — Editing connections
The blue points allow the user to edit the connections between the crowns or teeth.
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Crown and Bridge Restoration Design Panel

¥ Tip:

pas

Choose restoration type and jaw type.
¥ Select restoration type and jaw

Restoration type: Crown on a Tibase

Select jaw: (@ Mandible ) Maxilla

Unit bridge (2/4)

£

Cancel

Step 3 — Bridge editing
Step 3 is used for editing the bridge.

Crown and Bridge Restoration Design Panel

oose restoration type and jaw type.
Select restoration type and jaw

Restoration type: Crown on a Tibase

(@ Mandible

Unit bridge (3/4)

Add/Remove
Smaoth
Local deform

Global deform

Tool strength

Set To Default

“‘Add/Remove" is used for the addition/removal of the material.
“Smooth” smooths the bridge surface.

“Local deform” allows the creation of ups and downs.

“Global deform” creates ups and downs on a global scale.

The “Tool size” slider can be used to change the brush tool dimension, and “Tool strength” defines the
strength of the tool. The original values can be restored by clicking on the “Set to Default” button.

If the teeth are overlapping, the union operation between teeth is being performed and the first two
steps are skipped.

Step 4 — Undercuts
Step 4 is used to define the initial parameters for the bridge.
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The slider can be used for setting the values for undercut.

“Set insert direction from view” is used to set the insert direction according to the
current viewing angle in the 3D view.

“‘Reset insert direction” restores the original insert direction.
Bridge creation is finalized by clicking on the “Next” button.

27.7 Teeth Surfaces panel

Teeth Surfaces lists the imported patient’s STL models, placed virtual teeth and their reduced versions,
and the newly generated crown base:

STL Surfaces

Lock Closeness Visible Color

[] BSP_2020_1069_Lower_Model ] X
[] BSP_2020_1069 Upper_Model O [l X
0 Left Maxillary First Molar O X

The table includes the following attributes:

“Lock” — surface locking controlled with a checkbox.

“‘Name” — surface name.

“Closeness” — surface closeness controlled with a checkbox.
“Visible” — surface visibility or hiding with a checkbox.
“Colour” — surface colour.

* _ surface removal.
Filters can be used to display either the maxilla or the mandible only, or selected object types:

Filters
[ Maxillary [ Mandibular

[ Teeth and crowns [ Models [ Dentures
¥ Reduced teeth

X show implants

27.8 Teeth Edit panel

The Teeth Edit panel allows the user to edit the shape of a tooth by using different editing tools:
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active model I Left Maxillary First Molar
Editing tools

Manipulate Model

Manipulate Visible Teeth

Smooth

Add/Remove Material

etry Transform

Boolean operations

Transform

Reset center of rotation

“Manipulate Model” allows the user to change the position of the tooth.

“Smooth” smooths the tooth surface.

“Global Geometry Transform” creates ups and downs on a global scale.
“Add/Remove” is used for the addition/removal of the material.

“Local Geometry Transform” creates ups and downs on a local scale.

“‘Relax Mesh” is similar to smoothing while it respects sharp edges to some degree.

The “Tool size” slider can be used to change the brush tool size. The original values can be restored
by clicking on the “Set to Default” button.

Boolean operations allow the user to join and subtract 3D models.
Boolean operations
Boolean operation Union i
between . Left Maxillary First Molar
and %

Wlese_ 2020 1089 Lower Mode =

with offset of m ~ mm

Clear

27.9 Parts panel

The Parts Panel lists the imported patient’s drill kit and guide type and quantity of each part, which can
be added to the shopping cart.
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Parts Panel

Quantity

<

Implant IDH3010

&

Implant IDH3011 i E
Implant I0N4110 i E
Metal Cylinder TUBE44-272 2 E
Metal Cylinder Tube368 (pack of 5 pcs) i E
Drill DRILLD26L i E
Drill DRILLD26S i E
Drill DRILLT355 i E
Abutment ABDH30 2 E
Abutment AODA1565A i E
Drill Shaft CDRD32L i E
Drill Shaft CDRD325 i E
Drill Shaft CDRT355 i E

KR A A AR AR R R

The user is taken to the Blue Sky Plan official webpage after clicking on the “Add Parts to Cart” button.
The original values of the quantity of parts can be restored by clicking on “Clear user Adjustments”.

27.10 Screenshots panel

The Screenshot panel can be used for taking a screenshot with the button EI located in the top right
corner of the workspace. After clicking the button, the “Save screenshot” message appears, and the
screenshot is included in the column in the right panel.

Screenshot size

& Video

The arrows on the right are used for changing the screenshot size.

Video allows the screenshots to be exported as an AVI video or animated gif with custom text and
selected font size and type.
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Custom text in video

Font size -

[ 1talic [ Bold [ Underline

27.11 CAM Export

In addition to the normal export of models, the software allows you to create a CAM export.

In order to export, you need to create at least one crown or one bridge. Once you complete this step,
you can choose which models you want to export in the CAM column (1) inside of the export dialog.

If the model is not CAM exportable the value will be “N/A” (2), otherwise there will be a checkbox for
selection (3).

If you only want to see the models which can be CAM exported, use the button on the bottom left
called “Show only teeth with CAM file support” (4).

Export Quality
O Standard O High @ Very High
Export File Format

STL Surfaces

Name Color Selected
rer_Model

BSP_2019_1055_Upper_Model

Virtual Teeth

Tooth Name Selected
Right Mandibular First Molar N v

D - Mandibular Custom Crown Yes v

o

[[] Show only teeth with CAM file support [[] Swap face orientation | Export separated files to a folder Cost: 0

Create Surface Export (119 remaining) Cancel

The final product of the CAM export is a file called < name > .constructioninfo where all the
information about the model are stored.
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27.12 Crown and Bridge Preferences

General )
nization Crown and Bridge

Crown on a Tibase

Cron cement Spacer: 0,10 mm

Conventional crown

Crown cement spacer: 0,10 mm

CAD tools

Teeth chain spacing: 0,00

Restore Defaults oK Cancel

In “Preferences > Crown and Bridge” the user can set the Crown cement spacer for different types of
restoration available in the Restoration Design panel. CAD tools are available for the Denture module.
The “Default tool size” is used for selecting the default tool size, and “Default tool strength” defines the
default strength of the tool. “Teeth chain spacing” allows the user to set the spacing between the teeth
in the teeth chain.
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28 Splint Module

Dental splints are the most common dental treatment for temporomandibular disorders (TMDs -
tension in your jaw muscles, such as from clenching your jaw or grinding your teeth). These splints are
used for short periods of time. They do not cause permanent changes in the teeth or jaw. They include
bite plates and mouth guards that fit between and over the upper and lower teeth.

Dental splints can help ease muscle tension and stabilize the jaw. They do this by preventing grinding
and clenching of the jaw (bruxism) that might be causing muscle tension and pain. It is an important
treatment that may last for 3 months or more. The splints are also used for muscle syndromes, a new
VDO muscle test, mandibular lateral displacement and anterior repositioning.

Blue Sky Plan makes it possible to plan splint treatments based on imported STL models of the jaw
with teeth. The planning begins with an intro screen titled Splint, where the user selects the type of
planning — Incisal Splint (AMPSA) or Occlusal Bite Splint.

Incisal Splint
(AMPSA)

SPLINT

Occlusal Bite
Splint

\
__ gy} .

The specific type of planning can’t be changed in an upcoming process.

The individual types of planning include:

* Incisal Splint (AMPSA) -> Align to Grid - Buccal Bite Registration - Jaw Articulation -
Remove Undercuts - Add Anterior Deprogrammers - Draw Splint Curve - Set Raised Areas
- Edit Splint Module - Export

* Occlusal Bite Splint (Michigan-style splint) -> Align to Grid - Buccal Bite Registration -
Jaw Articulation - Remove Undercuts - Draw Splint Curve - Set Raised Areas - Edit Splint
Model - Export
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28.1 Loading the patient’s STL model

To start planning the splint, the user needs to select type of splint “Incisal Splint” or “Occlusal Bite
Splint”. For more information, see chapter 3 "Blue Sky Launcher" (available in PDF version of the
manual).

28.2 Align to Grid

The imported models might not be properly aligned (the alignment does not match the head in the
bottom left of the 3D view). This makes planning very difficult. For these cases, Blue Sky Plan has a
Model Alignment step.

For alignment, it is necessary to select the primary model through which the alignment is to be done.

To align the model to the grid, press the SHIFT key and add 3 points on the model by left clicking the
mouse to align the jaw to the grid. Then fine-tune alignment with the manipulation widget.

Alignment The Checkbox Move All Models Together can be used in
situations, when the user wants to fine-tune each model
separately. To change the model orientation, click on the Swap
Orientation

n 3 Points Alignment: (1 [/ 3)

B
o

¥ Advanced

This checkbox can be used for finetuning each
madel separately.

+ Move All Models Together
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28.3 Buccal Bite Registration

Buccal Bite Registration
Check loaded buccal bite alignment.
Buccal Bite(s) Positions

Positions:

Mowve Mandible to Position

Animate Mandible to Position

Save Current Alignment of Mandible
Use Computed Alignment of Mandible

Animation Speed

Advanced

Add Buccal Bite Positions
Buccal Bite Name:

* Bite
Select Buccal Bite Scan:

BSP_2017_1030_model_bite2

|
[] Dual Buccal Bite Scan (left and right)

=}= Add Buccal Bite Position

BS-LS-IFU-06-en Ver 7

BlueSkyBio
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The buccal bite registration process requires both jaw
models to be imported.

The positions table displays a list of the jaw positions that
were aligned with the buccal bite models. Bite name
displays the aligned buccal bites and can be renamed by
double clicking on the bite name. Buccal bites can be
deleted by clicking on the x button.

Move Mandible to Position - Instantly moves the mandible
to the position chosen from the table.

Animate Mandible to Position: Animates the mandible
from the actual position to the position chosen from the
table.

Stop Animation: Stops the motion animation.

Save Current Alignment of Mandible: Sets the actual
position as a starting position for the position chosen from
the table.

Use Computed Alignment of Mandible: Sets the actual
position for the position chosen in the table as calculated
using the buccal bites models.

Animation Speed slider: Sets the speed of animation.

In the advanced section, the user can work only with buccal
bites that do not have a position yet (if it was deleted
before). To add a buccal bite name, click on the Buccal Bite
Name dropdown and select a name. To rename the bite
name, click onto the Bite section and rename it. By clicking
on the Add Buccal Bite Position, the user adds a new bite
position that can be seen in the Positions table.
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28.4 Jaw Articulation

The lower jaw articulation can be visualized by adding a jaw articulator. This function is not dependent
on an import of the buccal bite. Collisions between the upper and the lower jaw can be shown in all
positions.

Place Jaw Articulator on mandible by left clicking on the occlusal edge between the mandibular central
incisors to place the jaw articulator.

Articulator Placement To add jaw articulator, click on the Place Jaw Articulator button.
The Remove Articulator button removes the articulator from the
software. The mandible opening slider sets the distance/offset
between the jaws. The articulator parameters can be adjusted in
the Advanced section. Reset to Defaults resets the parameters
to defaults positions.

[‘_’[ Place Jaw Articulator
X
Articulator Opening
Mandible Opening

&> open

Advanced

You can setup advanced Articulator parameters

Edit Articulator Parameters

Arms Lenath 105,0.mm

@ Reset to Defaults

28.5 Remove Undercuts

Remove Undercuts is used to define the direction from which the splint will be inserted. Using this
function, you can visualize the areas that run “under” the model (undercuts) and may cause problems
when inserting the splint onto the teeth, especially in the case of using stiff materials for fabrication.
The splint guide fabricated on this model will be easy to mount.
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Articulator visualization shows the user how much the mandible jaw has opened. The distance is
shown in the label.

Remove Undercuts
Select a splint model insertion direction by dragging
the widget in the 3D scene or set the insertion

direction from the current camera view. The red
areas will be filled for smooth insertion.

Splint Insertion Path

Define Insertion Direction
Define Insertion Direction From View

Reset Insertion Direction

¥ Advanced

You can set more parameters here.

Undercut Settings

Maximal Allowed Undercut 0,00 mm

How to work with insert direction:

o Select the model to work with
o Click on Define Insertion Direction

o The insertion direction should be adjusted using the rotation ring so that the
undercuts are minimized

o The insert direction can also be defined by clicking on Define Insertion
Direction from View

o —
g

> Reset Insertion Direction will restore the original status of the arrow
o The Maximal Allowed Undercutallows the user to set the values for the undercut.
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If the insertion direction is set
incorrectly; arrow turns red, the user
will receive the message Insertion
Direction is Invalid and cannot
proceed further. It is necessary to set
the correct direction in order to
proceed.

28.6 Add Anterior Deprogrammers

The Anterior Deprogrammer is a flat plane occlusal splint with an anterior acrylic block designed to
disclude the posterior teeth. Since the body has a protective reflex to prevent added pressure to the
anterior teeth, when this splint is worn, less pressure is exerted. Blue Sky Plan anterior
deprogrammers are represented by STL shapes that the user can manipulate.
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Note that length parameters always measure the "perpendicular" distance. For example, the anterior
and posterior length only measure the distance along the Y-axis (green in the application), as is shown
in the picture, even though the 3D dragger is visualized to be hugging the side of the deprogrammer. S
is the center point of the support (the plane on top of the deprogrammer). The guidance angle is the
angle between the sideway parallel projection of the original position of the posterior vertex B, the
center of support S and the current position of the posterior vertex B. Note that changing this
parameter affects all parts of the deprogrammer except the support itself.

Anterior Deprogrammer To add a deprogrammer, click on the Add Anterior
You can Add the Anterior Deprogrammer to the Splint Deprogrammer button. The user. IS. able to choos.e the anterlpr
and set its position and parameters. Single click on deprogrammer shape from an existing list and adjust its location
Ehf e and manipulate its measurements. Remove Anterior
raggers, double click switches to the usual .
manipulation widget. Deprogrammer the button removes the anterior deprogrammer.

Anterior Deprogrammer

-

Remove Anterior Deprogrammer

Parameters

Guidance Angle o
Anterior Length e
Posterior Lengthe
Anterior Width €)
Posterior Width &)
Thickness '@'
Support Height o
Support Width e

Presets

To create a new preset that allows you to save the current parameters of the deprogrammer, click on
the Save button. A new dialog window appears with the Enter preset name option. Save your preset
and see it in your presets
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Parameters Parameters

Guidance Angle 26,4° Guidance Angle 26,4°

or Length 7,1 mm Anterior Length 7,1 mm

Length 8,9 mm Enter preset name: Fo r Length 8,9 mm

Anterior Width 8,0 mm Anterior Width 8,0 mm
13,3 mm ost il 13,3 mm

’ Cancel i
4,6 mm a { 4,6 mm
Support Height 4,9 mm Support Height 4,9 mm
Support Width 7,2 mm Support Width 7,2 mm

Presets = Presets

To show more options, click on the ... option. Here you can delete your presets as well as export/
import presets.

Parameters

Guidance Angle 26,4°

Anterior Length 7.1 mm
Posterior Length 8,9 mm
Anterior Width 8,0 mm
Posterior Width 13,3 mm
Thickness 4.6 mm
Support Height 4,9 mm
Support Width 7,2 mm

Presets Freset ¥ Ij R

(% Export preset
®) Import preset
Delete preset

28.7 Draw Splint Curve

Press and hold Shift and add a curve point on the selected model by clicking the left mouse button.
You can also hold Shift and press the left mouse button and drag the mouse over the surface of the
model. The shape of the curve can be edited using individual control points on it. Before actually
generating a splint guide, it is a good idea to check its shape in this mode. If needed, you can delete
the curve by clicking the Clear curve button and start by drawing the curve again.
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the m

Splint Curve

< Draw Curve

&

Selection and Manipulation | Draw strokes | Selection and Manipulation

28.8 Set Raised Areas

Raise to Antagonist Cusp Tips o Raise to Plane a Raise by Ramp e Offset by Minimal Thickness e

Splint Minimal Thickness | 1,50 mm Splint Minimal Thickness | 1,50 mm Splint Minimal Thickness 1,50 mm Splint Minimal Thickness 1,50 mm

0,00 mm Splint Offset From the Jaw 0,00 mm Splint Offset From the Jaw 0,00 mm Splint Offset From the Jaw 0,00 mm

0,10 mm Rasat Plane Ramp angle 15,0°

Reset Plane

The Raise to Antagonist Cusp Tips (1) method aims to extend the region bounded by the curve to
the antagonist jaw. The Follow cusp tips radius determines the virtual inflation of the antagonist cusp
tips, that will be used for creating the resulting splint shape. A higher value will result in a flatter
occlusal part of the splint, while lower values will result in a sharper indentation in the occlusal part of
the splint. This value can be set by clicking on the slider.

Raise to Plane (2) raises the region bounded by the curve to the visualized plane.

Raise by Ramp (3) raises the region bounded by the curve to the visualized plane with the possibility
to set the angle of the ramp.

Offset by Minimal Thickness (4) this method inflates the region bounded by the curve by the minimal
thickness value. The offset and minimal thickness of the splint can be set by the sliders in the General
Splint Settings section.

The offset and minimal thickness of the splint can be set by the sliders in the Workflow Settings in
the Annotation step or in each Set Raised Area method.

To create a splint preview, choose the preferred Raise Area Method.
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5]

[ Keep both parts ~ Invert Plane Reset Plane

Cut by Plane

The Density slider defines mesh smoothness when applying a brush, if the Adaptive Refinement is
on.

Blue Sky Plan software allows the user to edit the models. Click on the brush icon to select the
functionality to eliminate problem areas. The Add/Remove Brush (2) is used for adding/removing the
surface material. The Local Deform Brush (3) deforms the surface at a local point. The Smoothing
Brush (1) can be used for final modifications and polishing the surface. Resolve Collisions (4)
automatically tries to brush off current collisions. The Offset slider sets the offset for the selected

models.
Use Adaptive Refinement enables better, smoother mesh creation when using the brush.

Plane Cut (5) allows the user to cut a model by a cutting plane. The plane can be moved and rotated
and the cutting direction can be inverted. The plane can be reset to the default horizontal position.
Both parts of the cut model can be retained (a new Plane Cut remainder model will be created).

Everything below the plane cut will be removed
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Everything above the plane cut will be removed

28.10 Export and Upload to BioBigBox

The final step, Export, is common for all types of planning. The only difference is in what can be
exported in this final step, OBJ or STL models (3). Export as Separated Files (4) exports each
selected object to a separate file. Otherwise, objects are exported as a single file. The user can
choose which model will be exported (1) and also check the Export Cost of the models as well as the
credits available on their license (2). After selection, the models will be exported by clicking on the
Export button (5). Both project (6) and selected models (7) can be uploaded to the BioBigBox
treatment folder.

Export (9/9)

Select models and set parameters for export.

Export Selection

Name
BSP_2017_1030_model_bite
BSP_2017_1030_model_bite2
BSP_2017_1030_model_lower
BSP_2017_1030_model_upper

Splint

Export Cost: e 0.5
Available Credit: 1044.74

Export Parameters

Format OEJ e v
Export as Separate Files o

o H Export
e Upload Project
o Upload Models
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28.11 Keyboard Shortcuts

The user is able to select between 2 views - perspective and orthographic. To select between those
2 views, double click on the head orientation widget or number 5. It is possible to use keyboard
shortcuts 1, 3 and 7 or Alt 1, 3 and 7 to switch between views.

Keyboard shortcuts 4, 6, 2 and 8 moves the camera 15°.

28.12 Manipulation Shortcuts

Shortcuts allow the user to manipulate the visible models in the 3D view.

Manipulation shortcuts

Hold R + LMB Rotate
Hold T + LMB Translate
H Hide Dragger

R + Left mouse button rotates the model, T + Left mouse button moves the model and H hides
the dragger.

28.13 Visibility Panel

Visibility panel allows the user to work with 3D objects to set:
- visibility
- opacity O
- renaming
- deleting
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- changing the color
- collisions

To rename a model, click on the Rename button (1), write a new name (2) and click on the check or X
button (3) to confirm.

Step related toggles " Step related toggles \ Step related toggles

Grid Grid
Collisions Collisions
Models . " Models .
BSP_2017_1030_model_bite2 @ =+ BSP_2017_1030_model_bite2 ses BSP_2017_1030_model_bite2
BSP_2017_1030_model_lower @ =+ BSP_2017_1030_model_lower BSP_2017_1030_model_lower

BSP_2017_1030_model_bite ot BSP_2017_1030_model_bite o BSP_2017_1030_model_bite
BSP_2017_1030_model_upper @@ *** a BSP_2017_1030_model_upper “es BSP_2017_1030_model_upper
Splint @ o m b= x s el 9 Splint_new
Model Previews @ = Model Previews @ "

Minimal thickness model previ...

Y0000 6 6\ N

Model Previews

Minimal thickness model previ... Minimal thickness model previ...

Step related toggles
Grid ]
Collisions &
Models ® =
BSP 2017 _1030_model bite2 &
BSP 2017 _1030_model_lower &7
BSP_ 2017 1030_model_bite -
BSP_2017_1030_model_upper @& |7_|/ ):(

Splint 7] Toggle collisions

Model Previews @ =

Minimal thickness model previ...

Collisions

To change the model’s color, select the color of the model (1) and choose any color from the "Basic
colors" set (2) then click on the OK button (3).

Step related toggles

Grid

Collisions

Models .

= [

Fick Screen Color

|| BSP_2017_1030_model_bite2

BSP_2017_1030_model_lower

L_o BSP_2017_1030_model_bite

| ] BSP_2017_1030_model_upper

] splint

Model Previews

Custom colors

Add to Custom Colars

RORRR VRN

S
R

Minimal thickness model previ...
Cancel

Changing the color
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The grid scale indicator is shown in the upper right corner and can be toggled in the Visibility panel.
The patient’s name can be hidden/shown by clicking the icon shown in the picture.

® 6' Test Name (@) ev
5 mmiEEH @) 5 mmiE] @

28.14 Editing Mode

The user is able to jump from Wizard to Editing Mode by right
clicking the mouse -> Editing Mode or by clicking the icon in
the side panel. Editing Mode is not available in the Splint
Curve, Set Raised Areas and Edit Splint Model steps.

[ o)
~ T

&3 Editing Mode

Choose one of the supported editing functions from the toolbar on the left Editing mode

(1) ‘: Leave Editing Mode e
To leave the mode, click on the Leave Editing Mode (2) button. ]
1

Editing mode is Active

Please choose one from the
supported editing mode functions
above.

28.15 Edit Model

see section 28.10
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28.16 Notes and Measurements

Incisal Splint Design (9/9) Notes and Measurements °

149 mm  Distance
712°

Enter text Note

4 Measure Distance
£33 Measure Angle
B Add Note

Removal

Clear Measurements

Clear Notes

Select the Measure Distance button to make any 3D measurements. Click the left mouse button with
the pointer on the model to mark the start point of the distance to be measured and click again on the
model to mark the end point of the measured distance. To correct the measurement you can grab one of
the end points and move them.

Select the Measure Angle button to measure angles. Click the left mouse button with the pointer on
the model and repeat the process twice to get an angle. To correct the measurement you can grab the
points specifying the angle.

Select the Add Note button to add a note on the model. Hold Shift and left click to place the text note.
By default, Enter text appears, but the user can edit it by double clicking.

The text of an overlay can be changed by clicking on the Note field. The color of several types of items
can also be changed in the panel by clicking on the Color field. To remove the measurements, click
on B the button in the Note field or by clicking the Clear Measurements or Clear Notes buttons.
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28.17 Create a screenshot

Incisal Splint Design (9/9) Screenshots

w >>
r... Edit Splint Mo... Export m
0

&S Take Screenshot
Screenshot Export

Format PNG

[ Export to a New Folder

The Screenshot panel can be used for taking a screenshot with the button located in the top right
corner of the toolbar. Screenshots are taken by clicking on the Take Screenshot button. The user can
export screenshots in the corresponding format (PNG or JPG). Screenshots can be deleted using the
right mouse button to select Remove. Clicking the Export button exports the selected screenshots.

28.18 Jaw Movement

See section 28.4

28.19 Show dimensions

In the splint module, it is possible to turn on the dimensions for 3D objects. Right-click on the model
and select Toggle Dimensions from the context menu. The dimensions are hidden by clicking Toggle
Dimensions again.
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29 Preferences

Blue Sky Plan® makes it possible to save user settings for the program and its environment. You mark
the settings selection with the "Tools > Preferences..." menu option.

5} Preferences e

General

Language English

Interface Dark

Background Colo

Appearance

[ Implant
O

wing mode

Cancel

29.1 General

» Big icons — sets the size of the icons in the tool bars

» Hide window titles — sets the visibility of the titles of windows with visualization data

» Show implant to axial slice angle — displays the value of the implant to axial slice angle

» Synchronize cross-sections zoom — if this option is turned on, moving and changing the ruler in
any cross-section of the slice also changes the ruler in the other cross-sections of the slice

» Always show selected implant/tooth — ensures visibility of the active implant when implants/teeth
are fully transparent

* Move slices to selected implant's position — clicking on the implant sets the positions of the
orthogonal and normal slices on the selected implants
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» Maximum intensity projection slice mode — this button for switching the slice display mode offers
two variants: MIP (maximum intensity projection) and X-ray.

 Start panoramic view in RTG mode — in panoramic window, opened data are viewed in RTG
(=composite) mode

» Force tabbed docking — disables the option to cascade panels above each other

+ Start model alignment dialog on model import — the process of model alignment will
automatically perform, when the model is imported

* Use point based model alignment in Wizard — manual adjustment using matching points and
volume in Wizard

+ Implant always vertical in tangential view — any rotation of the implant displays the implant
vertically in a tangential window

» Swap face orientation in exported models — the exported models have swapped face orientation
of the mesh

» Advanced gestures in Leap viewing mode — enables advanced scene manipulation gestures in
Leap viewing mode. A Leap controller is required.

« Zoom with circle gestures — toggle the effect of the circle gesture between slider control and
zoom control.

29.2 Customization

» Dragger delay — the time until the dragger disappears after the mouse cursor moves away from
the implant or tooth

* Model Import Quality — sets the quality of imported model

» Export File Format — enables to choose the default export file format

* Model Collisions Mode — enables to switch between different views of model collisions

+ Video Image Delay — when exporting steps plan within Ortodontics module, it is time interval
between individual images of the exported video

» Grid 3D (color, size, spacing, thickness) — the properties of 3D grid in the scene

* Axis — the thickness of implant/scanbody axis

29.3 Project

» Autosave project — automatically saves the project at the time interval entered

29.4 Shortcuts

In these sections shortcuts are defined for many different actions.

» Users can add or change the shortcut by clicking onto the window "Keyboard Shortcut" and
pushing the keyboard or combinations of keyboards. To confirm the newly defined shortcut it is
necessary to click the button "Set".

29.5 Advanced

» Logging — allows information about the execution of the program to be stored in a log. The log
can be displayed by clicking the "Show Log" button, and its content can make it easier for the
program manufacturer to solve problems that arise when running the program on specific
hardware configurations.
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* Log OpenGL errors — enables to log OpenGL errors

» Web Engine Settings — choose how much the default web browser uses GPU acceleration

» Module for shell open — enables to choose the default module used to open the data on double
click in shell

» Automatically check for updates — every day when it first starts up, the application checks
whether you are using the newest release and, if not, offers to install the update for you.

» Show Blue Sky Bio hints and messages — displays the bar containing hints and messages

* Open videos in external browser — allows to open tutorial videos in external browser

* Use system proxy — enables the proxy servers set in the system to be used

» Antialiasing — enables the edge smoothing of the models

» Enable LabPronto service — displays the LabPronto service

» Show warning when recommended Software Guide Tube settings changed — displays the
warning message if the parameters of Software Guide Tube are changed

« Show warning for collisions between Software Guide Tubes and model — displays the warning
message if Software Guide Tube collides with the model

* Run nerve detection in Surgical Guide automatically — the automatic nerve detection is done for
both foramens in Wizard

29.6 Surgical Guide

In this section, the different parts of the surgical guide can be adjusted.

» Software Guide Tube — Distance (ie. distance from implant abutment) and Wall Thickness

+ Surgical Guide — Offset (ie. distance between model and surgical guide)

* Windows in Surgical Guide — Width, Height and Depth

* Metal Cylinders — Lip Height and Lip Width (for custom Metal Cylinders)

* GRS Guide (available in “File > Export to > GRS Guide”) — Hole Diameter

+ Generated Model — adjusts Base Height, if using the Close or Hollow Model function

* Articulation Pin Arms — Width and Height (see chapter 19)

+ Implant to tooth (occlusal side) — when aligning a tooth to implant, Distance can be adjusted
* Undercut — Insertion Path Direction and Maxium Allowed Undercut (see chapter 16)

* Endo mode — see chapter 17

29.7 BSB Direct Cut Drills

These settings apply for BSB Direct Cut Surgical Guide Solution only.

29.8 Orthodontics and Tooth Movement Limits

See chapter 22.

29.9 Crown and Bridge

See chapter 24.
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30 Automatic updates

Blue Sky Plan® supports the option of automatically checking the availability of a newer version of the
program. It does this once a day when it first starts up; this can be turned off in the program settings
dialog in the “Advanced” tab with Automatically check for updates. This feature can be invoked
manually with the menu selection “Help > Check For Updates...”

- Blue Sky Plan - New version El@

New version brings new features and bugfixes!

Remind me later Download Skip this version

If a new version is available, the program offers the user the options of postponing the update till later,
downloading and installing the update immediately, or skipping this update completely. The update
download runs directly in the application environment, and to install it, Blue Sky Plan® must shut down
and then start the installation, so please close open projects before checking for a new version and
installing the update.
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: ) Blue Slq.r'P.'!an - New version EI@

New version brings new features and bugfixes!

A VARIETY OF DRILL STOPS
AVAILABLE FOR GUIDED AND
NON-GUIDED SURGICAL CASES

NOW AVAILABLE

' CLICK FOR MORE INFORMATION

\L) BlueSkyBio.com
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31 Footnotes

31.1 Blue Sky Bio Aligners Prescribed Instruction For Use
Caution: US federal law restricts this product for sale by or on the order of a dentist or physician.

Indication for Use

Blue Sky Bio Aligners are a series of clear, lightweight, plastic appliances indicated for the treatment of
tooth malocclusions in patients with permanent dentition (i.e., all second molars). Utilising a series of
incremental tooth movements, it sequentially positions the teeth by way of continuous gentle force.

Device Description

Blue Sky Bio Aligners are a series of clear plastic aligners that offer a solution for aesthetic orthodontic
treatment by utilising a set of removable aligners to correct tooth malocclusions. A dental health
professional (e.g. orthodontist or dentist), using a standard personal computer, prescribes the Blue
Sky Bio Aligners based on an assessment of the patient’s teeth, determines the course of treatment
with the system, takes moulds of the patient’s teeth and then imports a digital version of the mould (or
model) into the ordering software, then in the ordering software aligns the teeth as they want them at
different phases of treatment. The phase models are exported from the ordering software and sent to
Blue Sky Bio. Blue Sky Bio then prints a series of plastic trays intended to gradually realign the
patient’s teeth in accordance with the physician’s prescription in the ordering software. The prescribing
physician creates the models used to print the aligners. Blue Sky Bio produces trays which are formed
of clear, thermoformed plastic. The trays are sent back to the dental health professional who then
provides them to the patient, confirming their fit and design. Over a period of time, additional trays are
provided sequentially to the patient by the dental health professional to gradually move the target teeth
to the designed position. The dental health professional monitors the treatment from the moment the
first aligner is delivered to when the final aligner is delivered. The trays are held in place by pressure
and can be removed by the patient at any time.

Storage and Handling

Store the devices in a dry, clean and dust-free environment in the original packaging at modest
temperatures (5°C to 40°C / 41°F to 104°F).

Contents of the Box

The box contains the aligners for the patient identified by the stickers on the plastic bags containing
the aligners. These were made from the models you sent to Blue Sky Bio. If at any office visit the
aligner fits incorrectly, scan the patient, go through the construction/ordering process again and send
Blue Sky Bio a new model for aligner re-fabrication.

The aligners are delivered clean but NON-STERILE in a plastic bag. The plastic bag has a sticker on it
which identifies the patient and which number of aligner is in the bag. The patient should be instructed
to clean the aligner with toothpaste and a toothbrush each day. The teeth should be brushed before
inserting the aligner.
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31.2 Computerised Orthodontic Bracket System
Instructions for Use

Caution: US federal law restricts this product for sale by or on the order of a dentist or physician.

Indication for Use

The Blue Sky Bio Computerised Orthodontic Bracket System is a software system intended for use as
an aid in orthodontic treatment planning to correct malocclusions in orthodontic patients. For use by
dental professionals trained in orthodontic treatment, including radiographic analyses and treatment
planning. The Blue Sky Bio Computerised Orthodontic Bracket System is intended for use with
commercially available brackets currently used in standard orthodontic treatment. The end product is
an indirect bonding tray for use by the dental professional to place multiple brackets at the same time.
The additive printing of the indirect bonding trays should only occur at a validated printing centre. Each
validated printing centre is to be a registered and listed contract manufacturer with Blue Sky Bio, as
documented to the FDA per the Device Establishment Registration and Listing (see CFR Part 807).

Device Description

The device consists of proprietary software that allows the placement of virtual orthodontic brackets on
3D models supplied by the clinician. The physical models are scanned and converted into virtual
models in the software. An indirect bonding tray made out of resin is produced. The physical
orthodontic brackets are inserted into the indirect bonding tray. The tray aids in the accurate bonding
of the brackets, duplicating the position of the virtual brackets in the planning software. The tray is
produced using two alternative methods.

One method utilises the virtual model of the patient model with virtual brackets. The indirect bonding
tray is designed and printed as a negative of the virtual model with the brackets in place. The printing
of the indirect bonding tray should only occur in an FDA registered establishment.

The second method utilises a printed patient model with markers indicating the position of the
brackets. The brackets are glued to the model on the marked areas and the indirect bonding tray is
pressure thermoformed over the model capturing the brackets.

Both methods result in a resin indirect bonding tray with brackets attached to the tray according to the
bracket position planned in the software. The clinician inserts the tray with the brackets on the patient’s
dentition, allowing the accurate positioning and bonding of the brackets. Commercially available
brackets are used as part of the system but are not part of the submission.

The software is available for download on the Blue Sky Bio website and it is used by Blue Sky Bio and
authorised users. The download includes the instruction manual, which can also be downloaded
separately on the Blue Sky Bio website. The software requires activation for authorised users.

31.2.1 User Identification

The clinician creates the patient models to be scanned into the software. The clinician either creates or
reviews and approves the virtual orthodontic treatment plan, including the bracket positions. The
software is intended to be used by Blue Sky Bio and authorised entities manufacturing the indirect
bonding tray based on the clinician-approved positioning of the brackets.

How to use the Computerised Orthodontic Bracket System

The dental professional creates a model of the patient’s dentition. The model is scanned and
converted into digital model using any legally marketed scanner for dental applications which will
export STL files. Scanning a physical impression to make a virtual patient model is also possible. The
model data is imported into an activated copy of the Computerized Orthodontic Bracket System on a
standard personal computer.
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An authorised user is required to activate the software. The authorised user is either a Blue Sky Bio
employee or an authorised purchaser. Authorised users follow the specification requirements
guidelines determined by Blue Sky Bio for using their computer and printer with the Computerised
Orthodontic Bracket System.

The software has a database of 3D models of commercially available orthodontic brackets. Based on
the patient’'s 3D models and treatment plan the software operator identifies the ideal placement of the
brackets. The bracket placement is reviewed and approved by the dental professional. The dental
professional can adjust the final position of the bracket if desired.

Manufacturing of the Indirect Bonding Tray (IBT)
Two alternative methods are used to manufacture the indirect bonding trays.

1. The virtual model of the patient’s dentition with the virtual brackets in place is utilised to create a
negative of the model. This virtual model fits on top of the dentition of the patient and has also cavities
matching the shape of the brackets. The user defines the outline of the indirect bonding tray in the
software and a virtual model of the tray is created. This model is printed using a new and not recycled
legally marketed material for short term use in the mouth called NextDent Ortho IBT utilising a 3D
printer satisfying the specifications of Blue Sky Bio described in section 16.11.4. The tray is delivered
to the clinician.

2. In an alternative method, a model of the patient’s dentition with bracket positioning markers is
printed utilising a 3D printer satisfying the specifications of Blue Sky Bio described in section 16.11.1.

The actual brackets are temporarily attached on the markers of the model. A legally marketed
thermoplastic resin sheet such as Dentsply Essix Ace is pressure formed on top of the model
capturing the patient’s dentition and brackets. Any standard thermal pressure forming machine can be
used following the guidelines of the manufacturer of the resin sheets. A pressure forming machine is
sold by the manufacturer of Essix Ace. The sheet is trimmed to the middle of the brackets. Excessive
undercuts are removed and the tray is made suitable to be used as an indirect bonding tray and
delivered to the clinician.

Use of the Indirect Bonding Tray (IBT)

IBT’s are patient-specific devices intended for short term use in the patient’s mouth. The indirect
bonding tray is a placement guide to allow a dentist to place orthodontic brackets in a precise manner.
Manufacturing the tray using the two alternative methods does not change the way it is used. The key
to the tray’s clinical use is the fit on the patient’s dentition and the location of the spaces holding the
brackets during the bonding process. The clinician verifies the accurate fit of the tray on the dentition.
In addition, the position of the brackets in the patient’s mouth is verified to ensure that the location of
spaces for the brackets matches the virtual treatment plan. Once the shape of the tray has been
verified, the clinician inserts the brackets into the tray and places a legally marketed bonding agent.
The final step is placing the tray back in the patient’'s mouth to bond the brackets onto the patient’s
dentition following the instructions of the manufacturer of the bonding agent. If necessary, the clinician
can adjust the bracket position removing one or more brackets and using traditional manual bracket
placement. The procedure is the same for a printed or thermoformed indirect bonding tray.

31.3 Blue Sky Bio Aligner G - Patient Instruction

Rx only
Federal law restricts this device to sale by or on the order of a physician.

Device Description

Blue Sky Bio Aligner G is a sequence of clear plastic, removable, orthodontic aligners that gradually
move the patient’s permanent teeth in small increments to correct a misalignment.
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Indications for Use

Blue Sky Bio Aligner G is a series of clear, lightweight, plastic appliances indicated for the treatment of
tooth malocclusions in patients with permanent dentition (i.e. all second molars). Utilizing a series of
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force.

Contraindications
* Do not use if allergic to plastics.

Warnings and Precautions

1. Because the aligners are worn in the mouth, accidental swallowing or aspiration of the appliance
may occur and may be harmful.

2. Keep aligners away from hot water and harsh chemical solutions.

a) Do not use denture cleaners to clean aligners.

b) Do not drink hot or colored liquids with aligners in place — they may become distorted or discolored.
3. Keep aligners out of reach of young children and pets.

4. When not in use, store aligners in the container provided.

5. Aligners worn out of sequence can result in delayed treatment and complications including patient
discomfort. Always follow the order of wearing the aligners as specified by a doctor.

6. Sensitivity and tenderness to teeth may occur during treatment, especially when moving forward
from one aligner step to the next.

7. Wearing the aligner may temporarily affect speech. Patients typically adapt quickly to the aligners
within a week or two.

8. Irritation of the soft tissue in the mouth (gums, cheeks, tongue and lips) may occur. Consult your
doctor if this persists.

9. Avoid chewing gum when using the aligners.
10. Do not use sharp objects to remove aligners

Directions for Use
Hygiene

1. Rinse new aligners with cold water prior to first use.

2. Clean aligners prior to each use. Use a soft-bristle toothbrush and a small amount of toothpaste. Do
not expose aligners to hot water.

3. Wash hands thoroughly with soap and water before handling aligners.

4. Take care to maintain proper oral hygiene during aligner use and treatment.

a) Brush and floss after each meal, prior to inserting aligners.

b) Maintain regular dental checkups and cleaning appointments during the aligner treatment period.

Aligner Placement

5. Aligners are to be worn according to the doctor’s instructions, usually for 20-22 hours per day, for
the number of days recommended by the doctor for each aligner in sequence.

6. Handle only one aligner at a time.

7. Make sure to insert the aligners as marked — for upper or lower use. Either the upper or lower
aligner may be inserted first.
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8. When inserting the aligner, gently push over the front teeth, then apply pressure, using your
fingertips, to the tops of the left and right molars (back teeth) until the aligner snaps into place.

Aligner Removal

9. To remove the aligners, use your fingertip on the inside of the back molar on one side of your mouth
to slowly pull the aligner from the molars. Repeat the process on the others side before trying to
completely remove the aligner. Once it is disengaged from the molars, gentle prying away from the
teeth with the fingertips should allow removal without damaging the aligner.

10. After removal, rinse aligner with water, shaking off excess water, and store in the case provided.

11. If you have attachments in place on your teeth during the aligner treatment, take care not to
dislodge them when removing the aligners

31.4 Blue Sky Bio Aligner G - User Instruction
Indications for Use

Blue Sky Bio Aligner G is a series of clear, lightweight, plastic appliances indicated for the treatment of
tooth malocclusions in patients with permanent dentition (i.e. all second molars). Utilizing a series of
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force.

Contraindications
= Blue Sky Bio Aligner G is contraindicated for patients who are allergic to plastics.
Device Description

Blue Sky Bio Aligner G is a series of clear plastic aligners that offer a solution for aesthetic orthodontic
treatment by utilizing a set of removable aligners to correct tooth malocclusions.

Blue Sky Bio Aligner G is 3D printed using Tera Harz Clear, P/N TC-85DAC, photo-curable resin, by
Graphy Inc.

The dental software used when planning and manufacturing the aligners is the Blue Sky Plan software
module for Blue Sky Bio Aligner G.

A dental clinician (e.g. orthodontist or dentist), using a standard personal computer prescribes the Blue
Sky Bio Aligner G based on an assessment of the patient’s teeth and determines the course of
treatment via the system. The clinician takes molds of the patient’s teeth and completes a prescription
form and sends the molds to the dental lab, which in turn scans the molds and uploads the .STL files
of the molds into the Blue Sky Plan software. This digital file is a series of CAD files (.STL) for building
models that can be used to fabricate aligners. Alternatively, the dental clinician may generate the
digital files by scanning the patient's mouth directly, using an intraoral scanner, and then sends the
files to Blue Sky Bio or its authorized lab.

The dental lab or the clinician designs a series of digital models and plastic trays intended to gradually
realign the patient’s teeth, this is done using Blue Sky Plan software. The prescribing physician
reviews and approves the model scheme before the aligners are produced. Once approved by the
clinician, Blue Sky Bio or its authorized dental lab produces the Blue Sky Bio Aligner G sequential
aligners, which are made of clear 3D printed Tera Harz Clear resin. The sequential aligners are 3D
printed and cured in a post-curing unit. The dental lab then cleans and polishes the Blue Sky Bio
Aligner G series to remove rough edges, as needed. They are then delivered to the dental clinician.

Blue Sky Bio Aligner G are sent to the dental clinician who then provides them to the patient,
confirming fit and design. Over a period of time, the clinician gives the patient additional trays
sequentially to gradually move the target teeth to the designed position. The dental health professional
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monitors treatment from the moment the first aligner is delivered to when the final aligner is delivered.
The trays are held in place by pressure and can be removed by the patient at any time. Each aligner in
the series is worn for approximately 1 to 2 weeks, for 20 to 22 hours per day, (however, they should be
removed for eating and for cleaning), after which they are replaced by the next stage of aligners. This
is repeated for the duration prescribed by the dental clinician.

Requisite Equipment and Design Software

The following material, equipment and software are required to produce Blue Sky Bio Aligner G:

Make Type/Model
Material Graphy Inc. Tera Harz Clear resin, P/N TC-85DAC
Blue Sky Plan Software for Blue Sky Bio
Design software Blue Sky Bio, LLC u v = po
Aligner G
3D Printer SprintRay, Inc. SprintRay Pro 95 printer
UV Light Curing Unit | CureM U102H UV Cure Oven

Clinician’s Instructions for Blue Sky Bio Aligner G
Scanning

The first step is to obtain the dimensions and details of the patient’s baseline dentition. The clinician
takes molds of the patient’s teeth and completes a prescription form and sends the molds to the dental
lab, which in turn scans the molds and uploads the .STL files of the molds into the Blue Sky Plan
software. This digital file is a series of CAD files (.STL) for building models that can be used to
fabricate aligners.

Alternatively, the dental clinician may generate the digital files by scanning the patient's mouth directly,
using an intraoral scanner.

Design processing

The second step is to create sequential digital aligners. The dentist then uses the Blue Sky Plan
Software module for Blue Sky Bio Aligner G to develop the treatment plan and to produce standard
STL 3D files to facilitate the manufacturing of each sequential aligner in the treatment plan.
Alternatively, a dental technician, develops the treatment plan and sends it to the licensed dentist for
review and approval of the treatment plan prior to 3D printing.

CAUTION — The dentist should only provide the patient with a few sets of aligners at a time. The
dentist must monitor the patient’s progress periodically prior to delivering subsequent aligners.

> For detailed instructions on how to use the Blue Sky Plan software, please refer to User Manual —
Blue Sky Plan Software — Blue Sky Bio Aligner G.

Instructions for Printing & Post Processing of the Blue Sky Bio Aligner G
Blue Sky Bio Aligner G Printing process

The third step is for making the aligners using a 3D printer. Use Blue Sky Plan Software for Blue Sky
Bio Aligner G to plan the treatment by creating a series of sequential aligners that gradually position
the teeth into their final desired position. Use a SprintRay Pro 95 3D printer to print the aligners for
each treatment step.
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= This step requires a digital aligners file: STL format files
= STL File size: less than 500 MB in each file.

Parametric Considerations for Printing Blue Sky Bio Aligner G on SprintRay Pro 95

» Material Mode: SPRINTRAY SPLINT Layer
= Resin Curing Wavelength: 405 nm LED
= Layer Thickness: 100 um
= Exposure Time: 2 Seconds
= Recommended orientation angle (degree): 30° from platform/print bed
= Support function: Auto
= Printing Position: All position Offset: 5 mm
= Environmental Conditions
o Temperature: 15~ 25 °C
o Relative humidity: 30 — 75%

Features of Printer Software

a) STL file import

b) Automatic rotation and placement

c) Layer slicer for path inspection

d) Auto and manual generation of supports

Material Reuse (uncured resin, leftover photopolymers)

A. The validated and accepted criteria for material reuse is 6 times or less. Discard any uncured resin
(leftover resin) after being used 7 times.

B. Required volume of resin for fabricating aligners up to 7 times for SprintRay Pro95 = 310 g.

C. Required volume of resin for making one aligner set = 35 g. o An aligner set means an upper
(maxillary) aligner and a lower (mandibular) aligner.

D. Minimum replenishment volume (amount) of resin for SPRINTRAY Pro 95: 100 g.

E. Note — Any uncured resin (leftover resin) in the resin tank should not be poured back into the
original resin bottle. Please discard uncured resin (leftover resin).

F. Caution — Do not mix new resin and leftover resin (uncured resin). There is no reaction between the
chemical, oxygen and moisture. Therefore, there is no need to monitor the state of the resin.

G. Note — Graphy Inc. only guarantees the quality of aligners that have been printed up to 6 times or
less.

Printing Preparation

A. Shake the Tera Harz Clear vigorously whilst in its original packaging before use.

B. If different types of resin or alcohol, used during cleaning, remain in the vat, it can weaken the
material properties of the printed aligner or lead to printing failure. Always clean the resin tank to
remove any impurity after printing.

C. Be sure to wear protective glasses and protective gloves when handling resins and printed parts.

D. Open the 3D printer cover and make sure there is no impurity left on the plate or resin tank and
pour the Tera Harz Clear into the printer’s resin tank up to the required filling line indicated by the
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manufacturer. Caution — When filling the resin into the resin tank, nitrile gloves, protective glasses and
mask should be used.

E. Close the printer cover.

> For detailed instructions on how to prepare the 3D printer, please refer to the OEM User Manual,
SprintRay PRO 95 User Manual.

3D Printing Process

A. Load digital aligners file (STL) for starting.

B. For printing the aligner model on the build platform, use the printer’s software tool to set the optimal
position at 30 degrees from the platform.

C. Generate supports on the lingual using the recommended setting by the printer manufacturer. If the
support is not enough, add supports on the aligner model.

D. Start printing.
Cleaning Residual Resin from the Printed Aligner

A. Detach the printed aligner model from the build platform.
B. Remove supports from the aligner.

C. Place the aligner on a paper towel and let the aligner stand for 1 hour until the residual resin is
removed or cleaned from the aligner. (Turn the inner surface of the aligner to face the bottom to
facilitate removal of residual resin.)

D. Check if there is any residual resin remaining inside the aligner. If residual resin still remains, wipe it
off with a cotton swab. (Note — If residual resin remains inside, it can cause incongruity.)

> Caution — After printing is completed, the resin tank typically contains some leftover resin (uncured
resin). This resin should not be reused. Safely dispose of residual resin. Do not mix the new resin with
uncured resin (leftover resin).

Post-processing

The fourth step is post-processing. In this step, the aligner becomes fully hardened. A CureM U102H
UV Cure Oven is required for post UV curing and the nitrogen process.

Requisite post-processing equipment (UV-light curing & Nitrogen units)

- Brand Name: Cure M U102H

- Curing Chamber: Required

- Supply Voltage: 100-240, 50/60

- Lamp Power: 80 W

- Light Intensity: 400 mW/cm2

- Lamp Wavelength: 395-405 nm

- Curing Time (min): 60 minutes — Turn object between the curing time

A. The printed aligner must undergo post UV curing and the nitrogen process using a CureM machine.
Do not use any other post curing unit.

B. Place the aligner on the CureM plate.
C. Connect the nitrogen generator tube to the plate’s connector.
D. Place the plate inside the curing unit.
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E. After that, add nitrogen at 10 L/m for 1 minute.

F. Start the first post-curing for 30 minutes, turn the aligner on the opposite side and cure for an
additional 30 minutes under the same conditions, by filling the chamber with nitrogen first.

G. Take out the aligner from the CureM using tongs once post-curing is done.
H. If necessary, polish the aligner with wet sandpaper using the general dental method

> For detailed instructions on how to use the CureM U102H, please refer to the OEM User Manual,
CureM U102H User Manual.

Cleaning and Finishing

After the post-curing process, clean the aligners and finish the fabricating process.

A. Wash the aligner in warm water.

B. Place the aligner on a tissue (paper towel) and let it stand for 30 minutes until it has dried.
C. After the aligner has completely dried, check the aligner’s surface and finish the process.

Dental Lab Instructions for Blue Sky Bio Aligner G Labeling and Packaging

Prior to sending aligners to the clinician, place each aligner in a plastic bag, labeled with the following:
o Patient Name and Identifier number

o Doctor’'s Name

o Dental Lab address and contact information

0 Rx — Prescription Use Only Symbol

o Aligner Step #

o Patient Instruction for Use — Blue Sky Bio Aligner G

Notification

The Tera Harz Clear specifications have been validated with the required equipment and the validated
manufacturing process and software. Any other equipment and manufacturing process will be beyond the
device’s specifications.

Warnings

» Tera Harz Clear contains polymerizable monomers which may cause skin irritation (allergic contact
dermatitis) or other allergic reactions in susceptible persons. If in contact with skin, wash thoroughly
with soap and water. If skin sensitization occurs, discontinue use. If dermatitis or other symptoms
persist, seek medical advice.

= Avoid inhalation or ingestion. High vapor concentration can cause headache, irritation of eyes or
respiratory system. Direct contact with eyes may cause possible corneal damage. Long-term
excessive exposure to the material may cause serious health effects. Monitor air quality in line with
OSHA standards.

» Tera Harz Clear should not be used for any other purpose apart from orthodontic appliances. Any
deviation from this instruction for use may have a negative effect on the chemical and physical
properties of the Tera Harz Clear.

Inhalation
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Tera Harz Clear is an irritant for the respiratory system. High atmospheric concentrations can cause
irritation of the respiratory system, dizziness, headaches and anesthetic effects.

Skin contact

Tera Harz Clear may cause sensitization if in contact with skin. Irritation to skin, repeated or prolonged
contact may cause dermatitis.

Eye contact

A high vapor concentration of Tera Harz Clear may cause irritation.

Ingestion

Tera Harz Clear has low oral toxicity, but ingestion may cause irritation of the gastrointestinal tract.
Protection

Wear protection when handling Tera Harz Clear. Protective glasses and nitrile gloves are advised.
» H317 May cause an allergic skin reaction.

» H413 May cause long lasting harmful effect to aquatic life.

Precautions

» Read all safety and operating instructions beforehand.

= Wear protective glasses and nitrile gloves whenever you handle Tera Harz Clear resin.

= Work in a well-ventilated area.

= Cure any resin you plan to dispose of.

Adverse Reactions

Tera Harz Clear may cause allergic reactions. In case of an allergic reaction, please contact an
orthodontist or dentist.

Disposal

= Fully cure any liquid resin you plan to dispose of.

= Tera Harz Clear in its polymerized form is not environmentally harmful. Residual waste material in its
liquid state should be delivered to a collection point for waste material.

Storage Conditions, Expiry Date and Transport

Store Tera Harz Clear in its original packaging at room temperature in a dry and dark area, preferably
in 15~25 °C. Close the packaging after each use.

The expiry date is on the product label. Do not use Tera Harz Clear past its expiry date.
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Explanation of Symbols

Symbol Definition Symbol Definition
LOT Batch number of product Date of manufacture
g Use-hy date Consult instructions for use
& Caution Non sterile
ﬁT{‘:\Cj Keep away from sunlight Recycle

®

Do not use if package is

damaged

Fragile, handle carefully

Upper and lower

temperature limitation

Manufacturer

B(umv

Prescription Use Only

H 3=

Catalog number

Blue Sky Bio, LLC
800 Liberty Drive, Libertyville, IL 60048
info@blueskybio.com

(888) 446-6724
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